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An Introduction to Readerware
Readerware is a collectors dream come true, catalog your books, music & videos automatically. It includes:

Readerware can search the internet and automatically catalog the books, music & videos you own, complete with
cover art. There is no easier way of cataloging your library. It eliminates or reduces the chore of manual data entry.

A powerful SQL database to store and track your library. It can store thousands of titles.
Bar code reader support, literally catalog an item by scanning the barcode, Readerware does the rest.
User friendly database searches. Search on virtually any field. No database knowledge needed!
Support for multiple databases, create as many databases as you want or store everything in a single database.
Built in access to the ultimate reference sources, The Library of Congress and The British Library.
Fully integrated want list with price comparison.
Compare prices before you buy.
Sophisticated reporting to produce hard copy listings of your library and want list.
Easy to use, configurable operation
Full mouse and keyboard navigation.
Powerful import/export capabilities.
Support for multiple platforms, take Readerware and your database to your platform of choice.
Full online help
Mobile support

Whether you are someone who loves to read or someone who loves to collect, Readerware is the product for you.
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Upgrading from Readerware 3 to Readerware 4
Upgrading from Readerware 3 to Readerware 4 is very simple and will be transparent for most users. Just install Readerware 4
and start it. Everything will be taken care of. 

Installing Readerware 4

The default installation directory for Readerware 4 is different from earlier versions so you can have both versions installed on
the same computer. 

The first time you run Readerware 4 it will detect your existing installation. It will automatically migrate your Readerware
preferences to Readerware 4 format so that Readerware 4 looks the same as your current Readerware 3 installation. The table
view will consist of the same columns as it does now, any additional views you have created will still be there etc. 

Converting your database

Your Readerware 3 database also needs to be converted to Readerware 4 format. This is done by backing up your existing
Readerware 3 database and restoring it to Readerware 4 format. Your existing Readerware 3 database is not touched and is still
available. The database upgrade wizard will be launched automatically whenever you open a Readerware 3 database in
Readerware 4 and step you through the conversion process 

If you have several Readerware 3 databases, you will need to open each one in Readerware 4 to convert it. Readerware 3
databases will not automatically show up in the Readerware 4 open database dialog, by default Readerware 4 only displays
Readerware 4 databases. To open a Readerware 3 database, change the file type drop down list at the bottom of the open
dialog to select Readerware 3 databases, you will then be able to open and convert the database to the new format. On a Mac
there is no file type selection, you will able to open either a Readerware 4 or Readerware 3 database. 

Once you have your database in Readerware 4 format it is a good idea to back it up for safe keeping. 

Readerware Database Upgrade Wizard

The Readerware database upgrade wizard will guide you through the process of upgrading your Readerware 3 database to
Readerware 4 format. Most users will just click the Next button to proceed through the conversion process as Readerware
makes default choices for you which will be appropriate in most cases. 

The actual conversion is pretty quick but the speed will depend on the size of your database. Readerware will keep you posted
on the progress. 

3.0 Database Upgrade

This is the first page of the wizard and will be displayed automatically whenever a Readerware 3 database is opened in
Readerware 4. It will display the name and location of the Readerware 3 database. The conversion process will backup your
Readerware 3 database and restore it to Readerware 4 format creating a new Readerware 4 database. Your existing
Readerware 3 database is not touched. 

Confirm that you want to convert this database by clicking on the Next button. 

If you decide not to convert the database at this point, click on the Cancel button. 

4.0 Database Selection

This is where you tell Readerware where to create the new database and what to call it. 

Readerware has already set the Readerware 4 database for you based on the Readerware 3 database name. The new
database will be stored in the same folder as the Readerware 3 database and will have the same name. Readerware uses a
different file type for Readerware 4 databases. 

If you want to use another name or location for your new database, click on the Browse button. The standard file selection
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dialog will be displayed. 

Verification

Readerware now has all the information it needs to convert your database to Readerware 4 format. Click Next to begin the
conversion. 

Converting...

As Readerware converts your database it will display the progress. Once the conversion is completed the Next button will be
enabled, click it to continue. 

Done!

This final page of the database upgrade wizard displays the number of rows converted. Click Finish to exit the wizard and open
your new database.

Readerware automatically opens your new Readerware 4 database once the conversion is completed. You should see your
records and Readerware 4 is ready to go. 

Converting an external database

The process for converting an external database like a MySQL database is practically the same as converting a standard
Readerware database. The same upgrade wizard is used with external databases, The difference comes when you select your
new Readerware 4 database name. 

Readerware cannot create a new external database. You must use the utilities provided with the external database to create a
new empty database. When you get to the 4.0 Database Selection page of the wizard, the database field contains the name of
your existing Readerware 3 external database. Launch the utility that came with the database and create the new empty
database. Return to the wizard and change the name to the new database name. You can do this by typing it in on by clicking on
the Browse button to display the external database selection dialog. 

Installing Readerware 4 on a new computer

If you are installing Readerware 4 on a new computer, then there is no existing database to convert. 

Start by backing up your existing Readerware 3 database on your old machine. Now transfer the backup file to your new
computer. 

Install Readerware 4 and when the program starts select the Restore function. Select your Readerware 3 backup file.
Readerware 4 will recognize that it is a Readerware 3 backup file and will let you now that it will be restored to a Readerware 4
database. As there are no existing preferences on your new computer, be sure to check the option to restore preferences too. 

Complete the wizard as described above. 

Upgrading Client/Server Edition

There is a little more involved in converting a Readerware Client/Server Installation to Readerware 4. 

The way we communicate with the server has changed so you must upgrade both the server and the client computers to
Readerware 4. 

Start by running the Readerware 3 RWServer Config utility on the server machine. Shutdown the Readerware 3 server. If you
are running on Windows you should also uninstall the Readerware 3 server Windows service by selecting from the Service
menu. 

Now install Readerware 4 on the server machine and run the appropriate Readerware client programs, i.e. Readerware 4
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(Books), Readerware 4 (Music) etc. You may see an error because the server is not running. Click OK on the error and the
Database Chooser will be displayed. Select the option to Open an Existing Database and open your Readerware 3 databases
locally. On Windows and Linux you will need to select the Readerware 3 database type in the file selection dialog. As the
Readerware 3 databases are opened the database conversion process will be triggered as described above. The Readerware
server cannot convert the databases so this must be done in the Readerware client programs. Each database must be
converted separately using the appropriate client program. 

Once the databases have been converted, start the Readerware 4 RWServer Config utility. The database tabs will still be
referencing the Readerware 3 databases. Click on the Browse button and select the appropriate Readerware 4 database. Save
the server configuration. 

When you save the new server configuration you may be prompted to select a borrower database. This only applies if you will be
using the Readerware Loan Client. If you do not plan on using the Readerware Loan Client you can ignore this message. In
Readerware 4 the loan client lets you checkout all media types, books, music and videos. You have to pick one of the databases
as the borrower database and the borrowers will be stored in this database. If you have been using the loan client in
Readerware 3, then the borrowers are in your book database and you should select the book database now. It is best to select
the database you will be using most in the loan client. If you will be primarily loaning videos for example, select the video
database as the borrower database. Save the server configuration after specifying the borrower database. 

If you are running on Windows you must install the new Readerware 4 server as a Windows service. Select from the Service
menu. If when using the Readerware 3 server you changed the properties of the RWServer Windows service, you will need to
make those changes again for the new server. See Running the server as a Windows service. 

Now you are ready to start the new server. 

Once the Readerware server is running, the next step is to run the Readerware client programs on the server machine again.
When you used these to convert the databases, the new Readerware 4 databases were saved as the current databases. We
need to reset them to connect to the Readerware server. Start each client program in turn. You should receive an error saying
that the database is in use. This is because the databases have been opened by the server. Click OK on this error and the
Database Chooser will be displayed. Select the option to Connect to a Readerware Server. Now the Readerware client
programs are configured to connect to the Readerware server again. 

Finally on the other client machines install Readerware 4 and run the clients. They should connect to the new Readerware 4
server as normal. No special configuration is required, these clients should already be configured to connect to the Readerware
server. If the clients cannot connect to your Readerware 4 server, it is probably your firewall software. As Readerware 4 is
installed in another folder, the firewall rules on the server machine may need updating. 

A final note about the Readerware Loan Client. In Readerware 4 the loan client can checkout all media types, books, music and
videos. It must now be run in client server mode and when it connects to the server it will access all databases that have been
configured on the server. If you have configured all three databases, the Readerware loan client will connect to the three
databases and you will be able to search for any media type and checkout any item. If you have only configured the server for
the books database, then you will only be able to checkout books.

Top of Page

Copyright © 1999-2022 Readerware Corporation

Page 5 of 145



Upgrading from Readerware 2.0 to 3.0
Upgrading from Readerware 2.0 to 3.0 is very simple and will be transparent to most users. Just install Readerware 3.0 and
start it. Everything will be taken care of.

The default installation directory for Readerware 3.0 is different from earlier versions so you can have both versions installed on
the same computer.

The first time you run Readerware 3.0 it will detect your existing installation. It will automatically migrate your Readerware
preferences to 3.0 format so that Readerware 3.0 looks the same as your current 2.0 system. The table view will consist of the
same columns as it does now, any additional views you have created will still be there etc.

Your Readerware 2.0 database also needs to be converted to 3.0 format. This is done by copying your database to create a
new 3.0 database. Your existing 2.0 database is not touched and is still available. The database upgrade wizard will be
launched automatically to step you through the conversion process whenever you access a 2.0 database in Readerware 3.0.

If you have several Readerware 2.0 databases, you will need to open each one in Readerware 3.0 to convert it. 2.0 databases
will not automatically show up in the Readerware open database dialog, by default Readerware only displays 3.0 databases. To
open a Readerware 2.0 database, change the file type drop down list at the bottom of the open dialog to select Readerware 2.0
databases, you will then be able to open and convert the database to the new format.

Once you have your database in 3.0 format it is a good idea to back it up for safe keeping.

Readerware Database Upgrade Wizard

The Readerware database upgrade wizard will guide you through the process of upgrading your 2.0 database to 3.0 format.
Most users will just click the Next button to proceed through the conversion process as Readerware makes default choices for
you which will be appropriate in most cases.

The actual conversion is pretty quick but the speed will depend on the size of your database. Readerware will keep you posted
on the progress displaying the total number of rows that need to be converted and the current status.

2.0 Database Upgrade

This is the first page of the wizard and will be displayed automatically whenever a 2.0 database is accessed in Readerware 3.0.
It will display the name and location of the 2.0 database. The conversion process will copy your 2.0 database creating a new 3.0
database, your existing 2.0 database is not touched.

Confirm that you want to convert this database by clicking on the Next button.

If you decide not to convert the database at this point, click on the Cancel button.

3.0 Database Selection

This is where you tell Readerware where to create the new database and what to call it.

Readerware has already set the 3.0 database for you based on the 2.0 database. The new database will be stored in the same
folder as the 2.0 database and will have the same name. Readerware uses a different file type for 3.0 databases.

If you want to use another name or location for your new database, click on the Browse button. The standard file selection
dialog will be displayed.

Note that under some circumstances Readerware will relocate your database to a new folder rather than store it in the same
folder as your 2.0 database. Over time operating systems have changed the rules as to where you should store data. For
example in most cases it is no longer permitted to store data in the program installation folder. If Readerware detects that your
existing 2.0 database is stored at an invalid location, it will relocate it to your Documents folder. You can of course change the
location, but please do not try and store it in the invalid folder as this can cause problems in the future.

Verification

Readerware now has all the information it needs to convert your database to 3.0 format. Click Next to begin the conversion.

Converting...
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As Readerware converts your database it will display the number of rows that have to be converted and the current row number.
Once the conversion is completed the Next button will be enabled, click it to continue.

Done!

This final page of the database upgrade wizard displays the number of rows converted. Click Finish to exit the wizard and load
your new database.

Readerware automatically loads your new 3.0 database once the conversion is completed. You should see your records and
Readerware 3.0 is ready to go.

After the Conversion

Once you have converted your 2.0 database to 3.0 format you are ready to go.

Nothing else is required to access your data in Readerware 3.0, but there are some optional steps you might want to take.

Readerware 3.0 includes a lot of new fields, you might want to run auto-update to populate these new fields if the data is
important to you.

Readerware lets you add user defined fields to your database. If you added a new field for data that is now standard in
Readerware 3.0, you might want to copy the data from the user defined field to the new 3.0 field using the replace wizard.

Upgrading from Bookography 1.0

The process is the same for converting a Bookography 1.0 database to 3.0 format.

You will need to open your Bookography database in Readerware 3.0 to convert it. Bookography databases will not
automatically show up in the Readerware open database dialog, by default Readerware only displays 3.0 databases. To open a
Bookography 1.0 database, change the file type drop down list at the bottom of the open dialog to select Bookography 1.0
databases, you will then be able to open and convert the database to the new format.
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The Readerware Window
The Readerware window consists of four components:

Menu - The Readerware menu provides access to all functions.

Toolbar - The toolbar provides quick access to commonly used functions. The toolbar buttons include an icon and
label describing the function. If you need more information on what a button does hold the mouse over it to display a
tooltip. The appearance and behavior of the toolbar can be changed in Preferences.

Search Bar - The search bar lets you quickly search your database. Select the search type, the value you are looking
for and click on the Search button or hit the Enter key.

View - The view displays the current search results. You can choose from four different views: Table view, Tree view,
Thumbnail view and Fish Eye view.

The Readerware Menu

The Readerware menu provides access to all program functions and features.

File Menu - Use the file menu to open and create databases, to print reports and barcodes, to import and export
data, backup and restore your database etc.

Edit Menu - Use the edit menu to access the clipboard, add new records, edit existing records, make bulk edits,
check items in and out etc.

Web Menu - Use the web menu to launch the auto-catalog wizard to add new items to your database, use the
Readerware online search pages and catalog items using drag & drop etc. View Menu - Use the view menu to select
a different view, toggle between navigation and edit modes, display statistics, navigate between items etc.

Help Menu - Use the help menu to access this help system and other Readerware support resources like the tutorial
and knowledge base.
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Readerware Table View
The Readerware table view displays your data in a spreadsheet style view.

You can customize the view, you can determine what columns are displayed and in what order. To show or hide a column, right
click on a column header and use the popup menu. To move columns around, drag the column header to the desired location.

You are not limited to a single table view, you can create as many as you want. Each table view can include different columns in
the order you want them. You can have a main table view for browsing your collection but the Readerware table view also works
with the print function, so you can define reports by creating a table view with the columns you want to print. To create a new
table view, use Preferences.

Sorting the table view

You can sort the table view on any column(s). To sort on a column, just click on a column header. An icon is displayed in the
header to indicate it is the sort column. The arrow indicates whether the sort is ascending or descending. Click again in the
column header to toggle the sequence.

To sort on a secondary column hold down the Ctrl key, (Mac users hold down the Apple/Command key), and click on another
column header. For example to sort your database by author and title, first click on the author column header. Then hold down
the Ctrl key and click on the title column header.

Navigating the table view

When you first display the table view it is in navigation mode. Most fields are displayed like links in a browser and you can click
on them to refine your search results.

For example click on an author to see books by that author. Click on a category link to display albums in that category. You can
keep refining the search results by clicking on links. Use the Back and Forward toolbar buttons to move back to the previous
result set, again just like a browser.

You can select one or more rows by clicking on the cursor icon at the beginning of a row. To select your first item, just click on
the cursor icon. To select another item, use the standard list selection keys for your operating system to select other items or a
range of items. For example on Windows hold down the Ctrl key on your keyboard and select the next item. On Mac OS X hold
down the Command key and click on the next item. To select a range of items, hold down the Shift key and click on an item, all
items between the new and previous selections are now selected.

You can display a particular item in the detail view by clicking on the green enter icon at the beginning of a row. Use the Home
toolbar button to return to the table view.

You can jump to a new location in the table view. Right click on a column header, type one or more characters and hit the Enter
key. Readerware will look down the column for the first entry that starts with the specified data and position that row at the top of
the view. You can do this with any column but normally you would choose the primary sort column to jump to a specific author
for example.

Editing in the table view

Click on the Edit Mode toggle button in the toolbar to switch from navigation mode to edit mode. Table cells are now editable.

Click on a cell to change the contents. An appropriate editor is displayed to help you make your changes. For example clicking
on an actor cell displays the contributor drop down list. You can select a new actor from the list or type the first few characters of
the name. If you click in a date cell, the date editor is displayed etc.

Your changes are automatically saved as you move around the table view.

Click on the Edit Mode toggle button again to switch back to navigation mode.
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Readerware Tree View
The Readerware tree view is a two panel view. In the left panel is the tree. You can determine how the tree is organized by
selecting from the category list at the top of the tree.

The tree contains two types of nodes a folder node for the top level category and an item node for each item in your database.

You can expand all folder nodes by right clicking on the tree and selecting from the popup menu.

You can expand individual folder nodes by clicking on the expand symbol or double-clicking on the node itself.

As you click on a node the contents of the right panel change based on your selection.

For example you can display your book database in the tree view by author and title. Select an author node to display all books
by that author. Select a title node to display full information about the book.

Selecting a folder in the tree

A folder node can contain multiple items, i.e. all albums by a particular artist.

When you select a folder node the contents are displayed in the right pane.

You can choose between a table or thumbnail view for the contents of the folder node using Preferences. You could display all
the albums as cover thumbnails or in a table. When you embed a view like this, it functions in the same way as the standalone
view.

Selecting an item in the tree

When you select an item node the item is displayed in the detail view.

You can use the tabs in the detail view to display the item summary, images or edit the item.
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Readerware Thumbnail View
The Readerware thumbnail view displays the small image for each item as a thumbnail.

If no image is available a default image is used.

You can sort the images on any column(s) to display the thumbnails in the order you want.

You can set the size of the images in preferences. You can also scale the images dynamically. If you want to see more images
without scrolling you can shrink the images so that more will fit in the window.

If you hold the mouse over an image a popup window is displayed with information on that item. You can define the format of the
popup, what columns are included etc.
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Readerware Fish Eye View
The fish eye view is a new way to display a large number of search results. When you only have a few items in your database, it
can look kind of silly, but try it again when you have a several hundred or several thousand titles and you can see the power of
the fish eye view.

The view is built around the root node in the center of a circle, colored dots radiate out from the center. The first row of nodes
are yellow and represent authors, the next row of dots are green and represent the titles.

Need to find a particular author? Maybe you can see the author node, simply drag it to the center of the view. If you cannot see a
particular author, click in the approximate position and drag to the center. Now this area of the view is enlarged as it moves and
you can see more detail. Select the author node or go straight to the titles and drag them to the center.

Right click on a title node and you can display the cover image or detail view of that item by selecting from the popup menu.
Click anywhere in the view to remove the cover image

Navigate through all items in the search results using the Back/Forward buttons in the toolbar. Readerware displays each title
in the detail view.

Click on the toolbar Home button to return to the fish eye view.
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Readerware Detail View
The Readerware detail view is used to:

Add new items to your database manually. Click on the Add Book toolbar button. To add based on an existing item, first
search for it, make your changes and click on the Add button.
View items in your database. You can display the detail view from any of the main views. The Summary tab is displayed
and you can see information about the item.
Edit items in your database. You can display the detail view from any of the main views. Select the Edit tab and the fields
are editable. Click on the Update button to apply your changes.
Check items in and out - Select the Loan button to open the loan dialog.

There are at least 4 tabs in each detail view:

Summary tab - Display a formatted summary of the item. The summary page is template driven and it is possible to
develop your own templates to the display the data you need.
Edit tab - Display the item in edit mode, click on the Update button to apply your changes.
Images tab - Display the images that have been added to this item. You can also edit the images. Right click on an image
to display the popup menu. Mac users Control-Click on the image. You can copy/paste images, load in a new image,
export images etc.
Contents tab - There will be at least 1 contents tab, more if there are multiple volumes, discs etc. You can edit the
contents, right click on the item number to display the popup menu. Mac users Control-Click. You can copy/paste items,
insert new items, insert breaks etc.
User tab - This is an optional tab and only appears when you have added user defined columns to your database. The
user defined columns appear on this tab and can be edited.

Editing an item

The Edit tab displays the full item and most fields are editable. The exceptions are fields like date added and last updated which
are set automatically.

The Edit tab includes both the image and data in a split panel.

You can also edit the image, right click on the image to display the popup menu. Mac users Control-Click.

You can change the position of the image panel, the number of images displayed etc. in Preferences. If you need more space to
edit the data you can adjust the split by dragging it with the mouse. You can collapse it completely if you don't need to see the
image. Click on the buttons on the divider to collapse and restore the split.

You can control the level of detail displayed on the Edit tab, choose between Full, Standard, Brief and Seller. You can set the
default display type in Preferences. Normally the display type is used globally and applies to all records but you can save a
different setting for each record if you want. For example if your music library is mostly jazz or rock you are probably not
interested in fields like Composer, Conductor, Work etc. So you choose the standard display mode as the default as it does not
include this information. You do have some classical albums though. For these you would like to see this information. Select the
full display type and then click on the Update button. Readerware will save this setting in the record and always display the full
listing for this item.

Many fields in the Edit tab will have a specific editor to help you enter an appropriate value. Some are plain text, you just enter
the data, others will have specific editors:

Contributors - Authors, artists, actors, directors etc. are contributors. The contributor editor is a drop down list. You can
select the contributor from the list or enter the first few characters of their name. Use the cursor keys to move up and down
the list and the Enter key to select. You can click on the green enter icon to display the contributor dialog where you can
record personal information, a biography, picture etc. You can also use this dialog to add a new contributor.
Lists - Fields like format, category, rating etc. are lists. You can select a value from the list, type in the first few characters
of the entry you are looking for to display it. You can add new entries by just typing them in. You can maintain the list by
selecting the Edit item from the popup menu.
Dates - Dates can be entered by selecting from the drop down panels. You can also just enter a date if you prefer.
Values - These fields use a spinner to increment/decrement the value. The arrow buttons are sensitive to the cursor
location. The can click on the dollar component before the decimal point and use the arrows to adjust the dollar amount,
click in the cents component to adjust the cents. You can also type in new values.
Numbers - These fields use a spinner to increment/decrement the value. You can also type in new values.
Media - Click on the ... button to select a media file. Click on the Play button to play it.
Keywords - Keywords are comma separated. Type in your keywords followed by a comma.
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Many fields include a search item on the popup menu. For example right click in the author field to display the popup menu. Mac
users Control-Click. Select Search from the popup menu and Readerware will search the database and display all books by this
author. This can be a very useful feature when editing a record, you might want to make changes to other books by this author,
items in this category etc. You can also access the clipboard functions from the popup menu.

Finally at the bottom of the panel is the button bar:

Add - Add a new item to the database.
Update - Update an item in the database
Delete - Delete an item from the database
Clear - Clear all fields
Loan - Open the loan dialog to check books in and out

The Update button is actually a group of three buttons. Click on the main Update button to update the current item. The updated
item is still displayed and you can make further changes or use the toolbar Home button to return to the parent view, the Back
and Forward buttons to move to another item. Click on the <+ button to the left of the main Update button to update the current
item and move to the previous item. Similarly click on the +> button to the right of the main Update button to update the current
item and move to the next item.

Editing item contents

Each item in your database can have a list of contents. Books can have Volumes and Chapters, videos can have discs and
episodes, albums can have discs and tracks. You edit these entries the same way regardless of the product. 

Using an album as an example, display the album in the detail view and click on one of the disc tabs. The tracks on that album
are displayed. All fields can be edited, just click in the field. 

There can be any number of discs in an album, you can create additional discs using the Add disc button. 

There can be any number of tracks on a disc. A powerful track editor is included, you can right click on a track number to access
the editor. Control-Click on a Mac. Select the desired function from the popup menu. 

You can insert and delete tracks, copy/paste tracks. 

You can insert a disc break. This can be useful if a site does not include disc breaks in their listings, some sites might list a
double album as a list of 38 tracks. If track 20 is the first track on disc 2, right click on track 20 and select Insert Disc Break.
Readerware will create a new disc and move the remaining tracks on to it. 

If you are cataloging vinyl you can insert side breaks to keep track of which tracks are on each side of the LP.
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Readerware Views
Readerware has four different view types, Table view, Tree view, Thumbnail view and Fish Eye view.

You can change views using the View menu.

You can create additional views of each type. For example you might create multiple table views each with a different set of
columns.

You can create additional views by first selecting an existing view and then the View->Copy View menu item. You can now
customize the new view.

You can also create, rename or delete views using Preferences. 

Changing the Default View

Readerware is setup to automatically select the table view when it starts up. You can easily change this.

Select the view you want to use and then the View->Save as Default View menu item.

For example if you wanted to use the thumbnail view as the default view, select it and save. Now when you restart the program
Readerware will display the thumbnails of all your items.
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Cataloging Your Library
Readerware is the easiest, fastest way to catalog your library. It supports all formats, books, eBooks, audio books etc.

There are three ways to catalog your books with Readerware:

Auto-Catalog - You scan the barcode or enter the ISBN (ISBN-10 or ISBN-13). Readerware searches for the book
and catalogs it automatically complete with cover art. 

Drag and Drop - You search for the item at any one of the supported sites, then drag from your browser and drop on
Readerware, it is cataloged. Designed for older titles that may not have an ISBN or LCCN, but also useful for eBooks
and while browsing. You can search by author, title etc. Select from the Web menu to open the Readerware search
pages in your browser, then drag & drop. There are additional sites available when using drag & drop. 

Data entry - You can always enter items the old fashioned way, just type them in. 

Top of Page
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Readerware Auto-Catalog Wizard
One of the more powerful features of Readerware is Readerware auto-catalog. Readerware can scan the internet looking for
information about the items you own, extract that information, including cover art and build your Readerware database.
Cataloging your collection has never been easier and the Readerware auto-catalog wizard will guide you through the process
step by step.

These are the basic steps:

1. Pick the internet sites you want to search
2. Identify the items you want to catalog by scanning a barcode or entering an ISBN
3. Run Readerware auto-catalog
4. Check the results

Site Selection

This is the first page of the Readerware auto-catalog wizard. This first step is to select which sites you want to search. You can
select one or more sites.

To select the sites start by displaying the list of sites available by  clicking on the down arrow on the site selection box. A list of
available sites is displayed.

To select your first site, just click on it. Notice that the list does not automatically disappear at this point like a conventional drop
down list. This is because you can select more than one site. To add another site, use the standard list selection keys for your
operating system to select other sites or a range of sites. For example on Windows hold down the Ctrl key on your keyboard and
click on the next site. On Mac OS X hold down the Command key and click on the next site. Notice that the names of both sites
now appear at the top of the list. To select a range of sites, hold down the Shift key and click on a site, all sites between the new
and previous selections are now selected.

When you have completed selecting the sites, click on the up arrow to close the list.

If the Merge data from all selected sites box is checked, Readerware will search all the sites you select and merge the data.
Readerware gets as much information as possible from each site before moving on to the next site looking for still more
information. This means that the order you search sites is important.

For example, suppose you like the Amazon listing but would also like to include the dewey number in your Readerware
database. In this case you would search Amazon first and then the Library of Congress.

But supposing you prefer the Library of Congress listing but would also like to get images from Amazon. You simply search the
sites in the reverse order, The Library of Congress first.

If the Merge data from all selected sites box is not checked, Readerware will extract data from the first site with a match and
then move on to the next item in the list.

Either way, the order you search sites can be important, it can make a big difference to the data you collect during a Readerware
auto-catalog run. Each site maintains different data about an item. Many sites categorize items for example and Readerware will
extract the category information for you. But sites use different categorization schemes. So which is better? That is really for you
to decide, you need to look at the data each site returns and determine which site provides the best data for your needs. Then
you can set up the search sequence to search that site first. That way, if your favorite site has the item, Readerware will extract
the information from that site. If not it goes on to check the other sites. You change the search order using Readerware Site
Preferences. 
 

ISBN/LCCN/UPC Input

You tell Readerware which items to look for by entering the ISBN or LCCN of the book, the UPC of a CD or video. There are two
ways to do this, you can simply scan the item with a barcode reader or you can type in the data, with or without the punctuation.

If you are typing in CD and DVD barcodes, you must ensure that you type in all digits. A US barcode currently contains 12 digits,
a European barcode contains 13.
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In the above example, you would enter 731458917724, you must include the digits to the left and right of the barcode.

Using a barcode reader is often the fastest way to enter the list of items to catalog. Each day more and more companies make
low cost bar code readers available to consumers. Check the barcode reader section on the Readerware web site for more
information.

To enter the ISBN, LCCN or UPC manually, simply type it in and press the enter key. Readerware will then validate the data
and if valid, move it to the list below. If invalid, Readerware will display an error message. Readerware also uses audible queues
to indicate a valid or invalid item number, so you don't have to keep looking at your screen each time you enter an item.

Normally when Readerware indicates that an ISBN is invalid, it means that you typed in the number incorrectly. Simply correct
the mistake and try again. Very rarely Readerware will display the error, even when you entered the ISBN exactly as printed on
a book. This is because the publisher included an invalid ISBN on the book. This does occasionally happen, especially on older
books when the ISBN system was new. You can tell Readerware to accept this ISBN anyway and try and find it by clicking on
the Accept button in the dialog.

To scan in a barcode, refer to the instructions  that came with your scanner. Simply ensure that the input field has the focus and
scan. Readerware then receives the data, converts it if necessary and adds it to the list.

To delete an item from the list, select it and hit the Delete key.

Duplicate Entries

The Allow Duplicates option affects how Readerware handles a duplicate ISBN or UPC. 

When the Allow Duplicates option is on, you can enter duplicate ISBNs and UPCs in the database. So you can enter or scan
the same ISBN/UPC any number of times. If you scan an ISBN three times, three separate entries are added to the database.

When the Allow Duplicates option is off you can only enter an ISBN or UPC once, the copies field is used to track the number
of copies of the same item you own. If you enter the same ISBN or UPC more than once in the auto-catalog wizard,
Readerware displays a duplicate error. However if you have more than one copy of the same item, you can check the Allow
duplicates and increment copies option. With this option checked Readerware lets you enter the same ISBN or UPC as many
times as you want. Readerware will use this information to update the copies field as the book is cataloged. So if you enter the
same ISBN five times, Readerware will add the book once and set the copies count to five. If the book is already in the
database, Readerware updates the copies count. So if the book is already in the database with the copies count set to three and
you enter the ISBN three times, after auto-catalog completes the copies count for that item will be set to six. 

Rerunning auto-catalog

You can rerun Readerware auto-catalog, maybe your internet connection went down while auto-catalog was running, maybe you
want to select more sites and try again to match not found books. You don't have to scan all the items again, simply hit the
Reload button to reload your last item list.

If the Allow Duplicates option is off, when you rerun auto-catalog, Readerware skips any items that are already in its database
and just searches for the items it doesn't already have cataloged.

If the Allow Duplicates option is on, you must delete the ISBNs of books already cataloged from the list or they will be cataloged
again.

Using a file of ISBN, LCCN, UPC or barcode scans

Readerware can also read ISBN and barcode scans from a file. Select the Load List button and a file selection dialog is
displayed. Select the file and click on Open. The file must be a standard text file and contain one ISBN or bar code scan per line.
The ISBN can be entered with or without the hyphens. Readerware will then replace the contents of the list with the contents of
the file. You can use this feature to prepare a list of items to catalog ahead of time either in Readerware or another program like
a text editor. 

Using a batch barcode reader

Readerware supports several batch barcode readers including the LaserChamp (Flic), Symbol CS-1504 and CS-2000 readers.
Batch barcode readers are not connected directly to your computer, You can scan barcodes into the reader and at a later time,
upload them into Readerware. This means that you can take the barcode reader to your shelves rather than drag your books,
CDs and videos to your PC. To upload barcodes from a batch barcode reader, click on the Upload button. 
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Saving entered barcodes

You can optionally save the item list you just entered before continuing. Normally after you have entered your data you continue
through the wizard and catalog your new items. But maybe you are at a remote location and do not have access to an internet
connection. You can save the data you entered to a file for later use. Click on the Save List button and select the location and
name for your file. To use the saved file, start auto-catalog again and click on the Load List button

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running Readerware auto-catalog. A
quick summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 
 

Auto-Catalog Running Page

When you reach this page, Readerware auto-catalog is running. You will see a progress window that will update as Readerware
catalogs your items. In the background Readerware also updates the list each time an item is processed. If you want, you can
move the progress window out of the way to see more of the auto-catalog activity. Simply click on the title bar and drag the
window out of the way. The progress window will close automatically once Readerware auto-catalog completes. Don't hit the
Cancel button though, this will abort the Readerware auto-catalog run.

You may have noticed that as you added an item to the list, a  question mark icon was displayed next to it. This indicates that
Readerware auto-catalog has not yet searched the internet for this item. As it processes each item, Readerware changes the
icon to indicate the results. The icons are:

- The item has been processed, the item and product image have been added to the database. 
- The item has been processed and added to the database, no product image was found 
- The item has been processed but could not be found at any of the sites searched 
- The item was already found in the Readerware database, this item was skipped 
- A site returned multiple results for this item, Readerware cataloged the first match. You might want to check the

site manually. 
- A site was busy and returned an HTTP status code of 503. This is a temporary condition, try again later.   More

In addition to the icons, Readerware adds the title to any item it finds. This is a very handy way to identify the items that were not
found by Readerware, it effectively gives you their location on your shelves.

You can save the item list by clicking on the Save List button.

When you have reviewed the status of each item you entered, click on the Next button to proceed to the final page of this
wizard. 
 

Auto-Catalog Complete Page

This page displays the overall auto-catalog statistics:

Items Input Count - The number of items entered
Items Added Count - The total number of items that were added to your database
Images Added Count - The number of items with product images added, this will be less than or equal to the
items added count.
Duplicate Items Count - The number of items already found in the Readerware database and skipped.
LOCIS Multiple Matches - This count will normally be zero. Occasionally  the Library of Congress will return
more than one match for the same ISBN. In this situation Readerware cannot determine which is the correct
match so the book was skipped. But the book does exist at The Library of Congress, so you can use the
Readerware Browser to catalog the book after selecting the correct match.

Note that you can use the Back and Next buttons to toggle between the results and the auto-catalog summary page. When you
are done, click the Finish  button. Readerware will then display all the new items added to your database in the main window.
You can optionally review and edit these new items. Click on the toolbar browse button to return to the full database display.

This statistics information and a complete item by item listing is also written to a log file, if user logging is enabled. You will find
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this file in your Documents->Readerware->Logs folder. You can view this file in any text editor

There is no easier way to catalog your collection! 
 

Site Overloaded Error

Sometimes a website can block Readerware requests by returning an HTTP status code of 503. The official definition of a 503
status code is:

The server is currently unable to handle the request due to a temporary overloading or maintenance of the server.
The implication is that this is a temporary condition which will be alleviated after some delay.

This status code is returned by the server Readerware is trying to connect to, we have no control over this unfortunately. On the
final page of the Auto-Catalog wizard there is a View Log button. If you click on this button the auto-catalog log will open with
details of what happened during the session. It will report any sites that returned a 503 status code. 

Once you have identified the site that is returning the 503 status code, you can remove the site from your auto-catalog list and
choose other sites. If you want to rerun the last auto-catalog list with your new sites, on the ISBN/LCCN Input page of the auto-
catalog wizard, click on the Reload button to reload the list of ISBNs.   More

Top of Page
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Drag & Drop from the Web
You can use drag & drop to catalog older titles that may not have an ISBN, UPC or LCCN, you can also catalog titles as you surf
the web.

Suppose you are surfing the web in your favorite browser, checking the new releases section at Barnes & Noble. You find a new
book by a favorite author. This is a must have item so you want to add it to your Readerware database. Simply drag the page
from your browser and drop it onto Readerware. The book (or album or video), is now cataloged, it's that simple. 

You can drag & drop to the main Readerware window. In this case the item will be added to the database. You can also drag &
drop to the Want List. In this case the item is added to the database and to your want list. 

Let's take a closer look. In the location bar of your browser you will find a little icon that you can drag. You may have already
used this technique to add a shortcut to your desktop. The location and image of this icon varies from browser to browser and
platform to platform. These days it is often the padlock icon indicating whether you have a secure connection or not.

Microsoft Edge
Windows 10

Mozilla Firefox
Kubuntu Linux

Google Chrome
Kubuntu Linux

Apple Safari
macOS
  Note: The Safari browser displays an abbreviated URL. You must first click in the URL field to display the full URL
and the drag icon. Then drag & drop.

To import the contents of the current browser page into Readerware, simply drag the icon from the browser to the Readerware
drop target icon, the Drag & Drop button at the end of the search bar:
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To perform the drag & drop, click on the drag icon in your browser, hold the mouse button down and move it until you are over
the Readerware drop target. The mouse pointer will change to indicate that Readerware will accept the drop. Finally release the
button. Readerware will popup a dialog while it reads the data, extracts the information and adds the item to your database.

That's it, you're done, you have just added a new book, album or video to your Readerware database. 
 

Site Overloaded Error

Sometimes a website can block Readerware requests by returning an HTTP status code of 503.

The official definition of a 503 status code is:

The server is currently unable to handle the request due to a temporary overloading or maintenance of the server.
The implication is that this is a temporary condition which will be alleviated after some delay.

This status code is returned by the server Readerware is trying to connect to, we have no control over this unfortunately. If you
get this error you can drag & drop from another site or you can save the page to a file using your browser and then drag & drop
the file.   More 
 

Drag and Drop Tips

Believe it or not, it can get even easier.

Many browsers support the ability to drag a link, so you can catalog an item without actually displaying the page in your browser.

Imagine you are still on that new releases page at Barnes & Noble. You see a new album, you could click on it to display the
detail page, listen to some samples and then catalog it by dragging it to Readerware (Music).

But there are some titles you just have to have. So you can simply drag the link from the new releases page and drop it onto
Readerware (Music). Readerware (Music) will retrieve the contents and catalog it even though you can't see it in your browser. 
 

Drop Actions

So far we have been adding new items to the Readerware database by dropping the page onto Readerware but there are a
number of actions you can perform using drag and drop: 

Add - Add a new record to the Readerware database. Readerware will extract the data from the web page and add a new
record to the database. This is the default drop action.
Replace - Replace the currently selected record with data from the web. Readerware will extract all the data from the web
page and replace the existing database contents with the new data. If there is data in fields that were not available on the
web, the database field contents are unchanged.
Update - Update the currently selected record with data from the web. Readerware will extract all the data from the web
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page but only database fields that are currently empty will be changed.
Get new images - Readerware will extract images from the web page and add or replace the current database images.

Hold down the Ctrl+Shift keys as you drag and drop, Readerware will display the drop action popup menu when you drop the
item:

Using the clipboard

Most browsers support drag and drop but there are some exceptions. If you cannot drag and drop from your browser to
Readerware, you can use the clipboard instead. Start by selecting the URL in your browser and copying it to the clipboard.
Select the Edit->Copy menu item in your browser. There are typically other more convenient ways to do this, but they will vary
by browser.

Now switch to Readerware. Instead of dragging the URL to the Readerware drop target, the Drag & Drop button, right click on
the button. macOS users should control click on the button. The drop action popup menu will be displayed. Select the
appropriate action and Readerware will retrieve the URL and process it just as if you had used drag and drop.

Supported Sites

You cannot drag from just any site, Readerware needs to know how to find and extract the data from the web page. For a
complete and up to date list of supported sites go to the Readerware Search page. You access the Readerware Search Page
from within the product itself. Select one of the Web->Search menu items and Readerware will open your browser at the
Readerware Search Page. You can then look at the drop down list of supported sites. 
 

Searching the Web from Readerware

You can search the web from within Readerware. Select one of the Web search menu items and Readerware will open your
browser automatically and take you to the appropriate Readerware search page. 

The Readerware search page is an easy to use page that enables you to search any of the supported sites. The Readerware
search pages offer:

Search by ISBN or UPC, you can even use your barcode scanner
Quick search by book author, album artist or video title
Direct access to the search page of each site, when available
Direct access to the book, album or video home page of each site

So the Readerware search pages are a great starting point for your web searches. You can also use them outside of
Readerware, just bookmark one or more of the pages, you can even make one of them your home page. 

Summary
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Readerware offers a very convenient and easy way to catalog your books, music and videos as you surf the web, just drag and
drop! The Readerware search pages make it easy to find what you are looking for.

But you don't have to use the Readerware search pages, use you favorite search engine. It doesn't matter how you get to the
page, once you have displayed an item at any one of the supported sites, simply drag it to Readerware and it is cataloged. It's
that simple.

Top of Page
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Drag & Drop from a File
You can use drag & drop with a link from your browser to catalog books, music and videos. The way drag & drop works is that
your browser passes the link to Readerware. Readerware then retrieves the contents of that page, extracts the data and adds
the item to your database. Sometimes Readerware may have trouble connecting to some sites because of a site overloaded
event. Even though you can display the page in your browser, Readerware cannot connect to the site to retrieve the page. 

Now you can save the page to a file using your browser and then drag & drop the file onto Readerware and the item will be
cataloged. It is not as convenient as traditional drag & drop, but it is a reliable way of cataloging an item. 

The first thing you need to do is save the current page to a file using your browser. You will probably find a File->Save As or a
File->Save Page As menu item. Some browsers let you right click on a page and provide the Save As function on a popup
menu. Most browsers let you save the page in various formats, you should pick the option to save it as an HTML file, you
shouldn't use the web page complete option. Save the file to a convenient location, your Desktop folder is a good choice
because it will be right there on your desktop. 

Now all you need to do is drag & drop that file onto Readerware. Drop it on the Drag & Drop button, the same way you do for a
normal drag & drop operation. 

Readerware will read the file, extract the data and add the item to your database. 

Standard drag & drop is the best way to catalog an item from your browser, but if you have problems with it, you can save the
page to a file and then drag & drop the file onto Readerware .

Top of Page
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Readerware Auto-Update Wizard
One of the more powerful features of Readerware is Readerware auto-update. Readerware can scan the internet looking for
information about the items you own, extract that information, including cover art and update your existing Readerware
database.

Use Readerware auto-catalog to build your initial database and Readerware auto-update to add new information and update
existing data. Cataloging your collection has never been easier and the Readerware auto-update wizard will guide your through
the process step by step.

These are the basic steps:

1. Pick the internet sites you want to search
2. Identify the items you want to update
3. Identify the database columns you want to update
4. Run Readerware auto-update
5. Check the results

Site Selection

This is the first page of the Readerware auto-update wizard. This first step is to select which sites you want to search. You can
select one or more sites.

To select the sites start by displaying the list of sites available by clicking on the down arrow on the site selection box. A list of
available sites is displayed.

To select your first site, just click on it. Notice that the list does not automatically disappear at this point like a conventional drop
down list. This is because you can select more than one site. To add another site, use the standard list selection keys for your
operating system to select other sites or a range of sites. For example on Windows hold down the Ctrl key on your keyboard and
click on the next site. On Mac OS X hold down the Command key and click on the next site. Notice that the names of both sites
now appear at the top of the list. To select a range of sites, hold down the Shift key and click on a site, all sites between the new
and previous selections are now selected.

When you have completed selecting the sites, click on the up arrow to close the list.

You might be wondering why you would select multiple sites to search. The answer is that no one site will have every item and
each site will have different information about an item. When trying to update an item, Readerware searches each site in turn
looking for a match. Readerware extracts the data from that site and updates the database. Then it searches the next site
looking for more data. When all sites have been searched, it goes on to the next item in the list.

Advanced tip: You can control the order in which the sites are searched. This can make a big difference to the data you collect
during a Readerware auto-update run. As mentioned earlier, each site maintains different data about an item. Many sites
categorize items for example and Readerware will extract the category information for you. But sites use different categorization
schemes. So which is better? That is really for you to decide, you need to look at the data each site returns and determine which
site provides the best data for your needs. Then you can set up the search sequence to search that site first. That way, if your
favorite site has the item, Readerware will extract the information from that site. If not it goes on to check the other sites. So it is
important that if you have a site preference, you place it at the top of the list. You change the search order using Readerware
Site Preferences. 
 

Item Selection

The next step is to select the items you want to update. Readerware gives you a number of options, some based on the current
search results. If using one of these options you must perform a search before launching the Readerware auto-update wizard.
This will establish the items you want to update.

On this panel you can select on of the following choices:

All Items in the database - The current search results are ignored and Readerware will try and update every item in your
database. A count of the total number of items in your database is also displayed.
Current Search Results - The items returned by the last search will be updated, these are the items currently displayed in
the main window. A count of the  number of items returned by the last search is also displayed.
Currently selected search results - The items currently selected in the main window are updated. You can select as
many items as you want. A count of the  number of items selected is also displayed.
Input a list of items - If you select this option the ISBN/UPC input panel will be displayed next allowing you to enter the
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keys of the items you want to update. You can enter these manually or use a bar code reader.

Auto-Update is ISBN/UPC based. This means that if the Allow Duplicates option is on, all items with the same ISBN/UPC will be
updated. For example if you use Readerware auto-update to fetch a new image for a book, the image will be updated on all
books with this ISBN. 

ISBN/UPC Input

If you selected the Input option on the last panel, the ISBN/UPC input panel is displayed next. Otherwise you go straight to
database column selection. You tell Readerware which items to look for by entering the ISBN of the book, the UPC of a CD,
video etc. There are two ways to do this, you can simply scan the item with a barcode reader or type in the data, with or without
the punctuation. 

If you are typing in CD and DVD barcodes, you must ensure that you type in all digits. A US barcode currently contains 12 digits,
a European barcode contains 13.

In the above example, you would enter 731458917724, you must include the digits to the left and right of the barcode.

Using a bar code scanner is often the fastest way to enter the list of items to update. Each day more and more companies make
low cost bar code readers available to consumers. Check the barcode reader section on the Readerware web site for more
information.

To enter the ISBN or UPC manually, simply type it in and press the enter key. Readerware will then validate the data and if
valid, move it to the list below. If invalid, Readerware will display an error message. Readerware also uses audible queues to
indicate a valid or invalid item number, so you don't have to keep looking at your screen each time you enter an item.

Normally when Readerware indicates that an ISBN is invalid, it means that you typed in the number incorrectly. Simply correct
the mistake and try again. Very rarely Readerware will display the error, even when you entered the ISBN exactly as printed on
a book. This is because the publisher included an invalid ISBN on the book. This does occasionally happen, especially on older
books when the ISBN was new. You can tell Readerware to accept this ISBN anyway and try and find it by clicking on the
Accept button in the dialog.

To scan in a barcode, refer to the instructions  that came with your scanner. Simply ensure that the input field has the focus and
scan. Readerware then receives the data, converts it if necessary and adds it to the list.

To delete an item from the list, select it and hit the Delete key.
 

Rerunning auto-update

You can rerun Readerware auto-update, maybe your internet connection went down while auto-update was running, maybe you
want to select more sites and look for more data. You don't have to scan all the items again, simply hit the Reload button to
reload you last item list. 

Using a file of ISBN, UPC or barcode scans 

Readerware can also read ISBN and barcode scans from a file. Select the Load List button and a file selection dialog is
displayed. Select the file and click on Open. The file must be a standard text file and contain one ISBN or bar code scan per line.
The ISBN can be entered with or without the hyphens. Readerware will then replace the contents of the list with the contents of
the file. You can use this feature to prepare a list of items to update ahead of time either in Readerware or another program like
a text editor.

Using a batch barcode reader

Readerware supports several batch barcode readers including the LaserChamp (Flic), Symbol CS-1504 and CS-2000 readers.
Batch barcode readers are not connected directly to your computer, You can scan barcodes into the reader and at a later time,
upload them into Readerware. This means that you can take the barcode reader to your shelves rather than drag your books,
CDs and videos to your PC. To upload barcodes from a batch barcode reader, click on the Upload button.
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Saving entered barcodes

You can optionally save the item list you just entered before continuing. Normally after you have entered your data you continue
through the wizard and update your items. But maybe you are at a remote location and do not have access to an internet
connection. You can save the data you entered to a file for later use. Click on the Save List button and select the location and
name for your file. To use the saved file, start auto-update again and click on the Load List button

Column Selection

Your last task is to identify which database columns to update and how Readerware should update each column.

You will see a list of all database columns. Those with a check mark next to them will be updated. Those with a X next to them
will not. You  can double click on any item in the list to toggle its status. You can use the buttons to the right of the list to select
or deselect all columns.

As you select each item in the list, you can also specify how the column should be updated:

Only Update if empty - Readerware will first check the database, if the column already has something in it, it will be
skipped. Use this option to look for additional data without changing your existing data.
Always replace existing contents - If Readerware finds data for the column, the current contents will be replaced. You
can use this to update the value of your collection for example. Let Readerware go out on the net and find the latest
values. Readerware will only update a column if there is new data available. If Readerware is unable to find data for the
column, the current contents are left unchanged.

This option is specified on a column by column basis. For example you could tell Readerware to update the Dimensions column
only if it is empty and always replace the Value column. So it is important to first select the column in the list, then set this option.
When you set this option it applies to the currently selected column only.

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running Readerware auto-update. A
quick summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 
 

Auto-Update Running Page

When you reach this page, Readerware auto-update is running. You will see a progress window that will update as Readerware
processes your items. In the background Readerware also updates the list each time an item is processed. If you want, you can
move the progress window out of the way to see more of the auto-update activity. Simply click on the title bar and drag the
window out of the way. The progress window will close automatically once Readerware auto-update completes. Don't hit the
Cancel button though, this will abort the Readerware auto-update run.

Initially each item in the list will have a question mark icon displayed next to it. This indicates that Readerware auto-update has
not yet searched the internet for this item. As it processes each item, Readerware changes the icon to indicate the results. The
icons are:

- The item has been updated
- The item was not changed.
- The item has been processed but could not be found at any of the sites searched 
- The item does not have an ISBN or UPC, so it could not be processed 
- A site returned multiple results for this item, Readerware cataloged the first match. You might want to check the

site manually. 
- A site was busy and returned an HTTP status code of 503. This is a temporary condition, try again later.

In addition to the icons, Readerware adds the title to each item. This is a very handy way to identify the items, it effectively gives
you their location on your shelves.

You can save the item list by clicking on the Save List button.

When you have reviewed the status of each item, click on the Next button to proceed to the final page of this wizard. 
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Auto-Update Complete Page

This page displays the overall auto-update statistics:

Items Input Count - The number of items processed
Items Updated Count - The number of items actually updated
Images Added/Updated Count - The number of items with product images added or updated.
Unchanged Count - The number of items that were not changed. Items are not changed if no new data was
found or all selected columns already had data.
Books Without Keys Count - Readerware can only auto-update items with an ISBN or UPC. This lists the
number of items that could not be updated because they did not have the key field.

Note that you can use the Back and Next buttons to toggle between the results and the auto-catalog summary page. When you
are done, click the Finish  button. Readerware will then display all the updated items in the main window. You can optionally
review and edit these updated items. Click on the toolbar browse button to return to the full database display.

This statistics information and a complete item by item listing is also written to a log filr, if user logging is enabled. You will find
this file in your Documents->Readerware->Logs folder. You can view this file in any text editor

There is no easier way to catalog your collection!

Top of Page

Copyright © 1999-2022 Readerware Corporation

Page 29 of 145



Readerware Auto-Update Wizard
One of the more powerful features of Readerware is Readerware auto-update. Readerware can scan the internet looking for
information about the items you own, extract that information, including cover art and update your existing Readerware
database.

Use Readerware auto-catalog to build your initial database and Readerware auto-update to add new information and update
existing data. Cataloging your collection has never been easier and the Readerware auto-update wizard will guide your through
the process step by step.

These are the basic steps:

1. Pick the internet sites you want to search
2. Identify the items you want to update
3. Identify the database columns you want to update
4. Run Readerware auto-update
5. Check the results

Site Selection

This is the first page of the Readerware auto-update wizard. This first step is to select which sites you want to search. You can
select one or more sites.

To select the sites start by displaying the list of sites available by clicking on the down arrow on the site selection box. A list of
available sites is displayed.

To select your first site, just click on it. Notice that the list does not automatically disappear at this point like a conventional drop
down list. This is because you can select more than one site. To add another site, use the standard list selection keys for your
operating system to select other sites or a range of sites. For example on Windows hold down the Ctrl key on your keyboard and
click on the next site. On Mac OS X hold down the Command key and click on the next site. Notice that the names of both sites
now appear at the top of the list. To select a range of sites, hold down the Shift key and click on a site, all sites between the new
and previous selections are now selected.

When you have completed selecting the sites, click on the up arrow to close the list.

You might be wondering why you would select multiple sites to search. The answer is that no one site will have every item and
each site will have different information about an item. When trying to update an item, Readerware searches each site in turn
looking for a match. Readerware extracts the data from that site and updates the database. Then it searches the next site
looking for more data. When all sites have been searched, it goes on to the next item in the list.

Advanced tip: You can control the order in which the sites are searched. This can make a big difference to the data you collect
during a Readerware auto-update run. As mentioned earlier, each site maintains different data about an item. Many sites
categorize items for example and Readerware will extract the category information for you. But sites use different categorization
schemes. So which is better? That is really for you to decide, you need to look at the data each site returns and determine which
site provides the best data for your needs. Then you can set up the search sequence to search that site first. That way, if your
favorite site has the item, Readerware will extract the information from that site. If not it goes on to check the other sites. So it is
important that if you have a site preference, you place it at the top of the list. You change the search order using Readerware
Site Preferences. 
 

Item Selection

The next step is to select the items you want to update. Readerware gives you a number of options, some based on the current
search results. If using one of these options you must perform a search before launching the Readerware auto-update wizard.
This will establish the items you want to update.

On this panel you can select on of the following choices:

All Items in the database - The current search results are ignored and Readerware will try and update every item in your
database. A count of the total number of items in your database is also displayed.
Current Search Results - The items returned by the last search will be updated, these are the items currently displayed in
the main window. A count of the  number of items returned by the last search is also displayed.
Currently selected search results - The items currently selected in the main window are updated. You can select as
many items as you want. A count of the  number of items selected is also displayed.
Input a list of items - If you select this option the ISBN/UPC input panel will be displayed next allowing you to enter the
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keys of the items you want to update. You can enter these manually or use a bar code reader.

Auto-Update is ISBN/UPC based. This means that if the Allow Duplicates option is on, all items with the same ISBN/UPC will be
updated. For example if you use Readerware auto-update to fetch a new image for a book, the image will be updated on all
books with this ISBN. 

ISBN/UPC Input

If you selected the Input option on the last panel, the ISBN/UPC input panel is displayed next. Otherwise you go straight to
database column selection. You tell Readerware which items to look for by entering the ISBN of the book, the UPC of a CD,
video etc. There are two ways to do this, you can simply scan the item with a barcode reader or type in the data, with or without
the punctuation. 

If you are typing in CD and DVD barcodes, you must ensure that you type in all digits. A US barcode currently contains 12 digits,
a European barcode contains 13.

In the above example, you would enter 731458917724, you must include the digits to the left and right of the barcode.

Using a bar code scanner is often the fastest way to enter the list of items to update. Each day more and more companies make
low cost bar code readers available to consumers. Check the barcode reader section on the Readerware web site for more
information.

To enter the ISBN or UPC manually, simply type it in and press the enter key. Readerware will then validate the data and if
valid, move it to the list below. If invalid, Readerware will display an error message. Readerware also uses audible queues to
indicate a valid or invalid item number, so you don't have to keep looking at your screen each time you enter an item.

Normally when Readerware indicates that an ISBN is invalid, it means that you typed in the number incorrectly. Simply correct
the mistake and try again. Very rarely Readerware will display the error, even when you entered the ISBN exactly as printed on
a book. This is because the publisher included an invalid ISBN on the book. This does occasionally happen, especially on older
books when the ISBN was new. You can tell Readerware to accept this ISBN anyway and try and find it by clicking on the
Accept button in the dialog.

To scan in a barcode, refer to the instructions  that came with your scanner. Simply ensure that the input field has the focus and
scan. Readerware then receives the data, converts it if necessary and adds it to the list.

To delete an item from the list, select it and hit the Delete key.
 

Rerunning auto-update

You can rerun Readerware auto-update, maybe your internet connection went down while auto-update was running, maybe you
want to select more sites and look for more data. You don't have to scan all the items again, simply hit the Reload button to
reload you last item list. 

Using a file of ISBN, UPC or barcode scans 

Readerware can also read ISBN and barcode scans from a file. Select the Load List button and a file selection dialog is
displayed. Select the file and click on Open. The file must be a standard text file and contain one ISBN or bar code scan per line.
The ISBN can be entered with or without the hyphens. Readerware will then replace the contents of the list with the contents of
the file. You can use this feature to prepare a list of items to update ahead of time either in Readerware or another program like
a text editor.

Using a batch barcode reader

Readerware supports several batch barcode readers including the LaserChamp (Flic), Symbol CS-1504 and CS-2000 readers.
Batch barcode readers are not connected directly to your computer, You can scan barcodes into the reader and at a later time,
upload them into Readerware. This means that you can take the barcode reader to your shelves rather than drag your books,
CDs and videos to your PC. To upload barcodes from a batch barcode reader, click on the Upload button.
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Saving entered barcodes

You can optionally save the item list you just entered before continuing. Normally after you have entered your data you continue
through the wizard and update your items. But maybe you are at a remote location and do not have access to an internet
connection. You can save the data you entered to a file for later use. Click on the Save List button and select the location and
name for your file. To use the saved file, start auto-update again and click on the Load List button

Column Selection

Your last task is to identify which database columns to update and how Readerware should update each column.

You will see a list of all database columns. Those with a check mark next to them will be updated. Those with a X next to them
will not. You  can double click on any item in the list to toggle its status. You can use the buttons to the right of the list to select
or deselect all columns.

As you select each item in the list, you can also specify how the column should be updated:

Only Update if empty - Readerware will first check the database, if the column already has something in it, it will be
skipped. Use this option to look for additional data without changing your existing data.
Always replace existing contents - If Readerware finds data for the column, the current contents will be replaced. You
can use this to update the value of your collection for example. Let Readerware go out on the net and find the latest
values. Readerware will only update a column if there is new data available. If Readerware is unable to find data for the
column, the current contents are left unchanged.

This option is specified on a column by column basis. For example you could tell Readerware to update the Dimensions column
only if it is empty and always replace the Value column. So it is important to first select the column in the list, then set this option.
When you set this option it applies to the currently selected column only.

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running Readerware auto-update. A
quick summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 
 

Auto-Update Running Page

When you reach this page, Readerware auto-update is running. You will see a progress window that will update as Readerware
processes your items. In the background Readerware also updates the list each time an item is processed. If you want, you can
move the progress window out of the way to see more of the auto-update activity. Simply click on the title bar and drag the
window out of the way. The progress window will close automatically once Readerware auto-update completes. Don't hit the
Cancel button though, this will abort the Readerware auto-update run.

Initially each item in the list will have a question mark icon displayed next to it. This indicates that Readerware auto-update has
not yet searched the internet for this item. As it processes each item, Readerware changes the icon to indicate the results. The
icons are:

- The item has been updated
- The item was not changed.
- The item has been processed but could not be found at any of the sites searched 
- The item does not have an ISBN or UPC, so it could not be processed 
- A site returned multiple results for this item, Readerware cataloged the first match. You might want to check the

site manually. 
- A site was busy and returned an HTTP status code of 503. This is a temporary condition, try again later.

In addition to the icons, Readerware adds the title to each item. This is a very handy way to identify the items, it effectively gives
you their location on your shelves.

You can save the item list by clicking on the Save List button.

When you have reviewed the status of each item, click on the Next button to proceed to the final page of this wizard. 
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Auto-Update Complete Page

This page displays the overall auto-update statistics:

Items Input Count - The number of items processed
Items Updated Count - The number of items actually updated
Images Added/Updated Count - The number of items with product images added or updated.
Unchanged Count - The number of items that were not changed. Items are not changed if no new data was
found or all selected columns already had data.
Books Without Keys Count - Readerware can only auto-update items with an ISBN or UPC. This lists the
number of items that could not be updated because they did not have the key field.

Note that you can use the Back and Next buttons to toggle between the results and the auto-catalog summary page. When you
are done, click the Finish  button. Readerware will then display all the updated items in the main window. You can optionally
review and edit these updated items. Click on the toolbar browse button to return to the full database display.

This statistics information and a complete item by item listing is also written to a log filr, if user logging is enabled. You will find
this file in your Documents->Readerware->Logs folder. You can view this file in any text editor

There is no easier way to catalog your collection!
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Manually Adding a Book to your Database
Normally you will use auto-catalog or drag & drop to add a book to your database but you can also add a book manually. 

To add a book to your database manually, click on the Add Book toolbar button or select the Edit->Add Book menu item. 

A blank detail view will be displayed in the main window. The only field that is required is the Title, all the other fields are
optional. 

You can enter the basic book information on the Edit tab. If the item has an ISBN you can scan the barcode into the ISBN field
or just type it in. All the number fields occupy the same space. Notice the drop down list to the left of the ISBN. If you want to
enter a Dewey Decimal Number for your new book, select Dewey from the drop down list and type it in. 

To add an image, select the Image tab. You can drag and drop an image on to one of the placeholder icons, either a local file or
an image from the web. You can also copy/paste an image or select an image file from your hard drive. Click on an image
placeholder icon and select from the popup menu. If you want to include content information, click on the Volume 1 tab. 

When you have entered the information for the book, click on the Add button to add the book to the database. At that point the
Update and Delete buttons will also be enabled. If you want to add more information to the book entry, click on the Update
button to update the book you just added. If you click on the Add button again another book will be added to the database. 

When manually adding a book to the database you can base it on an existing book. Start by displaying the book you want to
copy in the detail view. Make any changes you want and then click on the Add button. Readerware will add a new book to the
database containing the data from the book you started with and your edits.

Top of Page
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Maintaining Database List Columns
To edit a list like Author, Category, Format etc., right click in the field and select Edit from the popup menu. Mac users should
Control-Click in the field. 

You can also display the List Editor by selecting from the Edit->Database Lists menu item. 

Use this dialog to easily maintain the database list columns. 

You can add, update, and delete entries. You can also clean up unused entries, combine entries and print the list etc.

The dialog contains a list of all entries. Each entry is displayed with a use counter so you know how many database records are
using each list entry

Once you have made all your changes click on the OK button to update the database. Click on Cancel to discard your changes. 

Adding New Entries

To add a new entry type in the new value and click on the Add button. The new entry will be added to the list. 

You will get an error if an entry with that name already exists. List entries are case insensitive, so Paperback and paperback are
considered duplicates. 

Updating Existing Entries

To update an existing entry first select the entry you want to update. The current contents will be displayed in the entry field.
Make your changes and click on the Update button. The selected list entry will be replaced.

You will get an error if an entry with that name already exists. List entries are case insensitive, so Paperback and paperback are
considered duplicates. 

Deleting Entries

To delete entries from the list select the entries you want to delete and then click on the Delete button. The selected entries will
be removed from the list.

To select multiple entries use the standard list selection keys for your operating system. For example on Windows hold down the
Ctrl key on your keyboard and click on the next entry. On Mac OS X hold down the Command key and click on the next entry.
To select a range of entries, hold down the Shift key and click on an entry, all entries between the new and previous selections
are now selected. 

Removing Unused Entries

Each item displayed in the list is followed by it's use count in parentheses. This is the number of records in the database that
use this list entry.

If an item, is unused, the use count will be zero.

To remove all unused entries click on the Clean Up button. All list entries with a use count of zero will be removed. A count of
the removed items will be displayed. 

Merging Entries

You can combine multiple entries into one entry using the merge function. 

Start by selecting the main entry, the entry you want to merge the others into. 

Now select the entries you want to merge into the main entry. To add these entries use the standard list selection keys for your
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operating system. For example on Windows hold down the Ctrl key on your keyboard and click on the next entry. On Mac OS X
hold down the Command key and click on the next entry. 

You should now have the main entry displayed in the field to the right of the list and all affected entries selected in the list. For
example suppose you had three location values, Box 1, Box 2 and Box 3. You moved all the items into a bigger box and want to
update the database so that all items are now shown as being in Box 1. You start by selecting Box 1. Now you add Box 2 and
Box 3 to the selection. Box 1 is displayed in the entry field to the right of the list and all three entries are selected in the list. Click
on the Merge button. 

A confirmation dialog will be displayed. Note that the changes will be applied to the database immediately. Readerware will then
change the location selection on all affected records so that all records that were in Box 2 or Box 3 are now in Box 1. The Box 2
and Box 3 list entries will still be there, but they will have a use count of 0. Use the Clean Up function if you want to remove
these entries completely. 

Printing the List Entries

To print the list just click on the Print button. All the list entries will be printed.

 

Contributor Lists

To edit a contributor list like Author, Artist or Actor etc., right click in the contributor field and select Edit from the popup menu.
Mac users should Control-Click in the field. 

The process is basically the same as for normal lists but the List Editor Dialog has some additional fields. 

The contributors are displayed in a list sorted in your preferred sequence. You can change the sort in preferences, select the
Preferences menu item, then Contributors. 

When you select a contributor from the list, Readerware displays both the display and sort names and you can edit both. All the
functions mentioned above are available when editing contributors. You can add, update and delete contributors, you can clean
up unused contributors and you can merge contributors. Sometimes different sites will display author or artist names differently
and you can end up with multiple variations of the same name. For example when looking through my music library I found
albums by:

Gladys Knight & Pips
Gladys Knight & the Pips
Gladys Knight And The Pips
Gladys Knight/Pips
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Using the merge feature you can select the entry you want to standardize on, then select the entries you want to merge. Click on
the Merge button and Readerware will go through your entire database and update each affected album to use the correct entry.
The old entries are still in the list but these are now unused, you can click on the Clean Up button to remove them. 

The Contributor List Column Editor makes it easy to clean up some of inevitable extraction errors and lets you standardize
author, artist, actor names just the way you want them. 

As the Contributor List Column Editor does update your entire database, we do recommend that you create a backup of your
database before starting any major cleanup.
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Customizing Readerware Extraction
First off, this is not for everyone. Customizing the Readerware extraction process means getting your hands dirty and writing
some Python scripting code to massage the data extracted. But for those of you that have experience writing scripts, this is an
extremely powerful feature. 

So why would you want to customize the extraction? With the release of Readerware 3.0, there is a lot less need for custom
extraction. Readerware auto-catalog now lets you specify what fields are extracted and supply default values for any field. There
are a lot more standard fields in Readerware 3.0 which are extracted automatically. So if you have come to this page to learn
how to migrate your Readerware 2.0 scripts to Readerware 3.0, the answer might be to throw them away and forget about
custom extraction. 

One use for custom extraction is to standardize fields like category or publisher. Using custom extraction you can look at the
current contents of a field and change it. 

To start using custom extraction you need to install the script file and then customize it. You can download the base script file
from

http://www.readerware.com/misc/rwuserexit.py

You need to save this file into your Documents->Readerware folder. You can save it there or copy/paste it into a text editor. 

By itself this script does nothing, but it is the starting point for developing your own scripts. To edit this script file use a text editor
like Notepad or TextEdit. Add your statements to the script at the point indicated. You should not otherwise change the script,
just add your statements. 

Readerware uses the Python language for the extraction scripts. Please note that indentation is very important in Python.
Python uses indentation to delimit code blocks. So when you add your statements to the supplied script you should add them
after the placeholder line and start them in the same column. 

As an example, suppose you wanted to map the categories extracted from a web site to your own categories:

# Add your statements here
if (string.find(rw.getCategory1(), "Mystery") != -1):
    rw.setCategory1("My Mystery Category")

You can probably see the basic idea, check for a string in the extracted category, if found replace the category with another. The
full list of the methods available on the rw object are included at the end of this document. 

Learning Python

There are a lot of resources available on the web to help you with Python and a lot of books available too. Just fire up your
browser and search for Python titles at your favorite book retailer. A good place to start your web search is at the official Python
site: http://www.python.org. 

Note that you don't have to install Python, all necessary libraries are included with the Readerware distribution. 

Python is a very powerful language and fairly easy to learn. If you're wondering about the name, yes it was named after Monty.
Unfortunately Readerware cannot offer support on Python itself. You will need to discover the power of Python for yourself. 

A good choice is "Learning Python by Mark Lutz", it has a very readable approach, covers the basics and advanced topics. The
"Python Pocket Reference by Mark Lutz" is a handy thing to keep by your keyboard. Another good one is "Text Processing in
Python by David Mertz". A friend recommends "Python Programming on Win 32 by Mark Hammond", it covers Python with
particular emphasis on using it with Windows. 

Debugging Your Script

Even the best Python programmer is going to make a mistake once in a while. Fortunately it is easy to debug your scripts with
Readerware. First, start Readerware, go to General Preferences and ensure the Enable Readerware logging option is
checked. You must restart Readerware when you change this option. 

Use Readerware as normal. When extracting data Readerware will output debugging information and any error messages to a
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log file. 

You will find this log file in your Documents->Readerware->Logs folder. You can view it in any text editor. 

Also with logging on, Readerware will write the HTML file it retrieved from the web site to the logs folder as trace.html. This can be
useful sometimes when debugging scripts. 

Available Methods

The following methods are available to get and set extracted data. They are accessed from the rw object, i.e. rw.setTitle("My
Title") 

getTitle()
setTitle(data)
getSubtitle()
setSubtitle(data)
setAuthors(authorList)
getAuthor()
setAuthor(data)
getAuthor2()
setAuthor2(data)
getAuthor3()
setAuthor3(data)
getAuthor4()
setAuthor4(data)
getAuthor5()
setAuthor5(data)
getAuthor6()
setAuthor6(data)
getTranslator()
setTranslator(data)
getIllustrator()
setIllustrator(data)
getEditor()
setEditor(data)
getPublisher()
setPublisher(data)
getPublicationPlace()
setPublicationPlace(data)
getReleaseDate()
setReleaseDate(data)
getCopyrightDate()
setCopyrightDate(data)
getPages()
setPages(data)
getEdition()
setEdition(data)
getLanguage()
setLanguage(data)
getSigned()
setSigned(data)
getDimensions()
setDimensions(data)
getReadingLevel()
setReadingLevel(data)
getLexileLevel()
setLexileLevel(data)
getCopies()
setCopies(data)
getBarcode()
setBarcode(data)
getISBN()
setISBN(data)
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getISSN()
setISSN(data)
getLCCN()
setLCCN(data)
getDewey()
setDewey(data)
getCallNumber()
setCallNumber(data)
getUserNumber()
setUserNumber(data)
getType()
setType(data)
getFormat()
setFormat(data)
getSeries()
setSeries(data)
getSeriesNumber()
setSeriesNumber(data)
getMyRating()
setMyRating(data)
getCondition()
setCondition(data)
getCoverCondition()
setCoverCondition(data)
getCategory1()
setCategory1(data)
getCategory2()
setCategory2(data)
getCategory3()
setCategory3(data)
getLocation()
setLocation(data)
getKeywords()
setKeywords(data)
getReadCount()
setReadCount(data)
getLastReadDate()
setLastReadDate(data)
getProductInfo()
setProductInfo(data)
getMyComments()
setMyComments(data)
getSource()
setSource(data)
getCatalogNumber()
setCatalogNumber(data)
getPurchasePrice()
setPurchasePrice(data)
getPurchaseDate()
setPurchaseDate(data)
getPurchasePlace()
setPurchasePlace(data)
getListPrice()
setListPrice(data)
getItemValue()
setItemValue(data)
getValuationDate()
setValuationDate(data)
getCurrencySymbol()
setCurrencySymbol(data)
getFavorite()
setFavorite(data)
getOutOfPrint()
setOutOfPrint(data)
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getMediaURL()
setMediaURL(data)
getOwner()
setOwner(data)
getStatus()
setStatus(data)
getExternalID()
setExternalID(data)
getASIN()
setASIN(data)
getSalePrice()
setSalePrice(data)
getSaleDate()
setSaleDate(data)
getNewPrice()
setNewPrice(data)
getNewCount()
setNewCount(data)
getUsedPrice()
setUsedPrice(data)
getUsedCount()
setUsedCount(data)
getCollectiblePrice()
setCollectiblePrice(data)
getCollectibleCount()
setCollectibleCount(data)
getBuyerWaiting()
setBuyerWaiting(data)
getWeight()
setWeight(data)
getSalesRank()
setSalesRank(data)
getImage1()
setImage1(data)
setRefImage1(data, ref)
getImage2()
setImage2(data)
setRefImage2(data, ref)
getLargeImage1()
setLargeImage1(data)
setRefLargeImage1(data, ref)
getLargeImage2()
setLargeImage2(data)
setRefLargeImage2(data, ref)
getUser1()
setUser1(data)
getUser2()
setUser2(data)
getUser3()
setUser3(data)
getUser4()
setUser4(data)
getUser5()
setUser5(data)
getUser6()
setUser6(data)
getUser7()
setUser7(data)
getUser8()
setUser8(data)
getUser9()
setUser9(data)
getUser10()
setUser10(data)
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setChapter(volume, chapter, title, author=None)
convertName(data)
getLogsDir()
getDocsDir()
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Searching Your Database
There are two ways to search your database. 

The search bar is always available in the main window and provides instant access to the powerful search facilities
built into Readerware. Select the column or field you want to search, the operator to use and the value you want to
search for. Click on the Search button or hit the Enter key to begin your search. 

You can click on the Adv. Search button to build a more complicated search. You can enter multiple conditions and
combine them with and/or. You can also save your advanced searches and easily run them at any time by selecting
them from the Search->Saved searches menu item.

You can use the search bar for quick, simple searches and you can use the Advanced Search Window to build more
sophisticated searches. With advanced search you can search on multiple fields, you can search fields for multiple values, date
ranges etc. 

A Readerware search consists of three components:

The column or field you want to search, i.e. Author, Title, Category etc.
The operator, is, contains, begins with etc.
The value you are searching for

The operator list is new in Readerware 4 and gives you more control over your searches. In Readerware 3 you could include
wildcards in the value field to achieve some of these results. In Readerware 4 the use of wildcards is discouraged, use the
operators contains, begins with and ends with instead. If you do enter wildcards in your search values, the operator selection is
ignored. 

That is really all there is to it. A more detailed explanation of the various search options follow. At this point you might prefer to
simply go and play. 

The Search Bar

The search bar is always available in the main window and provides instant access to the powerful search facilities built into
Readerware. Select the column or field you want to search, the operator to use and the value you want to search for. Click on
the Search button or hit the Enter key to begin your search. 

You can search on virtually any field. As you select the different search types you will notice that the operator list and search
criteria field will change. Sometimes you will type the search criteria in an entry field, for example a title search. Sometimes you
will select from a list, for example an author search. 

You can configure the search bar, put the searches you use all the time at the top of the list, hide searches you never use etc. If
you are looking for one of the searches listed below but don't see it in the search list, you just need to enable it in preferences. 

The operator list is new in Readerware 4 and gives you more control over your searches. The list of operators will vary based on
field selection. For example if you search a text field like title the operators will include:

Is - Readerware looks for an exact match of what you enter
Contains - Readerware looks for the text you enter anywhere in the field
Begins with - Readerware looks for the specified text at the beginning of the field
Ends with - Readerware looks for the specified value at the end of the field
Is empty - The value field is ignored and Readerware looks for items that have nothing in the selected field

If you select a date search you will have operators to search for an exact match, on or after, before etc. 

If you select a numeric field then you will have operators to search for an exact match, greater than, less than etc. 

If you search a contributor like Author, Editor, Illustrator etc., there is one additional option that you can set to refine your
searches. Select the Preferences menu item, then Contributors. There is an option to Force a wildcard search. If that option
is selected then the default operator is set to Contains and Readerware will search for all contributors containing the value. If not
checked then the default operator will be set to Is and Readerware will search for an exact match. 
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Readerware Book Searches

Search Description

Author Select an author from the list using the mouse or keyboard. You can also type
part of a name and select an operator like Contains

Book ID Enter a book ID
Book Info Enter search text

Borrower Select a borrower from the list to display a list of books currently on loan to this
borrower

Borrower ID Enter or scan a Borrower ID to display a list of books currently on loan to this
borrower

Buyer waiting Select a value from the list using the mouse or keyboard
Call Number Enter a Call Number

Category Select a category from the list using the mouse or keyboard. Readerware will
search all category fields.

Chapter title Enter part of a title, Readerware will return any book with a chapter title
containing these characters

Comments Enter search text
Condition Select a condition from the list using the mouse or keyboard

Contributor
Select a contributor from the list using the mouse or keyboard. You can also
type part of a name and select an operator like Contains. Readerware will search
all contributor fields, Author, Editor etc.

Copies Select a value from the list using the mouse or keyboard. Readerware will
search based on the number of copies of a book you have

Copyright date Click on the down arrow and select the date using the calendar or type it in
Cover condition Select a condition from the list using the mouse or keyboard

Date entered Click on the down arrow and select the date using the calendar. Choose an
operator to search on just that date, on or after that date etc.

Date last updated Click on the down arrow and select the date using the calendar
Dewey Enter a Dewey Decimal Number

Duplicates The duplicates search will return possible duplicate books. You can determine
which fields are matched when checking for duplicates in preferences.

Edition Select a value from the list to search by edition, First etc.

Editor Select a contributor from the list using the mouse or keyboard. You can also
type part of a name and select an operator like Contains.

Favorites Select a value from the list using the mouse or keyboard

Format
Select a value from the list to search by book format, Hardcover, Paperback,
eBook etc.

Full text search Enter search text. Readerware will search all text fields for the entered value,
title, author, book info etc.

Illustrator Select a contributor from the list using the mouse or keyboard. You can also
type part of a name and select an operator like Contains.

Image Select a value from the list, Readerware will display books with and without
images

Inventory count
Select a value from the list using the mouse or keyboard. The inventory count
search is used to make sure all items are present after performing an inventory
of your collection.

ISBN/Barcode Enter an ISBN or scan the barcode

Keys search Enter search text. Readerware will search all key fields for the entered value,
ISBN, User Number, Book ID, Call Number etc.
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Keywords Enter comma separated keywords. Choose from the operator list to determine
how Readerware combines the keywords. Keyword order is not important

Language Select a value from the list to search by language

Last read date Click on the down arrow and select the date using the calendar. Choose an
operator to search on just that date, on or after that date etc.

LCCN Enter a Library of Congress Card Catalog number
Location Select a location from the list using the mouse or keyboard

Loan Count
Search based on the number of times a book has been loaned out. You can
search for an exact match, less than, greater than etc.

Loans

Select a value from the list using the mouse or keyboard. Readerware can
search for books on loan, overdue etc. If loan columns are displayed, the loan
information will be included. This search returns all active loans, if you have 5
copies of a book out on loan, the book is listed 5 times with the information for
each loan

My Rating Select a rating from the list using the mouse or keyboard

Out of print Select a value from the list using the mouse or keyboard. Readerware will
search for books in or out of print

Owner Select a value from the list using the mouse or keyboard to search by owner

Place Select a value from the list using the mouse or keyboard
Publisher Select a value from the list using the mouse or keyboard

Purchase date Click on the down arrow and select the date using the calendar, Choose an
operator to search on just that date, on or after that date etc.

Purchase place Select a value from the list using the mouse or keyboard
Read Select a value from the list using the mouse or keyboard
Reading Level Select a value from the list using the mouse or keyboard
Release date Click on the down arrow and select the date using the calendar or type it in

Series Select a value from the list. Readerware will search for books that are part of the
specified series

Signed Select a value from the list using the mouse or keyboard

Source Select a value from the list using the mouse or keyboard to search by the source
used to catalog the book

Status Select a value from the list using the mouse or keyboard

Title Enter part of a title, Readerware will return any item where the title contains
these characters

Translator Select a contributor from the list using the mouse or keyboard. You can also
type part of a name and select an operator like Contains.

Updated by last
wizard

This search will display those items updated by the last wizard run, i.e. the last
auto-catalog run. This can be useful when you want to review the changes made
by a wizard

User number Enter the user number of a book
User 1 -
User 10

These searches will appear in the search list under the name you assigned for
any user defined fields you activated. Enter search text

ASIN Enter an ASIN

The Advanced Search Window

When you click on the Adv. Search button the Advanced Search Window is displayed. The current search, i.e. the contents of
the search bar in the main window are included as the first search bar. 
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To add additional search criteria click on the And or the Or button. A new search bar is added and the two searches are
combined using the selected operator. If you make a mistake and select the wrong operator, you can just click on the correct
operator. The selected operator is always highlighted. 

The advanced window search bar is the same search bar you use in the main window so you should be familiar with defining
your searches. Refer the the Search Bar section for more information. 

You can add as many search bars as you need. Click on the - button to remove any extra search bars. 

Click on the Run Search button to run your search. The search window remains open so you always return to it and edit your
search if you do not get the expected results. 

Once your search is working as expected you can save it if you plan on using it again. Click on the Save As button to save a
new search. You will be prompted to name the search and this will now be displayed on the Search->Saved searches menu
item. Click on the Save button to save changes made to an already saved search. 

To copy an existing saved search, select it and click on the Save As button. The search is saved under the new name and you
can modify it. 

You can delete a saved search that you no longer need by clicking on the Delete button. 

You can switch between saved searches by selecting from the Saved searches drop down list. If a search has been saved the
name of the search is displayed in the window title bar and it is selected in the search list. So you always know which search you
are working on. 

To start a new search, click on the New Search button. The first search bar will be reset to the default search and additional
search bars removed. You can then configure a new search. Only the search window is reset. If the search has been saved, it is
still in the saved search list. 

The Default Search

Readerware allows you to define a default search. Readerware runs this search when you start the program or open a new
database. Initially the default search is set to search for all titles and display them sorted by author and title. To define your own
default search simply perform the search as normal using the search bar in the main window. Now select the Search->Save as
Default Search menu item. For example you could set the default search to display all unread titles or books in a specific
category. 

Searching for Duplicates

The duplicates search lets you quickly find duplicate entries in your database. Select Duplicates from the search by drop down
list and click on the Search button. Readerware will display a list of possible duplicate entries. If you do not see the Duplicates
entry in the search list, remember that you can customize the search list. You can hide the searches you never use and move
the searches you use all the time to the top of the list. If you don't see the Duplicates search, you just need to enable it in
preferences. 

Before you use the Duplicates search, there is one more question you need to consider, what is a duplicate? You have to tell
Readerware how to detect a duplicate entry, you do this by selecting the columns Readerware should match on. 

You might consider a duplicate to be a book with the same ISBN. You would select the ISBN column and then Readerware will
display a list of books with duplicate ISBNs. The results list will include all books where two or more books have the same ISBN.
However you could have the same title with different ISBNs, if you want to check for all copies of a particular title you could
select the Author and Title columns. What about format? Would you consider a hardcover and paperback edition of the same
title to be duplicates? If you do, then select the Author and Title columns in preferences. If you do not consider them duplicates,
include the Format column too. Now Readerware will only display titles with the same format as duplicates. 

You determine what constitutes a duplicate. If you are storing your books in different locations, you might only consider books in
the same location to be duplicates, the same title in another location is not considered a duplicate. So you include the Location
column in the duplicate check. This is a very flexible approach and you can always change the selection as the term duplicate
may mean different things to you in different situations. 

When Readerware displays the duplicates it lists only items that have two or more matches and it lists all duplicate items. If you
only have one book with a specific ISBN, it will not appear in the search results. If you have two books with the same ISBN, both
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books are listed. Four books with the same ISBN, all four books are listed. You can then examine each book and decide what to
do. If you want to delete duplicates, you can decide what entry to keep and what entries to delete etc. 
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Readerware Loan Tracker
Readerware now provides two ways to manage circulation. 

Introducing the Readerware Loan Client

The Readerware Loan Client is a separate program, part of Readerware Client/Server Edition, that just handles loans. It adds
additional functionality like importing borrowers, printing borrower barcode labels, borrower reports etc. It also makes it easier
and faster to check books in and out. 

The Readerware Loan Tracker continues to provide basic loan functionality within Readerware itself. The two systems are fully
compatible. For example if you check a book out in Readerware it will appear in the Readerware Loan Client. 

Using The Readerware Loan Tracker

The Readerware Loan Tracker provides an easy way to track items out on loan, you can easily loan out an item, set a due date
and search for all items out on loan and items overdue. 

Checking Items In and Out

You can access the Loan Tracker in several ways:

Select the item in any view and then select the Edit->Check In/Out menu item.
Select the item in any view and then use the Edit->Check In/Out shortcut keystroke listed on the menu item.
Click on the Loan button from the Readerware detail view while displaying any item in your collection.

The Loan Tracker Window

In The Readerware Loan Tracker Window, you can enter the following information:

Loan Number - If you have multiple copies of an item, you can have multiple loan records. Readerware will not allow
more loan records than you have copies.

To add a new loan, select the <New Loan> entry. If this entry is not in the list, it means that you have already loaned
out all copies.

To update an existing loan or return an item, (delete the loan), select the appropriate loan number. If no loan
numbers are displayed in the list, there are no existing loans.

Loaned To - The name of the person or organization borrowing the item, (Required field). 

You can select the borrower from the list or enter a new borrower. When you add the loan, the borrower is
automatically added to the list and can be selected next time they borrow an item. 

Loaned Date - The loan date, this defaults to the current date, (Required field).

Due Date - The due date, the default loan period is set in Preferences, (Required field).

Click on the New Loan button to add the item to the Readerware Loan Tracker database.

Click on Update Loan to update an existing loan entry.

When the item is returned, click on the Returned button to delete the item from the Readerware Loan Tracker database.

Click on Cancel to dismiss the Readerware Loan Tracker without making any changes. 

Searching for Items on Loan and Overdue

To search for items out on loan, use the standard Readerware Search facility and select On Loan from the search by combo box
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and either Out On Loan or Overdue from the search for drop down list. 

Loan Statistics

Readerware automatically tracks the number of times an item was loaned out and the date of the last loan. These database
fields can be added to the table view. Normally they are set automatically but you can also update these fields manually. 

These statistics can aid you in removing unused titles from your library.
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The Readerware Want List
You can use the Readerware Want List to track the items you want to add to your collection. Click on the Want List toolbar
button to display your want list.

When you add an item to your database it is assigned a status code, the default status is "Own" which means that the item is in
your collection.

Any item with a status code of "Want" or "Ordered" is not yet part of your collection and will appear in your want list.

You can move items in and out of your want list by changing the item status.

You can also drag & drop items onto your want list. The item will be added to your database with a status of "Want", so it will
also appear in your want list automatically.

By default Readerware displays want list items in the main database and in the want list. If you prefer that want list items do not
appear in the main database, you can change how Readerware handles want list items in Preferences.

Using the Readerware want list

When you open your want list Readerware will display all items in the list in a standard table view. You can configure this table
just like a normal table view. You can show/hide columns, move them around, sort your want list on any column etc.

Two columns in the want list table view are displayed as links, the product key, i.e. the ISBN or UPC and the record ID. Clicking
on either of these links will display the full item in the detail view.

With the Readerware want list you can:

Print your want list, select the File->Print menu item.
You can price check items, find the lowest price at your preferred sites, select the Price Items toolbar button or menu item.
You can select the sites Readerware searches when doing a price check using Preferences.
You can order items from supported online retailers, select the Order Items toolbar button or menu item.
You can remove items from your want list by clicking the Delete button. Note that items are not removed from the
database. The delete function changes the status code to "Own" so that the item no longer appears in your want list but is
now in the main database.
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Readerware Bulk Editor Wizard
Another powerful feature of Readerware is this search and replace facility. You can easily apply a change to one or more items
in your database.

These are the basic steps:

1. Identify the items you want to change
2. Identify the database column you want to update
3. Enter the new data
4. Run Readerware replace
5. Check the results

Item Selection

The first step is to select the items you want to update. Readerware gives you a number of options, some based on the current
search results. If using one of these options you must perform a search before launching the Readerware Replace Wizard. This
will establish the items you want to change.

On this panel you can select on of the following choices:

All Items in the database - The current search results are ignored and Readerware will change every item in your
database. A count of the total number of items in your database is also displayed.
Current Search Results - The items returned by the last search will be changed, these are the items currently displayed
in the main window. A count of the  number of items returned by the last search is also displayed.
Currently selected search results - The items currently selected in the main window are changed. You can select as
many items as you want. A count of the  number of items selected is also displayed.
Input a list of items - If you select this option the ISBN/UPC input panel will be displayed next allowing you to enter the
keys of the items you want to change. You can enter these manually or use a bar code reader.

ISBN/UPC Input

If you selected the Input option on the last panel, the ISBN/UPC input panel is displayed next. Otherwise you go straight to
database column selection. You tell Readerware which items to look for by entering the ISBN of the book, the UPC of a CD,
video etc. There are two ways to do this, you can simply scan the item with a barcode reader or type in the data, with or without
the punctuation.

If you are typing in CD and DVD barcodes, you must ensure that you type in all digits. A US barcode currently contains 12 digits,
a European barcode contains 13.

In the above example, you would enter 731458917724, you must include the digits to the left and right of the barcode.

Using a bar code scanner is often the fastest way to enter the list of items to update. Each day more and more companies make
low cost bar code readers available to consumers. Check the bar code reader section on the Readerware web site for more
information.

To enter the ISBN or UPC manually, simply type it in and press the enter key. Readerware will then validate the data and if
valid, move it to the list below. If invalid, Readerware will display an error message. Readerware also uses audible queues to
indicate a valid or invalid item number, so you don't have to keep looking at your screen each time you enter an item.

Normally when Readerware indicates that an ISBN is invalid, it means that you typed in the number incorrectly. Simply correct
the mistake and try again. Very rarely Readerware will display the error, even when you entered the ISBN exactly as printed on
a book. This is because the publisher included an invalid ISBN on the book. This does occasionally happen, especially on older
books when the ISBN was new. You can tell Readerware to accept this ISBN anyway and try and find it by clicking on the
Accept button in the dialog.

To scan in a barcode, refer to the instructions  that came with your scanner. Simply ensure that the input field has the focus and
scan. Readerware then receives the data, converts it if necessary and adds it to the list.
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To delete an item from the list, select it and hit the Delete key.

If the Allow Duplicates option is on, all books with the same ISBN/UPC will be updated. For example if you use the replace
wizard to edit the title format for a movie, the title will be updated on all items with this UPC.
 

Rerunning replace

You can rerun Readerware replace, maybe you want to change several fields in each record. You don't have to scan all the
items again, simply hit the Reload button to reload you last item list. 

Using a file of ISBN, UPC or bar code scans

Readerware can also read ISBN and barcode scans from a file. Select the Load List button and a file selection dialog is
displayed. Select the file and click on Open. The file must be a standard text file and contain one ISBN or bar code scan per line.
The ISBN can be entered with or without the hyphens. Readerware will then replace the contents of the list with the contents of
the file. You can use this feature to prepare a list of items to update ahead of time either in Readerware or another program like
a text editor.

Using a batch barcode reader

Readerware supports several batch barcode readers including the LaserChamp (Flic), Symbol CS-1504 and CS-2000 readers.
Batch barcode readers are not connected directly to your computer, You can scan barcodes into the reader and at a later time,
upload them into Readerware. This means that you can take the barcode reader to your shelves rather than drag your books,
CDs and videos to your PC. To upload barcodes from a batch barcode reader, click on the Upload button. 

Saving entered barcodes

You can optionally save the item list you just entered before continuing. Normally after you have entered your data you continue
through the wizard and update your items. But maybe you are at a remote location and do not have access to an internet
connection. You can save the data you entered to a file for later use. Click on the Save List button and select the location and
name for your file. To use the saved file, start the replace wizard again and click on the Load List button 
 

Column Selection

Your last task is to identify the database column to change and the new value. You can only change a single column with
Readerware replace.

You will see a drop down list of all database columns. Select the one you want to update. An editable field is then displayed and
you can enter or select the new value. If you don't enter a value, the replace will erase the current contents.

When you select the column you want to change, an appropriate editor is displayed where you can enter the new data. For most
fields, this is an entry field or a list. But Readerware also allows you to perform some very powerful operations on some
columns, 
 

Title

When you select the title column you can:

Enter a new title

Reformat titles from "The Title" to "Title, The".

Reformat titles from "A Title" to "Title, A".

Reformat titles from "An Title" to "Title, An".

Uppercase titles 
 

Value
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When you select the value column you can:

Enter a new value

Adjust existing values by a set percentage. For example, suppose you want to value your collection at 25% less that
the Amazon retail price. You could use Readerware auto-catalog or auto-update to extract the price from Amazon.
Then you would use the replace function to set the value to 75% of the current value. Readerware will update the
value on each selected item. 
 

Copies

When you select the copies column you can:

Enter a new value

Increment copies by the specified amount.

Decrement copies by the specified amount. 
 

User Number

When you select the user number column you can:

Enter a new user number.

Automatically generate user numbers based on a pattern. You specify the pattern, the starting value and the
increment. You use question marks in the pattern to identify where Readerware should insert the number.

To start with a simple example. If you specify a pattern of ?, starting value of 10000 and an increment of 100,
Readerware will generate user numbers of 10100, 10200, 10300 etc.

You can specify other text in the pattern which is used as is. You can specify multiple consecutive question marks to
control the width of the generated number. If you specify a pattern of ?????? each number will have at least 6 digits,
Readerware adds leading zeros if necessary.

The following table lists some examples: 
  
 

Pattern Starting Value Increment Numbers

? 10000 10 10010, 10020, 10030
????? 100 10 00100, 00110, 00120
TOM-?????-BK 100 100 TOM-00100-BK, TOM-00200-BK, TOM-00300-BK
BN-? 100 1 BN-100, BN-101, BN-102

Images columns

When you select one of the image columns you can:

Resize the images to your preferred size as set in preferences. 

Verify images. Readerware scans all the images to make sure they are valid. If the image is too large, it will be
resized. If the image is invalid, it will be deleted. 

Delete the images from the database. Bulk Editor changes can not be undone, so make sure you really want to
delete all your images. Backup your database first.
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Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running your replace. A quick summary
of your choices is listed. Note that your changes are applied to the database immediately, so review your selections to make
sure they are correct. Click on Next if you are ready to go. Click on Back if you want to change your choices. 
 

Replacing Page

When you reach this page, your replace is running. You will see a progress window that will update as Readerware processes
your items. In the background Readerware also updates the list each time an item is processed. If you want, you can move the
progress window out of the way to see more of the replace activity. Simply click on the title bar and drag the window out of the
way. The progress window will close automatically once the replace completes. Don't hit the Cancel button though, this will
abort the replace.

Initially each item in the list will have a question mark icon displayed next to it. This indicates that Readerware has not yet
processed this item. As it processes each item, Readerware changes the icon to indicate the results. The icons are:

- This indicates that the item has been changed 
- The item was not changed 
- The item could not be found in your database. This can only happen when you input an item list 

In addition to the icons, Readerware adds the title to each item. This is a very handy way to identify the items, it effectively gives
you their location on your shelves.

You can save the item list by clicking on the Save List button.

When you have reviewed the status of each item, click on the Next button to proceed to the final page of this wizard. 
 

Replace Complete Page

This page displays the overall statistics:

Items Input Count - The number of items processed
Items Updated Count - The number of items actually updated
Errors - The number of errors

Note that you can use the Back and Next buttons to toggle between the results and the auto-catalog summary page. When you
are done, click the Finish  button. Readerware will then display all the updated items in the main window. You can optionally
review and edit these updated items. Click on the toolbar browse button to return to the full database display.

This statistics information and a complete item by item listing is also written to a log file, if user logging is enabled. You will find
this file in your Documents->Readerware->Logs folder. You can view this file in any text editor
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About your Database
There is only one thing you really need to know about your database, where is it?

The first time you run Readerware you will be prompted to create your database.

The Database Chooser dialog lets you select from the following choices:

Create a New Database - Choose this option if you are a new user. The standard file selection dialog is displayed and you
can pick the location for your new database and enter the database name. The default location for the database is your
Documents folder.
Open an Existing Database - Choose this option if you are reinstalling Readerware. The standard file selection dialog is
displayed and you can select your database.
Connect to an External Database - This option is for advanced users and lets you connect to an external database via
JDBC.

Readerware remembers the location and will open your database automatically when you start the program. However it is
important that you know where your database is. When you create your initial database take a moment to think about what you
want to call it and where you want to create it. Choose a convenient location that you will remember.

A Readerware database is made up of multiple files and your database is created inside a folder. For example if you create a
database called "My Books", Readerware creates your database in a folder called "My Books.rw3". This keeps all the files
together and can make it easier to move or copy a database.
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View Statistics
You can display the view statistics dialog by selecting the View->Statistics menu item.

It is important to understand that the statistics are for the current search results. So if you want the statistics for the full database,
make sure you do a full database search or click on the All Books toolbar button. This means that you can also get statistics for
books by category, on loan etc.

This dialog contains the following information about your books: 

Number of titles (records) - This is the number of different titles displayed, i.e. the number of records.

Number of books - This is the number of books displayed. The difference between the title and book counts is that
books include copies. So if you have 2 books displayed and 3 copies of each book, the title count will be 2 and the
book count will be 6.

Total Value of books - This is the total value of all the books. This is just a simple accumulation of the estimated
value field. It does not perform any currency conversion. If you use this field, you should ensure that foreign
currencies imported from overseas web sites are converted to the local currency.

Number of unvalued books - The number of books that do not have an estimated value.

Number of first editions - The number of first editions.

Number of signed books - The number of signed copies

Number read - The number of books flagged as read

Number unread - The number of books not flagged as read. Just waiting for a rainy day.
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Database Properties
Select the File->Properties menu item to display the Database Properties dialog. 

General Tab

The general tab displays basic information on the current database:

Name - The name of the database main file. For Readerware Server databases this will include the name of the server
and the remote file name.
Type - The type of database:

Readerware Local - The is the normal type, it indicates you have opened a database on one of your drives.
Readerware Server - This indicates you are connected to a Readerware server.
External (JDBC) - This indicates you are connected to an external database via JDBC. This could be a MySQl
database, Microsoft SQL server etc.

Location - The location, the path of your database. For Readerware Server databases this will include the name of the
server and the path of the remote database.
Date created - The date the database was created.
Access mode - The current database access mode, Read only, Checkout mode or Full access:

Read only - You can search and browse the database but you cannot make any updates.
Checkout mode - You can search and browse the database, you can check items in and out but you cannot make
any other changes to the database.
Full access - You have full access to the database.

Driver name - The driver used to access the database. For a Readerware local or server database this will be the HSQL
Database Engine Driver, for external databases it will be the driver you chose when configuring the database.
Driver version - The driver version.

Statistics Tab

The statistics tab displays information about our database and the resources used:

Row count - The number of items in your database.
Size (in bytes) - The space your database occupies on disk.
Memory used - The amount of memory currently in use by your database.
Memory allocated - The amount of memory currently allocated by the database engine. Memory is allocated as needed.
Memory free - The amount of memory currently allocated but not in use.
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Copy/Paste Database Rows
You can copy/paste rows in a Readerware database, you can paste into the same database or another database. Use
copy/paste to help with data entry, to merge databases etc. 

Copying Rows

It is best to use a table view when copy/pasting rows, you can easily select groups of rows. You can select one or more rows by
clicking on the cursor icon at the beginning of a row. To select your first row, just click on the cursor icon. To select another row,
use the standard list selection keys for your operating system to select other rows or a range of rows. For example on Windows
hold down the Ctrl key on your keyboard and select the next row. On Mac OS X hold down the Command key and click on the
next row. To select a range of rows, hold down the Shift key and click on a row, all rows between the new and previous
selections are now selected. 

Select the appropriate menu item to copy the selected rows to the clipboard. Select Edit->Copy Albums, in the music program,
Edit->Copy Books in the book program and Edit->Copy Videos in the video program. 

Readerware will display a running count of the rows copied in the status bar at the bottom of the window. 

Pasting Rows

If you are going to paste the rows into another database, you should open the database first using the File->Open menu item or
the File->Open recent menu item. 

When pasting rows into a database Readerware honors the database allow duplicates option. If allow duplicates is off and the
ISBN or UPC already exists in the database, the paste will fail. You should turn on the allow duplicates option if you will be
pasting rows with the same ISBN or UPC into the database. Select the Preferences menu item, then Database, then Settings.
Make sure the allow duplicates option is checked. 

To paste the rows into the database, select the appropriate menu item to paste the rows from the clipboard. Select Edit->Paste
(Insert) Albums, in the music program, Edit->Paste (Insert) Books in the book program and Edit->Paste (Insert) Videos in
the video program. 

The paste does not replace any selected rows, the paste always adds the new rows to the database. 

Readerware will display a running count of the rows pasted in the status bar at the bottom of the window. Once all rows have
been pasted into the database the Paste Results Dialog is displayed. This includes statistics and a log so that you can examine
any errors. 

Copy/Pasting Large Databases

As Readerware uses the system clipboard when you copy/paste database rows, it is possible to slow down your system if you
copy/paste very large databases. In our testing here we were easily able to copy/paste over two thousand rows in a single
operation. So you can copy/paste entire databases. 

However if you need to copy/paste a very large database, you might want to copy/paste the database in smaller batches. 

The Paste Results Dialog

The dialog contains two tabs:

Statistics Tab - The statistics tab displays the number of rows input and added and the number of errors. 

Log Tab - The log tab displays each row input and the error message if there was an error adding the row. Click on
the Find Next Error button to locate the next error in the log. Click the Close button to close the dialog.

Once the Paste Results Dialog is closed Readerware will display all the new rows just added. You can browse through them and
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make any edits you want.
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Using External Databases
Most users will use the built-in database. However advanced users can use other database engines to store their data.

Readerware supports MySQL, SQL Server, and PostreSQL, however it should be possible to use any database that includes a
JDBC driver. Contact Readerware support for assistance on getting other databases to work with Readerware.

To access an external database from within Readerware you need to use the advanced open dialog. This is activated in
Preferences. 

Connecting to an external database or a Readerware server requires Readerware Client/Server Edition. If the Advanced Open
Dialog option is disabled, you don't have Readerware Client/Server Edition. Upgrades are available on the website. 

Using Readerware with MySQL

You need to install MySQL and create an empty database. Refer to the MySQL documentation for assistance with installation.

You will also need the MySQL JDBC driver, Connector/J. This is available from the MySQL web site, unfortunately licensing
restrictions prevent us from including Connector/J with Readerware.

Opening a MySQL Database

Select the File->Open Database menu item and the Advanced Open Dialog will be displayed.

From the Database type drop down list, choose MySQL. 

The dialog will be filled with appropriate values. There are a couple of entries you will need to customize:

Enter your MySQL user name and password.
In the URL field, change {hostname} to the machine name or IP address where MySQL is running. Use Localhost if it is
running on the same machine.
In the URL field, change {database name} to the name of the MySQL database, you must have already created the empty
database in MySQL.
In Driver Location click on Browse and select the MySQL Connector/J driver

Click on the Test Connection button and Readerware will attempt to connect to the database. If successful click on the OK
button to open the database. If the database is empty Readerware will create the necessary tables. 

Using Readerware with Microsoft SQL Server

You need to install SQL Server and create an empty database. Refer to the SQL Server documentation for assistance with
installation.

You will also need the Microsoft SQL Server JDBC driver installed.

Opening a SQL Server Database
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Select the File->Open Database menu item and the Advanced Open Dialog will be displayed.

From the Database type drop down list, choose SQL Server. 

The dialog will be filled with appropriate values. There are a couple of entries you will need to customize:

Enter your SQL Server user name and password.
In the URL field, change {hostname} to the machine name or IP address where SQL Server is running. Use Localhost if it
is running on the same machine.
In the URL field, change {instance name} to the name of the SQL Server instance you are connecting to.
In the URL field, change {database name} to the name of the SQL Server database, you must have already created the
empty database in SQL Server.
In Driver Location click on Browse and select the Microsoft SQL Server JDBC driver

Click on the Test Connection button and Readerware will attempt to connect to the database. If successful click on the OK
button to open the database. If the database is empty Readerware will create the necessary tables. 

If you get a connection error check to make sure that SQL Server has been set up to accept TCP/IP connections. Use the SQL
Server Configuration Manager and select Network Configuration. Now select Protocols for the SQL Server instance you are
connecting to. Make sure TCP/IP support is enabled as shown in the screen below. 

 

You also need to set the correct TCP/IP port for IPAll. Right click on TCP/IP and select Properties from the popup menu. Select
the IP Addresses tab. Locate IPAll and set it to use port 1433 or whatever port you are using. 

Page 61 of 145



 

Using Readerware with PostgreSQL

You need to install PostgreSQL and create an empty database. Refer to the PostgreSQL documentation for assistance with
installation.

You will also need the PostgreSQL JDBC driver. This is available from the PostgreSQL web site, unfortunately licensing
restrictions prevent us from including it with Readerware. 

Opening a PostgreSQL Database

Select the File->Open Database menu item and the Advanced Open Dialog will be displayed.

From the Database type drop down list, choose PostgreSQL. 

The dialog will be filled with appropriate values. There are a couple of entries you will need to customize:

Enter your PostgreSQL user name and password.
In the URL field, change {hostname} to the machine name or IP address where PostgreSQL is running. Use Localhost if it
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is running on the same machine.
In the URL field, change {database name} to the name of the PostgreSQL database, you must have already created the
empty database in PostgreSQL.
In Driver Location click on Browse and select the PostgreSQL driver

Click on the Test Connection button and Readerware will attempt to connect to the database. If successful click on the OK
button to open the database. If the database is empty Readerware will create the necessary tables. 

Changing Databases

If you want to change database engines and move an existing database to a new format, use backup and restore.

Backup your existing database and then run the restore selecting the backup file you just created. On the Database Selection
page of the wizard, click on the Browse button and select the new database as normal.

For example you could backup a standard Readerware database and restore it to a MySQL database. Once the restore
completes Readerware will open your new database and your existing data will be displayed. 

Important note: You must restore the backup to an empty database. Do not open the external database in Readerware first as
that will create the standard database tables and the restore will fail. Create an empty database and then restore a Readerware
backup to it.
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Readerware Export Wizard
There are a number of reasons for using Readerware export:

Transfer you database to your mobile device, take your database with you on your next trip to your favorite book stores.
Create your own web pages to publish your collection online.
Transfer data to online book sellers and auction sites.
Transfer data to other programs or databases

Readerware Export is not a good way to transfer your Readerware database to a new machine. Use backup and restore to
transfer your complete Readerware environment to a new machine. 

Readerware export allows you to export the data in your Readerware database to a number of different formats:

CSV, (Comma Separated Value) - This is a standard data interchange format, use it to transfer data to other programs
and databases.
TAB Delimited - Another standard data interchange format. You can open a TAB delimited in file in a spreadsheet
program like Microsoft Excel or Open Office. A TAB delimited file provides an easy way to transfer your Readerware
database to a spreadsheet.
HTML - The universal language of the web, you can export your Readerware database to HTML to create web pages.
Readerware will build an HTML table displaying all the selected rows and columns. When Readerware creates the HTML
table it uses a style sheet, rware.css, which is distributed with the product. The style sheet controls various formatting
options such as the colors, font styles etc. To display correctly you must copy the rware.css file to the same location as the
exported HTML file. You can customize the style sheet, change the font or color of the HTML title, the background colors
used in the table etc. You can also create more advanced HTML pages using the Readerware Report Writer. 
Readerware Mobile - You can transfer your database to your Android phone or tablet, iPhone, iPad, iPod Touch etc. with
Readerware Mobile a lightweight edition of Readerware that runs on portable devices. In most cases you can also use the
network sync option to transfer your database to your mobile device, this is faster and easier than using export.
iPod Notes - You can transfer your Readerware database to your iPod MP3 player and have it with you when you shop.
Readerware can export your data right to your iPod, just connect it and then select your iPod on the Folder Selection page
of the wizard. To access your database on your iPod, select the Notes function and then Readerware.
Images - Create image files from your Readerware database. You can choose the image, the image format and how the
image files are named.
Generic UIEE (Universal Information Exchange Environment) - A common format used to exchange book information.
It is used by several book  sites.
Amazon UIEE - A non-standard version of the UIEE format used by Amazon.
BookHound -  You can transfer your database to BookHound from Bibliopolis.
HomeBase 2.0 - You can transfer your data to HomeBase from Advanced Book Exchange Inc. You can also upload the
exported file to the ABE web site. To import this into HomeBase, select File->Import / Export->Import from the
HomeBase menu. Select the merge or zap option and click OK. Select the file you created in Readerware. Here is a tip, if
you plan to regularly transfer files between HomeBase and Readerware, save the file in the HomeBase export directory.
Then when you try and import the file into HomeBase it will be right there. Readerware will remember the location when
you create your next export
Bookzangle -  This format lets you integrate with the Bookzangle system. https://bookzangle.com/ .

Exporting

These are the basic steps:

1. Pick the format you want to export to
2. Select the file you want to export to
3. Select the books you want to export
4. Select the database columns you want to export
5. Run Readerware export
6. Check the results

Format Selection

This is the first page of the Readerware export wizard. The first step is to select  which format you want to create the file in. Your
choices are:
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CSV, (Comma Separated Value)
TAB delimited.
HTML
Readerware Mobile
Readerware Mobile (iPod Notes)
Images
Generic UIEE, (Universal Information Exchange Environment)
Amazon UIEE
BookHound
HomeBase 2.0
Bookzangle

CSV/TAB Delimited Options

When you select the CSV or TAB delimited formats the following options are available:

Output header line - Include the column header line used to identify the columns contained in the file.
Enclose fields in double quotes - Readerware will enclose fields in double quotes when necessary. Use this option when
you always need the fields enclosed in double quotes.
Escape new lines - Some other programs cannot import fields containing new lines. Choose this option and Readerware
will replace new lines with '\n'.

File/Folder Selection

You need to tell Readerware the destination for the exported data. 

Click on the Browse button and select the file or folder from the standard selection dialog.

If you check the Always replace existing file check box Readerware will automatically overwrite this file if it exists. This is
useful if you are doing regular export runs to the same file. If this is not checked, Readerware will display a confirmation dialog
before overwriting an existing file. 

For TAB delimited, CSV and Bookzangle files you can also select the file encoding. This is important if your database contains
data in multiple languages. You are exporting data from Readerware and importing into another program. It is important that you
select the encoding that the other program is expecting. If there is a mismatch then data may not transfer correctly.

ANSI - This is your system encoding and is the default. It will work for databases that contain the system language.
Unicode (little endian) - Unicode is a double byte character set and can handle virtually any language and any
combination of languages. Little endian is used on Intel systems.
Unicode (big endian) - Unicode is a double byte character set and can handle virtually any language and any
combination of languages. Big endian is used on other systems like PPC.
UTF-8 - UTF-8 is a variable width encoding and can handle all characters in the Unicode character set. It has become
popular as you don't need to worry about endianness.

In general you should choose either ANSI or UTF-8. If you are exporting your database to another program on the same system
ANSI should work fine. If your database contains multiple languages or you are transferring the file to another computer, use
UTF-8. But remember the other program must be able to handle the encoding you select, so check their documentation. 

Book Selection Page

There are two or three choices when selecting which books to export. The number of choices depends on the format selected.
The choices are:

All books in the database - This will export all books in the database, the complete database.
Current Search Results - The books returned by the last search are exported. You need to search for the books before
starting the Readerware export wizard. You can control exactly which books are exported, for example you can search by
category, then date entered etc.
Currently selected search results - This will export all selected books. You can search for books and then select the books
you want to export.

Page 65 of 145



Column Selection Page

Some formats determine the columns that are exported, for example Amazon UIEE format defines which columns need to be
included in the exported file. In this case the column selection page is not displayed.

There are two ways to select the database columns you want to export

Current View Columns - The columns currently displayed in the search results table will be exported. Readerware views
are extremely flexible. You can define any number of views and control which columns are included in each view and the
order.  If you have a regular export you want to run, create a view for the export containing exactly the data you want. Then
just select the view before starting the Readerware export wizard.
Selected Database Columns - If you select this option the list of database columns is enabled. You select exactly which
columns you want to export and the order. Columns listed with a green check mark are exported, those listed with a red
cross are not. Double click on any entry to toggle its state. To change the order of the columns, select an entry in the list
and use the up and down arrows to change its location in the list.

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running Readerware export. A quick
summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 

Export Running Page

When you reach this page, Readerware export is running. You will see a progress bar that will update as Readerware exports
the data to the file. Immediately below the progress bar is a Cancel button which you can use to interrupt the export.

When the export completes, click on the Next button to proceed to the final page of this wizard. 

Export Complete Page

This page displays the overall export statistics:

Books Processed - The number of books written to the export file
Errors - The number of books that could not be written.

Normally this is all the information you need to ensure your data was exported correctly. If user logging is enabled, Readerware
also creates a log file called rwuser.log. This file lists each book and any error messages. You can view this log file in any text
editor.

When you are done, click the Finish  button to exit the export wizard.
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Readerware Import Wizard
Readerware can import data from other databases and programs. This can be useful if you are currently using another product
to maintain your collection and want to upgrade to the power of Readerware. As long as your current program can export data to
one of the two industry standard formats, you can transfer your existing data into Readerware. 

Readerware can import:

CSV or Comma Separated Value files - These files contain the data for each database column separated by a
comma. The first line of the file is a mapping line which allows you to map the data to Readerware database column
names. 

TAB Delimited Files - These are similar to CSV files except that the data is separated by the tab character. Again
the first line of the file is a mapping line which allows you to map the data to Readerware database column names. 

HomeBase 2.0 - This is the format used by HomeBase 2.0 and the ABE online site. To transfer data from from
Homebase export to Homebase format and then import the file into Readerware.

Mapping data for import into Readerware

A CSV or TAB delimited file is organized much like a spreadsheet. Each record in the file is a row in the spreadsheet. Each
record contains the data for each column in that row. 

Here is an example of a CSV file:

"Author","Title","Publisher" 
"Smith, Harry","My Story","HS Publ."

The problem is how does Readerware know what order the columns are in? The mapping line is key to importing data into
Readerware. The first row of the file is the mapping line and it identifies which Readerware database columns the data should
be imported into. This is a common technique used with CSV and TAB delimited files, your file may already have a mapping line
as the first line of the file. or it may just contain the data. You need to open the file using a text editor like Notepad or TextEdit.
Look at the first line. If there is a mapping line, you need to change the column names to match the Readerware column names.
If it is not there, you need to add the line. 

If there are columns in the file you do not want to import into Readerware you can use a column name of "Junk". Any column
name that Readerware does not recognize will be skipped. 

Readerware Column Names

Use the following table to build the mapping line.

Readerware Column Names
Column Name Contents

Author
Author2-Author6 Authors, Readerware supports up to 6 authors per book

Illustrator Illustrator
Translator Translator
Editor Editor
Title Book title, required
Alt_Title Alternate book title

Subtitle Book subtitle

Series Series name if the book is part of a series
Series_Number Series number if the book is part of a series
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ISBN ISBN - International Standard Book Number
LCCN LCCN - Library of Congress Card Catalog Number
ISSN ISSN - International Standard Serial Number
Dewey Dewey Decimal Number
Call_Number Library of Congress Call Number
User_Number Used for your own numbering system
Barcode The raw barcode
Publisher Book publisher
Pub_Place Place of publication
Release_date Date of publication
Copyright_date Copyright date
Pages Page count
Edition Edition value, First etc.
Signed Signed value, Signed, Inscription etc.
Content_Language Language
Reading_Level Reading level or age range etc.

Lexile_Level The Lexile Framework for Reading is an educational tool that uses a Lexile
to match readers of all ages with books

Copies Number of copies of this book
Format Hardcover, Paperback etc.
Item_Condition Condition of the book
Cover_Condition Condition of the book jacket
Category1 -
Category3 Book categories, Readerware supports up to 3 categories

Keywords Book related keywords separated by commas. 255 characters maximum
Product_Info Book information, synopsis, reviews etc. 65536 characters maximum
My_Comments Your comments on this book. 65536 characters maximum
My_Rating Book rating
Favorite Favorite book? True or False
Read_Count Number of times you have read this book

Date_Last_Read Last time you read this book
Location Physical location of this book
Dimensions Physical dimensions
Weight Shipping weight of this book
Source The source of the information, i.e. web site it was cataloged from
Item_Value Current value of this book
Valuation_Date Date this book was last valued
List_Price List price of book
Purchase_Price Amount paid for the book
Purchase_Date Date this book was purchased
Purchase_Place Where this book was purchased
Out_Of_Print Out of print? True or False
Currency_symbol Currency symbol used for all prices
Media_URL Link to related media, e.g. eBook file
Owner Owner of this book
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Status Status, must be one of Own, Want, Ordered, For Sale, Sold, Withdrawn,
Missing

External_ID External ID for this book, could be Library of Congress Number etc.
AM_ASIN Amazon ASIN
Sale_Price Sale price
Sale_Date Date sold
New_Value Value of a new copy
New_Count Number of new copies available
Used_Value Value of a used copy
Used_Count Number of used copies available
Collectible_Value Value of a collectible copy
Collectible_Count Number of collectible copies available
Buyer_Waiting Buyer waiting for a copy of this book
Sales_Rank Sales ranking of this book
Loan_To If the book is checked out, the name of the borrower
Loan_To_Brwr_ID If the book is checked out, the ID of the borrower
Loan_To_Email If the book is checked out, the e-mail address of the borrower
Loan_To_Phone If the book is checked out, the phone number of the borrower
Loan_Out If the book is checked out, the date the book was checked out
Loan_Due If the book is checked out, the due date of the book
Loan_Count The number of times the book has been loaned out
Last_Loan_Date The date the book was last loaned out

User1 - User10 User defined fields. Readerware supports up to 10 user defined fields.
Maximum length 255 characters

IMAGE1_FILE The full path of the first thumbnail sized image file
IMAGE2_FILE The full path of the second thumbnail sized image file
IMAGE3_FILE The full path of the third thumbnail sized image file
IMAGE4_FILE The full path of the fourth thumbnail sized image file
LARGE_IMAGE1_FILE The full path of the first large sized image file
LARGE_IMAGE2_FILE The full path of the second large sized image file
LARGE_IMAGE3_FILE The full path of the third large sized image file
LARGE_IMAGE4_FILE The full path of the fourth large sized image file

If you use an invalid column name, the data in that column is not imported. This can be useful. If the file contains some columns
that you do not want to import into Readerware, use a column name like "JUNK" and the data will be ignored. 

Importing

These are the basic steps:

1. Indicate the format of the file you are going to import
2. Select the file
3. Run the Readerware import
4. Check the results

Note: If the Allow Duplicates option is on Readerware will accept duplicate ISBNs. If the Allow Duplicates option is off, duplicate
ISBNs will be rejected. 

Format Selection
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Format Selection

This is the first page of the Readerware import wizard. The first step is to select which format the file you are importing is in.
Your choices are CSV, (Comma Separated Value), TAB delimited or HomeBase 2.0. See above for more information on the file
formats. 

File Selection

You need to tell Readerware the name of the file you wish to import and where it is located. Click on the Browse button and
select the file using the standard file selection dialog. 

For TAB delimited and CSV files you can also select the file encoding. You are importing data from another program into
Readerware. It is important that Readerware uses the correct encoding when reading the file. If there is a mismatch then data
may not transfer correctly.

Automatic detection - In many cases Readerware can determine the encoding by examining the file, however this
can sometimes fail to detect the correct encoding. Readerware displays the encoding on the Verification screen. If
this does not match the file, hit the Back button and select the correct encoding.
ANSI - This is your system encoding and is the default. It will work for databases that contain the system language.
Unicode (little endian) - Unicode is a double byte character set and can handle virtually any language and any
combination of languages. Little endian is used on Intel systems.
Unicode (big endian) - Unicode is a double byte character set and can handle virtually any language and any
combination of languages. Big endian is used on other systems like PPC.
UTF-8 - UTF-8 is a variable width encoding and can handle all characters in the Unicode character set. It has become
popular as you don't need to worry about endianness.

In general you should use automatic detection. If Readerware is unable to determine the encoding used, you can select the
correct encoding from the list. 

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running Readerware import. A quick
summary of your choices is listed. Click on Next> if you are ready to go. Click on Back if you want to change your choices. 

Import Running Page

When you reach this page, your Readerware import is running. You will see a progress bar that will update as Readerware
imports the data from the file. 

When the import completes, click on the Next button to proceed to the final page of this wizard. 

Import Completed Page

This page displays the overall import statistics:

Books Processed - The number of books in the imported file
Errors - The number of books that could not be imported.

Normally this is all the information you need to ensure your data was imported correctly. If user logging is enabled, Readerware
also creates a log file. This file lists each book and any error messages. Click on the View Log button. or you can view this log 

When you are done, click the Finish button to exit the import wizard. 

Import Errors

There are a few errors that can occur when importing data:

If the Allow Duplicates option is off, Readerware requires that the ISBN, if any, is unique. If the ISBN is already in the
Readerware database, it is not imported.
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Readerware Backup Wizard
The importance of backing up your data cannot be overstated. Readerware may be the fastest way to catalog your library, but
you will still invest a lot of time and effort in building your database just the way you want it. You should regularly backup your
database.

Fortunately, Readerware makes backups easy too. Its built in backup support creates a single ZIP archive of your database,
including all the data and images. To create a backup file, simply select File->Backup Database from the Readerware menu
and the backup wizard will guide you through the simple process.

You should then save that file in a safe place. Store it on another computer or hard drive, on a ZIP or other removable drive. If
you have a CD burner, put the file on CD. You could also consider putting it on an online server. Many standard ISP accounts
also give you online storage, more than enough space to safely store your Readerware database.

If disaster strikes and you need to restore your database, its just as easy. Start Readerware and select File->Restore Database
from the Readerware menu. Again, the restore wizard will step you through the simple process of recreating your Readerware
database. Once the restore completes, you can open your restored database by  selecting File->Open Database from the
Readerware menu.

Don't put it off, backup now!

Readerware allows you to easily backup your database to a compressed ZIP file. The backup file will contain all your data and
images. You can then save this file in a safe place.

To restore, simply launch the Readerware Restore Wizard.

Backup File Selection

You need to tell Readerware the name of the backup file you wish to create and where it should be located. The easiest way to
do this is to click on the Browse button and select the file using the file selection dialog. 

If you check the Always replace existing file check box Readerware will automatically overwrite this file if it exists. If this is not
checked, Readerware will display a confirmation dialog before overwriting an existing file. Use this option with care, for the best
protection you want to keep multiple backup files and not always replace the same file.

If you check the Add date to filename check box Readerware will automatically add the current date to the backup file name.
For example if you specify a backup file of "Books.zip" and this option is checked, Readerware may create the file as "Books
2007-03-19.zip". This makes the backup process automatic, let Readerware create a unique file for you each time you backup.
Having the date in the backup file name also makes it easy to identify the latest backup or restore your database to any point in
time.

It is a good idea to keep several backup files. You should also store them off your hard drive, maybe on CD, maybe on another
drive or computer, maybe online.

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running the Readerware backup. A
quick summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 
 

Backup Running Page

When you reach this page, your Readerware backup is running. You will see a progress bar that will update as Readerware
backs up the data to the ZIP file.

When the backup completes, click on the Next button to proceed to the final page of this wizard. 
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Backup Complete Page

This page displays the overall backup statistics:

Rows backed up - The number of items in your database that were backed up.
Images backed up - The number of image files backed up.

When you are done, click the Finish button to exit the backup wizard.

Backing Up Your Database to CD

To create a backup of your database on CD, you have to backup the database to your hard drive first, then copy the zip file to a
CD. 

Operating systems typically do not have file system support for CDs, you cannot write directly to a CD the way you can to a hard
drive. So backup to your hard drive first, then copy the file to CD.

This is where it gets tricky, getting the file to a CD differs with each OS. Some operating systems like Windows XP and Mac OS
X, have this capability built in. Others like Windows 98 don't, you need a third party utility. Normally you will get a utility to do this
with your computer or CD drive, maybe Nero, maybe EasyCD. 

Windows XP

To copy the Readerware backup file to a CD 

Insert a blank, writable CD into the CD recorder. 
If Windows XP asks you what to do with the blank disc, select "Open writable CD folder using Windows Explorer".
Otherwise double click on "My Computer", then double click on your CD drive icon. 
Drag and drop the Readerware backup file on to the CD folder 
Verify that the file(s) you intend to copy to the CD appear under "Files Ready to be Written to the CD". 
Under CD Writing Tasks, click Write these files to CD. Windows displays the CD Writing Wizard. Follow the instructions in
the wizard.

Mac OS X

To copy the Readerware backup file to a CD 

Insert a blank CD or DVD disc into the optical drive of your computer. 
If you see a dialog, you can choose an action from the pop-up menu. Then click OK. 
Type a name for the disc under the CD icon. 
Drag the Readerware backup file to the open window. 
The Finder places aliases to the files in the disc's window. 
Choose File->Burn Disc. 
The files that the aliases point to are burned to the disc.
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Readerware Restore Wizard
Readerware allows you to easily backup your database to a compressed ZIP file. The backup file will contain all your data,
images and preferences. You can then save this file in a safe place.

Should disaster strike, The Readerware Restore Wizard will guide you through the simple process of restoring your database. 
  
 

Backup File Selection

You need to tell Readerware the name of the backup file you wish to restore from and where it is located. Click on the Browse
button and select the file from the standard file selection dialog. 
  
 

Restore Options

A Readerware backup file contains both your database and your Readerware preferences. 

Normally you would restore your database only, but if you are restoring to a new system or your hard drive failed, you should
restore your preferences too. Preferences include your Readerware settings, licenses etc. 

Normally the default database size of 2GB is plenty. If you do exceed the maximum size you will get an exception when you add
new records to your database. This exception will state that the data file size limit has been reached . If you receive this error,
check the Maximum size option. The restored database will then support up to 8GB of data. 
  
 

Database Selection

You need to tell Readerware where to create the restored the database. Click on the Browse button and select the file from the
standard file selection dialog.

The new database name must not already exist, Readerware does not allow you to overwrite an existing database. 
  
 

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to running the restore. A quick summary of
your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 
  
 

Restore Running Page

When you reach this page, your Readerware restore is running. You will see a progress bar that will update as Readerware
restores  the data from the ZIP file.

When the restore completes, click on the Next button to proceed to the final page of this wizard. 
  
 

Restore Complete Page

This page displays the overall restore statistics:

Database components restored - This is the number of database tables restored.
Rows restored - This is the number of rows, books, albums or videos restored.
Preferences files restored - This is the number of Readerware preferences files restored.

When you are done, click the Finish button to exit the restore wizard.
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When you click on Finish, Readerware will open your new database.
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Reports
Readerware provides a built in reports facility. You have extensive control over the format of the report and the data selected for
printing. 

You can also define custom reports. 

The printing menu items work with the table view so are only active when a table view is displayed. 
 

Selecting the books to print

The Readerware reporting functions work together with the table views and search functions. You must select the view you want
to print  and run a search to establish the data you wish to print. Then when you select Print from the file menu or toolbar, the
current results set is printed in the format displayed.

You can define custom views to print just the database columns you want and in the order you want. The point to emphasize
here, is that views are not just for displaying data on the screen, they are also used to define reports. So name your new view,
"Summary Report" or "Inventory Report", then just select the appropriate view and print.

Readerware uses the current view to determine which columns to print, the order to print the columns and the order to print the
rows. It also uses the current view to determine how much space to allocate to each column when printing. Readerware
normally fills the entire width of the page with your data, adjusting the column widths as necessary. It allocates the same
proportion of the total width to each column.

Sometimes if you adjust the column width so that it just fits on the screen, it may be truncated  when printing due to differences
in printer and screen font sizes. You can fix this by selecting another font when printing, or adjusting the column width on the
screen.

If your report contains too many columns, they will all be shrunk to fit on the page. So if your report contains a lot of very narrow
columns with only a few characters of each column displayed, you are printing too many columns. The columns you select to
print must fit on the page, reduce the number of columns so that they all fit.

To show or hide columns, right click on the column title to display the popup menu. You can hide the current column or show
any previously hidden columns. The new column will be shown after the current column. So to show a column it is best to right
click on the title of the column that you want to appear before the new column.

You can also move columns around, simply click on the column header and drag the column to its desired location.

To sort the search results on any column simply click on the column header to sort the search results in ascending sequence.
Click again to toggle the sort sequence and display the search results in descending order.

The current view state is always saved when you exit Readerware or switch views so you never have to worry about saving your
changes.

You can refine your searches as described in the Search functions section. You can for example search for all books by a
particular author, then just hardcover and signed books. Then print these results.

To print the entire contents of your database, select one of the All data... formats from the toolbar. Then choose an author or
title search and search for *, i.e. all items.

You can also print the contents of the Readerware Want List. To print your want list you must select Print from the want list
window. Printing your want list can be very useful if you also buy from brick and mortar book stores. 
 

Printing a report

The first thing you see when you select Print is the Report Setup dialog:
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Using this dialog, you define the various printing options you want for this report, the font, orientation etc. All selections are
saved and will be used the next time you select Print. The choices you can make are:

Font Selection - You can select a font, style and point size for the report. A sample of your selection is displayed.
Orientation - Portrait or Landscape. The Readerware reports with a large number of columns displayed will normally
look better in Landscape mode.
Margins - The page margins are specified in inches, i.e. .5 will result in a half inch margin
Draw Table Grid - If checked Readerware will print the table grid.
Two sided - If checked Readerware will print on both sides of the paper. You should first print odd numbered pages 1, 3,
5 etc., reload the printed pages into the printer, and then print even numbered pages.
Break on Author - Readerware will exclude the author column from the table itself. The author will be printed on a
separate row and then Readerware will print the books for that author in the table format. Try it!
Tables per Page - If you are printing a table with only a few columns you can adjust the slider to get Readerware to repeat
the table across the page the specified number of times. For example if your view contains just author and title and you set
the Tables Per Page to 3, Readerware will print a table with six columns, flowing the data  from one group of columns to
the next.
Add Titles - If checked the report title will be printed at the top of each page. The tittle will be centered.
Page Number - If checked Readerware will include the page number at the top of each page of the report, to the right.
Date - If checked Readerware will include the date at the top of each page of the report, to the left.

Once you have specified all your Readerware options, you can display the printer properties dialog if additional options are
required.

Then hit the Print button to begin printing the report. A progress dialog will be displayed. You may cancel the report at any time.

If you selected the two sided option, you will see two print buttons, Print Odd and Print Even. These will print the odd and even
numbered pages respectively. You may print them in either order. After printing one set, reload the printed pages in the printer
and print the next set.
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The Readerware Report Writer
The Readerware Report Writer allows you to easily define your own custom reports in virtually any format, with images. You can
view, print and save the output. 

The input to the Readerware report writer is an HTML template which defines the layout and formatting options. Readerware
then merges in your data to create an HTML file. As the output is in HTML format you can view it any browser, print it or save
the output to a file and upload it to a web site. 

Printing a custom report

The easiest way to get started is to use one of the templates that are shipped with Readerware. To produce a report do the
following:

Search to establish the content for your report or select the books you want to include in the table view. The
Readerware report writer uses either the current search results or the selected books as input. So you could search
for all titles to produce a full report, search by a given author or category etc. 

Open the Readerware Report Writer Window by selecting the File->Report Writer menu item. 

Select the Readerware basic image report, (BasicImageReport.html), from the list. You will see the template
displayed in the window, but instead of data, you will see text like [[$AUTHOR]], [[$TITLE]] etc. The [[$----] fields
identify which Readerware database fields will be displayed and where. 

Select either the All Records or Selected Records option to determine which books are included in the report. 

Click on the Create Report button. Readerware will then populate the report template with the contents of the
current search results and display the output in your browser. You can view, print or save the report from your
browser.

That is how you print a report with the Readerware Report Writer. 

Creating a report template

A Readerware Report Writer template file is in HTML format so you do need to understand a bit about HTML to take full
advantage of all the customization and formatting options available.

The basic idea is that you create the HTML to produce the desired report, but instead of using real data you use predefined
Readerware keywords that determine where Readerware will insert the data. Consider the template for the basic table example
used earlier:

<HTML> 
<HEAD> 
   <TITLE>Readerware Basic Table Example</TITLE> 
</HEAD>

<BODY> 
<CENTER><FONT COLOR=#0000FF><H2>Readerware Basic Table Example</H2></FONT></CENTER>

<TABLE ALIGN=CENTER BORDER=3 CELLPADDING=5> 
<TR> 
<TH>Author</TH> 
<TH>Title</TH> 
<TH>ISBN</TH> 
<TH>Est. Value</TH> 
</TR>

[[$BEGIN_READERWARE]] 
<TR> 
<TD>[[$TITLE]]</TD> 
<TD>[[$AUTHOR]]</TD> 
<TD>[[$ISBN]]</TD> 
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<TD>[[$VALUE]]</TD> 
</TR> 
[[$END_READERWARE]]

</TABLE> 
</BODY>

</HTML>

This is fairly standard HTML, the interesting part is between the [[$BEGIN_READERWARE]] and [[$END_READERWARE]]
lines. These lines mark the section of code that Readerware will duplicate, once for each book to be displayed. You can see that
between these lines the HTML statements define a new row within the table. So if you have five books in your result set,
Readerware will duplicate this section five times creating a five row table.

Within this section you can see several Readerware database column names, for example [[$TITLE]] indicates this is where
Readerware is to place the book title, Readerware simply substitutes these keywords with the database values. That's really all
there is to it. Here is the HTML file that Readerware might generate from the above template

<HTML> 
<HEAD> 
   <TITLE>Readerware Basic Table Example</TITLE> 
</HEAD>

<BODY> 
<CENTER><FONT COLOR=#0000FF><H2>Readerware Basic Table Example</H2></FONT></CENTER>

<TABLE ALIGN=CENTER BORDER=3 CELLPADDING=5> 
<TR> 
<TH>Author</TH> 
<TH>Title</TH> 
<TH>ISBN</TH> 
<TH>Est. Value</TH> 
</TR> 
 

<TR> 
<TD>In a Dry Season</TD> 
<TD>Robinson, Peter</TD> 
<TD>0-380-97581-5</TD> 
<TD>$24.00</TD> 
</TR>

<TR> 
<TD>Roses, Roses</TD> 
<TD>James, Bill</TD> 
<TD>0-393-04637-0</TD> 
<TD>$23.00</TD> 
</TR>

<TR> 
<TD>The Breaker</TD> 
<TD>Walters, Minette</TD> 
<TD>0-399-14492-7</TD> 
<TD>$23.95</TD> 
</TR>

<TR> 
<TD>The Running Woman</TD> 
<TD>Carlon, Patricia</TD> 
<TD>1-56947-110-X</TD> 
<TD>$21.00</TD> 
</TR>

<TR> 
<TD>The Scold's Bridle</TD> 
<TD>Walters, Minette</TD> 
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<TD>0-312-95612-6</TD> 
<TD>$6.99</TD> 
</TR> 
 

</TABLE> 
</BODY>

</HTML>

Accessing Volume and Chapter Information

Each book in a Readerware database is made up of the basic information like author and title. It then has one or more volume
entries that you can use for the contents. For many books you may not use these but for multiple volume sets, magazines etc.
you might want to enter the contents. If you want to display volume and chapter information in your report, you must include a
volume and chapter section in your template. Readerware will then automatically handle any number of volumes and chapters.
The volume template section is repeated for each volume and the chapter template section for each chapter within the volume.

The volume and chapter sections of the template are identified by special keywords. For example:

[[$BEGIN_READERWARE]] 
<TR> 
<TD>[[$IMAGE]]</TD> 
<TD>[[$TITLE]]<BR>[[$AUTHOR]]</TD> 
</TR>

[[$BEGIN_READERWARE_VOLUMES]] 
<TR> 
<TD>Volums [[$VOLUMENUMBER]]:</TD> 
</TR> 
[[$BEGIN_READERWARE_CHAPTERS]] 
<TR COLSPAN=2> 
<TD>[[$TITLE]]</TD> 
</TR> 
[[$END_READERWARE_CHAPTERS]] 
[[$END_READERWARE_VOLUMES]] 
[[$END_READERWARE]]

The above is not a complete template, but it illustrates how you would display volume and chapter information. The
[[$BEGIN_READERWARE]] ... [[$END_READERWARE]] identifies the complete Readerware template, this section will be
duplicated once for each book you are displaying. There is HTML to display the cover image, title and author information.

The [[$BEGIN_READERWARE_VOLUMES]] ... [[$END_READERWARE_VOLUMES]] identifies the section that will be
duplicated once for each volume within each set. In this example it displays the volume number.

Finally the [[$BEGIN_READERWARE_CHAPTERS]] ... [[$END_READERWARE_CHAPTERS]] identifies the section that will be
duplicated once for each chapter, within each volume, within each book. This section displays title information. Note that this
section is within the volume section of the template. This is the normal way you would code this, you want the chapters listed for
each volume. If you use the chapters section on it's own, Readerware will display chapter information for the first volume only. 

Getting Started

You might want to start with one of the examples included with Readerware and adapt them for you own use, or you can start
from scratch. 

To start with an existing template, select it in the report writer window. Copy/Paste the template into a text editor like Notepad or
TextEdit. 

To remove a template you no longer use select the File->Remove template menu item. 

To install your template select the File->Install template menu item. 
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If you develop custom reports that you think might be useful to other users, please consider sending them in. They may be
placed on the Readerware web site where others can use and learn from them. Full credit will be given to the author or you can
remain anonymous if you prefer. Just e-mail any templates to support@readerware.com. 

You can browse user contributed templates in the Readerware Knowledge Base. 

Report Writer Templates

Report writer templates are standard HTML files with an embedded section that is duplicated for each database record
displayed. This section is marked by the following statements:

[[$BEGIN_READERWARE]]
.
.
.
[[$END_READERWARE]]

Sometimes you need to display multiple records within the marked section. Consider a two column table where you want each
column to display a record from the database. Effectively you want to duplicate a table row for each two records. You do this with
the [[$INCR_READERWARE]] statement. It tells Readerware to fetch the next record from the database. For example:

<TABLE>
[[$BEGIN_READERWARE]]
<TR>
<TD>[[$TITLE]]<BR>[[$AUTHOR]]</TD>[[$INCR_READERWARE]]
<TD>[[$TITLE]]<BR>[[$AUTHOR]]</TD>
</TR>
[[$END_READERWARE]]
</TABLE> 

Report Writer Keywords

The following is a full list of the keywords recognized by Readerware. These will be replaced by the appropriate data from the
database. 
 
[[$AUTHOR]] Book Author, displayed in selected format
[[$AUTHORLAST]] Book Author, displayed in Last, First format

AUTHORBIOLINK Display a link the use can click on to open the author contributor dialog. Includes image, biography
etc.

[[$AUTHOR2]] -
[[$AUTHOR6]] Additional Authors

[[$TRANSLATOR]] Book Translator
[[$ILLUSTRATOR]] Book Illustrator
[[$EDITOR]] Book Editor
[[$TITLE]] Book Title
[[$ALTITLE]] Alternate title
[[$SUBTITLE]] Book Subtitle
[[$ISBN]] ISBN-13 formatted for display, e.g. 978-0-684-87301-5
[[$ISBN-10]] ISBN-10 formatted for display, e.g. 0-684-87301-X
[[$RAWISBN]] Raw ISBN-13, no formatting, e.g. 9780684873015
[[$RAWISBN-10]] Raw ISBN-10, no formatting, e.g. 068487301
[[$ASIN]] Amazon Standard Identification Number

[[$ISBN/ASIN]] ISBN-13 formatted for display, e.g. 978-0-684-87301-5. If there is no ISBN, this keyword returns the
ASIN instead.

[[$RAWISBN/ASIN]]] Raw ISBN-13, no formatting, e.g. 9780684873015. If there is no ISBN, this keyword returns the
ASIN instead.

[[$PUBLISHER]] Publisher
[[$FORMAT]] Book format, hardcover paperback etc.
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[[$TYPE]] Display type
[[$EDITION]] Book edition
[[$LANGUAGE]] Language
[[$SIGNED]] Signed?
[[$DATE]] Release/Publication date
[[$PUBPLACE]] Place published
[[$COPIES]] Number of copies owned
[[$RATING]] User rating
[[$CONDITION]] Condition
[[$COVERCONDITION]] Cover condition
[[$CATEGORY1]] - 
[[$CATEGORY3]] Categories

[[$READ]] Number of times book has been read
[[$LASTREADATE]] The last time the book was read
[[$PRODUCTINFO]] Product information, reviews etc.
[[$COMMENTS]] Comments
[[$DATEENTERED]] Date entered into the Readerware database
[[$DATEUPDATED]] Date last updated
[[$ROWKEY]] The Book ID, this is a unique ID allocated to each book automatically as it is added to the database
[[$LCCN]] LCCN (Library of Congress)
[[$DEWEY]] Dewey decimal number
[[$DEWEYLABEL]] Dewey decimal number. Standard format, Library of Congress extensions removed.
[[$BARCODE]] Barcode
[[$CALLNUM]] Library of Congress Call Number
[[$BOOKID]] The Book ID, this is a unique ID allocated to each book automatically as it is added to the database
[[$USERNUM]] User defined book number
[[$ID]] If a user defined book number is present it is used, otherwise the Book ID is used
[[$COPYDATE]] Copyright date
[[$LOCATION]] Book location
[[$SERIES]] Book series
[[$SERIESNUMBER]] Series number
[[$PAGES]] Page count
[[$KEYWORDS]] Book keywords
[[$DIMENSIONS]] Book dimensions
[[$WEIGHT]] Book weight
[[$READINGLEVEL]] Reading level

[[$LEXILELEVEL]] The Lexile Framework for Reading is an educational tool that uses a Lexile to match readers of all
ages with books

[[$SOURCE]] Source of import
[[$PURCHASEPRICE]] Price paid
[[$PURCHASEDATE]] Date purchased
[[$PURCHASEPLACE]] Where purchased
[[$LISTPRICE]] List price
[[$VALUE]] Estimated value of this book
[[$VALUEDATE]] Valuation date
[[$SALEPRICE]] Sale price
[[$SALEDATE]] Date sold
[[$NEWPRICE]] New copy price
[[$NEWCOUNT]] Number of new copies available
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[[$USEDPRICE]] Used copy price
[[$USEDCOUNT]] Number of used copies available
[[$COLPRICE]] Collectible copy price
[[$COLCOUNT]] Number of collectible copies available
[[$SALESRANK]] Sales rank
[[$FAVORITE]] Is this a favorite book?
[[$OUTOFPRINT]] Is this book out of print?
[[$MEDIAURL]] Local copy of media
[[$OWNER]] Owner of this book
[[$STATUS]] Book status
[[$EXTERNALID]] External ID for this Book
[[$INVENTORY]] Book inventory count
[[$IMAGE1]] IMG tag for the first image
[[$IMAGE2]] IMG tag for the second image
[[$LARGEIMAGE1]] IMG tag for the first large image
[[$LARGEIMAGE2]] IMG tag for the second large image
[[$BESTIMAGE1]] IMG tag for the first image. Looks for the large image, if not found uses the normal image
[[$BESTIMAGE2]] IMG tag for the second image. Looks for the large image, if not found uses the normal image
[[$VOLUMECOUNT]] Number of volumes
[[$AUTHORURL]] Author web site
[[$USER1]] - 
[[$USER10]] User defined fields

[[$LOANTO]] Loaned to, borrower name
[[$LOANTO_EMAIL]] Loaned to, borrower e-mail
[[$LOANTO_PHONE]] Loaned to, borrower phone
[[$LOANDATE]] Loan date
[[$LOANDUE]] Loan due date
[[$LASTLOANDATE]] The last date this book was loaned out
[[$LOANCOUNT]] The number of times this book has been loaned out

[[$CURRENTDATE]] The current date. This tag can be used outside of the BEGIN/END tags and is designed to be used
as a report date.

[[$ITEM_COUNT]] The number of books printed. This tag must be used outside of the BEGIN/END tags, it can appear
at the top or bottom of the report.

[[$ITEM_VALUE_TOTAL]] The total value of the books printed. This tag must be used outside of the BEGIN/END tags, it can
appear at the top or bottom of the report.

[[$TEMPLATESDIR]] URL pointing to the templates directory

All keywords must be in uppercase as shown above. They can be in any order, but must appear between the
[[$BEGIN_READERWARE]]  and [[$END_READERWARE]] lines otherwise they will be ignored. 
  
 

Report Writer Volume Keywords

The following is a full list of the volume section keywords recognized by Readerware. These will be replaced by the appropriate
data from the database. 
 
[[$VOLUMENUMBER]] Volume Number
[[$VOLUMETITLE]] Volume Title
[[$USER1 - USER2]] User defined volume fields

All keywords must be in uppercase as shown above. They can be in any order, but must appear between the
[[$BEGIN_READERWARE_VOLUMES]]  and [[$END_READERWARE_VOLUMES]] lines otherwise they will be ignored. 
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Report Writer Chapter Keywords

The following is a full list of the chapters section keywords recognized by Readerware. These will be replaced by the appropriate
data from the database. 
 
[[$CHAPTERNUMBER]] Chapter Number
[[$TITLE]] Chapter Title
[[$AUTHOR]] Chapter author
[[$READ]] Number of times the chapter has been read
[[$COMMENTS]] Comments
[[$MEDIAURL]] Local copy of media
[[$USER1 - USER2]] User defined chapter fields

All keywords must be in uppercase as shown above. They can be in any order, but must appear between the
[[$BEGIN_READERWARE_CHAPTERS]]  and [[$END_READERWARE_CHAPTERS]] lines otherwise they will be ignored.
Normally the chapters section itself is embedded within the volumes section. 
  
 

Keyword Modifiers

The following is a full list of the modifiers that can be applied to any of the report writer keywords. These will modify the database
values, i.e. display the database value in uppercase. 
 
-U Display the value in uppercase
-L=n Limit the value displayed to at most n characters
-S=n Display the value starting at the nth character. This is relative to 0.
-Y Used with date fields, this will display the year only instead of the full date.

-H Hide if empty. Do not display anything if this field is empty. For example [[$IMAGE]] will display the default image if there
is no cover art. [[$IMAGE-H]] will display nothing if there is no image.

-
H=text

Display the specified text if the database field is not empty. If the field is empty, nothing is output. Suppose you want to
display the release date in brackets, but you don't want to display empty brackets if there is no date. Use [[$DATE-H=(]]
[[$DATE]][[$DATE-H=)]]

The modifiers must immediately follow the report writer keyword. For example:

[[$AUTHOR-U]]

This will display the author in uppercase.

You can apply multiple modifiers to a keyword. For example:

[[$AUTHORLAST-U-L=3]]

This will display the first three characters of the author in uppercase.
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Printing Barcodes
Readerware lets you print barcodes from a number of fields in your database, ISBN, item ID etc. Use barcodes to identify your
books, to help with shelving etc. 

For example you can assign your own asset number to each book in your database. Enter your asset number in the User
Number database column. You can print User Number barcode labels nad apply them to all books. Then to checkout a book you
can select a User Number search and scan the barcode. 

You can print Dewey Decimal Number labels. Apply these to your books and you can use the Dewey Decimal Number to help
shelve your books. 

Selecting the items to print

Readerware will print barcodes for the current search results or selected items. Start by searching your database to list the items
you want to print. For example you could do a Date Entered search to list all new items. 

You can select items from the list of returned results if applicable. To select your first item, just click on it. To add another item,
use the standard list selection keys for your operating system to select other items or a range of items. For example on Windows
hold down the Ctrl key on your keyboard and click on the next item. On Mac OS X hold down the Command key and click on the
next item. To select a range of items, hold down the Shift key and click on an item, all items between the new and previous
selections are now selected. 

Now select File->Print->Barcodes. 

Printing Barcodes

Select and setup your printer - You can print barcodes on any ink jet or laser printer using label sheets. Readerware also
supports Dymo LabelWriter label printers which take label rolls. 

Select the items you want to print - You can print the current search results or selected items. 

Choose your label stock from the list - Readerware supports Avery 5160/8160 label sheets on any ink jet or laser printer. If
you have a Dymo LabelWriter printer select either the 30252 address labels or 1738595 barcode labels. The address labels
normally work best, they are easier to find in stores and are bigger. They can hold both the barcode and additional text. The
Dymo barcode labels are smaller and have room for a barcode only. 

Select the database field you want to use as the source for the barcodes - ISBN, UPC, Book ID, User Number etc. 

Add a line of text to your label - You can optionally and a single line of text that will be output below the barcode. For example
you could add a line identifying your organization, a property of line etc. 

You can also include a mini template in this field to print data from your database. For example:

[[$BEGIN_READERWARE]][[$TITLE]][[$END_READERWARE]]

will include the book title on the barcode label. 

Click on the Print button to print your barcode labels. 

Tips on Printing Barcodes

Readerware picks the barcode symbology based on the source column you select. You should make sure that the data is valid.
If not you may have problems encoding the barcodes. For example if you have an invalid ISBN, the barcode may not print. 

When printing User Number barcode labels, keep the data short to ensure it will fit on the barcode label. 6-10 letters and/or
numbers will work fine, longer and you may find that the barcode overflows the label. 

You can include one line of text to be printed below the barcode assuming the label is big enough. For example you could add
"Property of your local library" to the label. 

Page 85 of 145



You can also include a mini template in this field to include data from your database. This is a very powerful feature, it uses the
same keywords as the report writer. (Book keywords, Music keywords, Video keywords). Some examples:

[[$BEGIN_READERWARE]][[$TITLE]][[$END_READERWARE]] 
will include the book title. 

[[$BEGIN_READERWARE]][[$AUTHOR-U-L=3]][[$END_READERWARE]] 
will include the first three characters of the author in uppercase.

Dymo labels can fade over time if exposed to sunlight or fluorescent light. You should consider label placement when choosing
Dymo labels.
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Printing Spine Labels
Readerware lets you print Dewey Decimal Number and Call Number spine labels. You can use these labels to help shelve your
books. 

Selecting the items to print

Readerware will print spine labels for the current search results or selected items. Start by searching your database to list the
items you want to print. For example you could do a Date Entered search to list all new items. You can select items from the list
of returned results if applicable. Now select File->Print->Spine Labels. 

Printing Spine Labels

Select and setup your printer - You can print spine labels on any ink jet or laser printer using label sheets. Readerware also
supports Dymo LabelWriter label printers which take label rolls. You can select the paper orientation. portrait or landscape. Note
when using a Dymo label printer that Landscape is the default orientation. 

Select the items you want to print - You can print the current search results or selected items. 

Choose your label stock from the list - Readerware supports several Avery labels both US legal and A4 sizes. If you have a
Dymo LabelWriter printer select the Dymo label stock 

Select the database field you want to use as the source for the spine labels - Dewey Decimal Number, Call Number or
None. Based on your selection you can also set options that control how the number will print. Some Dewey Decimal Numbers
will include a truncation mark, normally a slash. Readerware can print the full number or truncate it. Normally Call Numbers are
broken into multiple lines so that they will be visible on the spine of a book, but you can also print them on a single line. If you
select None, then only the text line will print. 

Add a line of text to your label - You can optionally and a single line of text that will be output below the label text. For example
you could add a line identifying your organization, a property of line etc. 

You can also include a mini template in this field to print data from your database. For example:

[[$BEGIN_READERWARE]][[$TITLE]][[$END_READERWARE]]

will include the book title on the label. 

Click on the Print button to print your spine labels. 

Tips on Printing Spine Labels

You can include one line of text to be printed below the text assuming the label is big enough. For example you could add
"Property of your local library" to the label. 

You can also include a mini template in this field to include data from your database. This is a very powerful feature, it uses the
same keywords as the report writer. (Book keywords, Music keywords, Video keywords). Some examples:

[[$BEGIN_READERWARE]][[$TITLE]][[$END_READERWARE]] 
will include the book title. 

[[$BEGIN_READERWARE]][[$AUTHOR-U-L=3]][[$END_READERWARE]] 
will include the first three characters of the author in uppercase.

Dymo labels can fade over time if exposed to sunlight or fluorescent light. You should consider label placement when choosing
Dymo labels.
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General Preferences
Readerware General Preferences are used to configure basic options such as the user interface, startup, logging etc. 

Look and Feel Preferences

Readerware supports multiple "look and feel" implementations. The choices available will depend on the platform you are using,
Windows, Macintosh etc. The look and feel determines how components such as buttons and list boxes etc. look and behave. It
also controls how a component reacts to mouse and keyboard input. 

If the Show tooltips option is checked, Readerware will display tooltips for buttons etc. 

If the Include images on menus option is checked, Readerware will include icons for many menu bar items. 

Browser Preferences

The browser preferences determine how Readerware launches your browser. 

Readerware will normally find your default browser automatically. If the Let Readerware find your browser automatically
option is turned on, Readerware will then determine the location of your browser from the operating system. If for some reason
this does not work or if you have multiple browsers installed and want Readerware to use a specific browser, clear this option
and select the browser 

Media Player Preferences

The media player preferences determine how Readerware launches your media player. 

Readerware will normally find your default media player automatically. If the Let Readerware find your media player
automatically option is turned on, Readerware will then determine the location of your media player from the operating system.
If for some reason this does not work or if you have multiple media players installed and want Readerware to use a specific
program, clear this option and select the media player. 

Logging Preferences

The logging options determine when Readerware will create log files. 

When the Enable user logging option is checked, operations such as auto-catalog, import etc. will produce a log file. Click on
the View Log button when the operation completes to see the log. 

When the Enable Readerware logging option is checked, Readerware will create a full session log to assist in problem
resolution. This should only be turned on at the request of Readerware Support as it can impact performance. 

Startup Preferences

These options control what operations Readerware performs as it starts. 

If the Show tip of the day option is checked, Readerware will display a tip window with help on commonly used features of the
program. A different tip is displayed each time you start Readerware. You can page through the tips and close the window when
you are done. After you have become familiar with Readerware, you can turn this option off. 

If the Show splash screen option is checked, Readerware will display a progress window as it starts. 

If the Start in Edit Mode option is checked, Readerware will start the program in edit mode, i.e. you can edit cells in the table
view. If not checked Readerware is started in navigation mode and you can click on links to refine the search results. 

If the Start in Return Mode option is checked in the Readerware Loan Client, it will start the program in return mode, If not
checked the Readerware Loan Client is started in loan mode. 
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Exit Preferences

There preferences control which operations Readerware performs at exit. 

When Readerware is run for the first time, it displays the main window in a default position and at a size that will fit on a basic
screen. You can resize and move the window to meet your needs. 

When the Remember size & position option is set, Readerware will remember the size and position of each window when you
close the application and restore them next time you start the application. There are two basic ways to use this feature:

You can leave Remember size & position on and always have your windows open at the location you left them when you
last closed Readerware.
Establish a new default position and size and select the Edit->Save Window Positions menu item and turn this option off.
Readerware will then open windows at your default location and size rather than the last used location and size.

When the Prompt for backup if database changed option is set, Readerware will display a backup reminder dialog whenever
you close the program after making changes to the database. If you close Readerware without making any database changes,
Readerware closes as normal. The backup reminder dialog will give you a chance to backup your Readerware database and
safeguard your data. If you turn this option off, remember to backup your database regularly by selecting the File->Backup
Database menu item.
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Toolbar Preferences
Use this panel to change how toolbars are displayed.

Display options

You can choose to display toolbars with icons and labels, icons only or labels only. 

The default is to display both icons and labels. Once you are familiar with the toolbar you can turn off the labels to reduce the
size and clutter.

Button tooltips

If checked Readerware will display a popup window when you hold the mouse over a toolbar button. If clear no tooltips are
displayed.

The tooltip will display a more detailed description of what the button does. A good combination is to turn off labels and turn on
tooltips. You have a smaller toolbar and can display the tooltip if you ever forget what a button does.

Icon sizes

You can display the toolbar icons in the following sizes: 

Small 24 pixels
Medium  32 pixels
Large 48 pixels

Toolbar item selection

You can choose to add additional functions to the standard toolbar:

Web Display/Browser - Click to display the current item at your default site
Preferences - This dialog.
Bulk Editor - Launch the bulk editor wizard
Auto-Update - Launch the auto-update wizard
Default search - Run the default search.
Views list - The views list is a drop down list containing all your views. You can easily switch views by selecting from the
list.
Saved searches list - The saved searches list is a drop down list containing all your saved searches. You can easily run a
saved search by selecting from the list.

Top of Page

Copyright © 1999-2022 Readerware Corporation

Page 90 of 145



Update Preferences
Readerware can check for product updates at regular intervals. Using this preferences panel you can turn the update check on
and off, set the interval and manually check for updates.

Check for updates automatically

If checked Readerware will check for updates at the specified interval. If cleared Readerware will never check for updates.

If update checking is turned on you can set the interval in days. If you set the interval to seven days, Readerware will next check
for updates in seven days time and every seven days after that.

We do recommend that you check for updates regularly.

Check Now

You can check for updates at any time by clicking on the Check Now button.

If a new version is available Readerware will display the latest version number and enable the Go to Download Page button.
This will launch your browser and take you to the Readerware web site where you can download the latest version.
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View Preferences
This panel is used to maintain your views and change global view options. 
 

Sort Preferences

Case sensitive

Readerware searches are normally case insensitive. An example of a case insensitive sort is:

Smith, jane 
Smith, John 
Smith, joseph

If you check the Case sensitive box, the same search results would be displayed in the following sequence:

Smith, John 
Smith, jane 
Smith, joseph

Ignore initial articles

If the Ignore initial articles box is checked Readerware will ignore articles of speech at the start of a field, (A, An and The). For
example:

A Murder in Mayfair
The Murder Room
Murder Scholastic
A Murder Too Many

If the Ignore initial articles box is cleared, the same titles will be sorted in the following sequence:

A Murder in Mayfair
A Murder Too Many
Murder Scholastic
The Murder Room

Readerware can also switch the titles for you. If you prefer to format the title as Murder Room, The use the Readerware Bulk
Editor to reformat the title.

Strict alphabetical title sort

If the Strict alphabetical title sort box is checked, articles of speech found anywhere in the title field are ignored, (A, An and
The). Spacing and punctuation are ignored, the title is sorted in strict letter by letter sequence. For example:

The Harder They Come
Hard Feelings

All spacing is eliminated and e comes before f so the titles will be listed in the above order.

If the Strict alphabetical title sort box is cleared, the titles would be listed in the following sequence:

Hard Feelings
The Harder They Come

This assumes that the Ignore initial articles box is checked. 

This option is only used when sorting by title.

Alphanumeric sort

By default Readerware sorts are alphabetic. This can cause some problems when a field contains a combination of alphabetic
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and numeric data. An example of an alphabetic sort is:

Model 11
Model 3
Model 8

If you check the Alphanumeric box, the same search results would be displayed in the following sequence:

Model 3 
Model 8 
Model 11

Focus

You can determine which component receives the input focus when Readerware displays the search results.

Current view - The focus will be placed in the view and you will be able to use the cursor movement keys to select
items and scroll the view. 

Search bar - The focus will be placed in the search bar for field and you will be able to enter a new search.

View Maintenance

To create a new view, select an existing view on which to base your new view and click on the Copy button. You will be
prompted to enter a name for your new view.

To rename a view, select the view in the list and click on the Rename button. You will be prompted to enter a new name for the
view. Note that you cannot rename one of the default views.

To delete a view, select the view in the list and click on the Delete button. There is no confirmation, the view is removed from the
list immediately. If you make a mistake and delete a view in error, simply hit the preferences Cancel button and the view will not
be deleted. Note that you cannot delete one of the default views.
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Table View Preferences
This panel is used to change table view preferences. 

Display Preferences

Use system row background color

If checked Readerware will query the operating system for the table row background color. If cleared Readerware will use a
white row background. 

Alternate row background color

Readerware can display alternate row background colors, i.e. even numbered rows in one color, odd numbered rows in another
color. If checked Readerware will display alternating row background colors If cleared Readerware will display all rows with the
standard background color. 

This option is on by default on Mac OS X, it is off by default on all other platforms. 

Display single result in detail view

When a search returns a single result you have the option of displaying this item in the table view as a single row or in the detail
view, just as if you had selected the detail view from the table. 

If checked Readerware will display a single result in the detail view. If cleared Readerware will display it in the table view. 

Highlight links in table

When in navigation mode Readerware can highlight links in the table similar to a browser. In Readerware you can click on a link
to refine the search results, i.e. click on an author link to display all books by that author. 

If checked Readerware will highlight links. If cleared Readerware will not highlight links but the mouse pointer will still change as
it goes over a link and the link will still function. 

Table View Maintenance

To show and hide columns in a view, select the view in the left list, then select the column in the right list. Double click on any
column to toggle its status. A check mark indicates the column is shown in the view, an X indicates the column is hidden. 

To show all columns click on the check mark button. To hide all columns click on the X button. You can then set the state of
individual columns as described above. 

To change the order of columns in a view, select the column in the right list. Use the Up/Down arrow buttons to change the
position of the column in the view.
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Tree View Preferences
This panel is used to change tree view preferences. 

Expand tree view on open

If checked the tree is fully expanded on open. If not checked only the top level nodes are visible on open. Note: you can expand
or collapse the tree view at any time by right clicking on it and selecting from the popup menu. 

Default Sort

You can set the default sort for the tree view. The column you specify becomes the folder node in the tree view and the data is
sorted in ascending sequence. 

Folder Node Display Preference

When you select a folder node in the tree view, Readerware displays all the items under this node in the right hand panel. You
can choose to use the Thumbnail or Table view to display these items. 

Tree View Maintenance

When using the table view to display the folder node contents you can determine which columns are displayed.
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Thumbnail View Preferences
This panel is used to change thumbnail view preferences. 

Show Titles Under Thumbnail

If checked the item title will be displayed under the thumbnail, image. 

Show Toolbar in Thumbnail View

If checked the thumbnail toolbar will be displayed. You can use this to scale the images, change the sort sequence etc. 

Sort Thumbnails By

You can specify up to three columns to use when sorting the thumbnails for display. 

Thumbnail Sizes

You can set the minimum, preferred and maximum size of the thumbnails. 

Readerware will display the thumbnails in your preferred size. You can scale them between the minimum and maximum values
you specify. 

Note: Readerware preserves the aspect ratio when scaling images. 

Thumbnail Popup Template

When you hold your mouse over a thumbnail, Readerware displays a popup containing more information about the item.
Readerware uses an HTML template to layout the popup contents. 

You can edit this template to display the information just the way you want it. This template uses the same format as the report
writer templates.
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Detail View Preferences
This panel is used to change detail view preferences. 

Image Preferences

Readerware can display thumbnail images in the detail view panels. You can choose to display the first, the first two, the last or
no images. You can also specify the image location. 

Default Tab

Readerware normally selects the Summary tab when the detail view is displayed. You can change that and make any tab the
default. 

Summary Display Templates

Readerware uses an HTML template to layout the summary panel. You can choose from the list of installed templates to
determine the format of the summary panel. 

You can also create and install your own templates. These templates use the same format as report writer templates. 

Default Display Type

Using the display type you can control how much information Readerware displays in the detail view. 

Normally Readerware uses the Standard format but you can change the default format to meet your needs. 

Dialog Preferences

Readerware displays confirmation dialogs as you add or update a record. You can turn these dialogs off if you find then intrusive.
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Search List Preferences
The Readerware search bar lets you easily search your database on virtually any field. Using this preferences panel you can
customize the search bar, hide searches you never use and organize the search list to meet your needs.

Search List

Searches displayed with a green check mark are included in the search bar, those displayed with a red X are hidden. Double-
click on an entry to toggle its state.

To change the order of a search entry in the list select it and use the arrow keys to move it up or down.
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Site Preferences
Readerware Site Preferences are used to customize the site drop down lists used for cataloging and ordering. You can also
choose a default site to use when displaying an item in your browser. 

Import URL List

The Import URL list is used by auto-catalog. The auto-catalog drop down list will include the sites you select in the order
specified. 

Sites displayed with a green check mark are included in the list, sites displayed with a red X are hidden. Double click on an entry
to toggle the selection.

 - Site will be included in the list 
 - Site is hidden

To change the order of a site in the list, first select it and then use the arrow buttons to move it up or down.

The first active site in the list is used when you display the current product in your browser. 

Order URL List

The Order URL List determines which sites will be searched when you run a price check or place an order from your want list.
You configure this list in the same way you configure the import list. 

Display at URL List

The Display at URL List is used to choose the web site you want to display an item at when you select the Browser toolbar
button from the main window or Want List, double click on an item in the table view etc. You can only select a single site from
this list, the item will be displayed at that site, i.e. Amazon, Discogs etc. 

If the Browser button should override site selection with Source column option is checked, Readerware will use the site the
item was cataloged from, i.e. the contents of the Source column, to determine which site to display the item at. 

After displaying the item at your preferred site you can look for similar items to add to your collection, order the item etc. 

The Button Panel

Once you have made your changes, click on OK to save them and have them take effect. Click on Cancel to discard your
changes. Note you only have to click on OK when you have finished all your changes, you can move between panels and only
click OK when you are done. This will close the Readerware preferences dialog.
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Database Preferences
Preferences are normally stored by user, database preferences are the exception. Database preferences are stored in the
database itself. 

This means that each database can have different settings, column names, access mode etc. 

Expand the Database node in the tree and select one of the database preferences panels.
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Database Settings
Use this panel to change Readerware database options, these control how Readerware stores and displays your data.

Run Default Search on Open

If checked Readerware will run the default search whenever you start the program or open a new database.

With this option on you will see the results of your default search when you start Readerware. With it off you will see a blank
page. Turning this option off can improve startup time.

Include Image Support

If checked Readerware will automatically add images for each item you catalog using auto-catalog or drag & drop. You will be
able to manually add images for other books.

Images can take up a lot of space, so if you do not need them you can clear this option and no images will be stored.

Include Want List in Searches

If checked Readerware will include your want list in database searches. If not checked, want list items are excluded from
database searches. An item is determined to be in your want list if the status is Want or Ordered. 

Note: This applies to all database searches except when you are searching by Status. If you search the database for items with
a status of Want or Ordered, they will always be returned regardless of how this option is set.

Refresh History

If checked Readerware will automatically reload result pages that have changed when they are accessed using the navigation
buttons, Home, Back, Forward. If unchecked, the page is displayed as is. This may mean that the page does not reflect the
current database state. It is normally OK to leave this option checked but if reloading a page from history becomes too slow
because the database has grown very large, you can turn this option off.

Allow Duplicate ISBNs/UPCs

If checked Readerware will allow duplicate primary keys in the database, the ISBN of a book, the UPC of an album or video. If
not checked, Readerware will reject duplicates. 

Date Preferences

Readerware can display dates in one of three formats, the full date, month and year or year only. Sometimes you don't have the
full date, you might know the exact date you purchased an item but might only know the year an item was released. 

Select the date you want to change from the list and then set the appropriate option. 

View Preferences

By default Readerware uses the Table View when you start the program and whenever you change databases. 

You can change the default view and Readerware will use this view at startup and whenever you change databases. 

You can also select a specific for each database. If this setting is set to "None", then Readerware will use the default view you
have set when opening this database. If you select a specific view, Readerware will use this view whenever you open this
database. 

It is possible to set a different view for each database.
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Database Access Preferences
Use this panel to specify how the database should be accessed, set a password etc. 

Database Open Dialog

If the Standard Open Dialog option is selected Readerware uses the standard operating system file selection dialog and you
can open your local database.

If the Advanced Open Dialog is selected Readerware will use a custom dialog that will let you open a standard database,
connect to an external database or connect to a Readerware Server. 

Connecting to an external database or a Readerware server requires Readerware Client/Server Edition. If the Advanced Open
Dialog option is disabled, you don't have Readerware Client/Server Edition. Upgrades are available on the website. 

Database Access Mode

The database access mode is the mode Readerware will use when a database is opened. Choose from:

Full Access - You have full access to the database
Checkout Mode Access - You can check items in and out but no other updates are permitted
Read Only Access - You can search and browse the database, no updates are permitted

You can optionally disable access to preferences in read only or checkout modes. 

If the database access mode has been set to read only or checkout mode, you can request full access to the database later
using the Edit->Request Update Access menu item. 

If the require password option has been set, you will have to enter the password before full access will be granted. 

You can use this option to restrict full access to authorized users. For example if you set the mode to checkout, users will be
able to search, browse and checkout items. If you are an authorized user you can request full access, supply the password and
you will be able to update the database. 

The next time Readerware is started the access mode is set to checkout mode again. 

If a password has been set, you will need to provide the existing password before you can change these settings. 

Open recent menu item count

The File->Open recent menu item can be used to switch between databases. By default it holds the last six accessed
databases. You can change this to a value between 2 and 25. 

Client/Server auto reconnect option

When running in client/server mode, Readerware can automatically reconnect to the Readerware server when the connection is
dropped. 

When you select a function that requires database access, Readerware will check that a database connection is available. If a
connection is not available it will attempt to reestablish the connection. If successful, the default search is run and you will need
to select the function again. 

If Readerware cannot reconnect to the server, the Database Chooser is displayed.

Top of Page

Copyright © 1999-2022 Readerware Corporation

Page 102 of 145



Database Column Names Preferences
Use this panel to change the database column names. You can change the names for any purpose. Maybe you just prefer
another name, maybe you are using Readerware to catalog different items, maybe you would like to use another language. The
name you choose will be displayed as column headings in the table view as field names in the detail view etc. 

Any name you change will be unique to this database. Each database can have a different set of column names. 

Column names table

All the database columns are displayed in a table. There are three columns in this table. 

The first column contains the database column name. This column is read only, it cannot be changed. 

The second column is the standard Readerware column name, i.e. the default column name that is displayed in the table view,
the detail view etc. This column is read only, it cannot be changed. 

The final column is the new column name, the name you want to use whenever this column is displayed. You can enter the new
name in this column. Find the column you want to change by scrolling through the table. Enter your preferred name in the third
column. For best results you should try and keep your name to about the same length as the Readerware name. 

Normally Readerware uses the same name for both the table and detail views. Readerware automatically adds a colon to the
detail view label, i.e. "Title:". However there are a couple of columns where Readerware uses different names for the table view
and detail view. For example take a look at the Readerware name for the Cover Condition column:

Cover Condition | Cover

In this example there are two names separated by the | character. The first name is used as the table view column name and the
second is used as the detail view label. In this instance we have shortened the column name in the detail view. You can use the
same technique when defining your column names. 

To remove an individual column name just click in the cell and delete the contents. 

Sorting the table

You can sort the column names table on any of the three columns. Normally the table is sorted on the Readerware name
column. Notice the sort icon in the column header. To change a column name scroll the table until you see the Readerware
column name you want to change. 

What if you want to see which column names you have changed. You could simply scroll the table looking for rows with an entry
in the New name column. But there is another way. Click on the New name column header. This sorts the table by the New
name in ascending sequence, i.e. all the empty columns come first. Click on the column header again to toggle the sequence
and display the New names in descending sequence. Now all the column names you have changed jump to the top of the table. 

Restoring the standard column names

If you decide you want to go back to the standard column names, click on the Restore default column names button. All data
in the third table column will be deleted and Readerware will use the default column names. 

The Button Panel

Once you have made your changes, click on OK to save them and have them take effect. Click on Cancel to discard your
changes.
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User Defined Column Preferences
The Readerware User Columns Preferences tab is used to define additional columns in the Readerware database. These can
be used for whatever information you want.

Once activated the columns can be added to the table view, and will be automatically displayed in the detail view. You can also
perform searches on user defined columns.

To activate a column, check the Active check box.

Enter the Column Title, this value will be displayed as the column header in the table view, as the tag name in the detail view,
and as the search choice in the search bar.

Select the column type:

Test Field - This is a single line text field that can contain any alphanumeric data
Whole Number Field - This is a single line field that can only contain whole numbers. The contents of this field will be
displayed right aligned. When sorting on this column, Readerware performs a numeric sort.
Yes/No (Checkbox) field - A boolean field that can contain a Yes or No value. This field behaves like all Readerware
boolean fields. In the table view it displays as Yes or No, in edit mode you can change the value by selecting from a list. In
the detail view this field is displayed as a checkbox.

When adding a new field you can use the Bulk Editor to set an appropriate default value. For example when defining a new
whole number field you might want to set a default value of 0.

To remove a column, clear the Active checkbox. Note that this does not remove the column or the data entered from the
database, it simply removes it from display. 
 

The Button Panel

Once you have made your changes, click on OK to save them and have them take effect. Click on Cancel to discard your
changes.
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Database Backup Preferences
Readerware Database Backup Preferences are used to determine when and how Readerware backs up your database. 

Automated Backup

Readerware can automatically back up your database. You decide where the backup files are stored and how many backup
files you want to keep. Readerware can create a new backup automatically when you close the program or on request. 

As new backup files are created Readerware takes care of deleting older backup files so you can control the amount of spaced
used for backup files. 

If you use a cloud drive like Dropbox, OneDrive or Google Drive, Readerware can save your backup files to your drive folder and
they will be synced to the cloud. 

Use the options on this page to configure how Readerware backs up your database. 

Exit Preferences

If you update your database Readerware can prompt you at exit to backup your database. If this option is checked Readerware
will display the prompt. You can select Yes to start the backup, No to close Readerware without running the backup or Cancel
to return to Readerware. 

When you select the Yes option to backup your database, one of two things will happen based on your automatic backup
settings. If the Use automatic backup settings option is checked, Readerware will run the automatic backup and exit. If the
option is not set, Readerware will launch the Backup Wizard and you can select your options and view the results as you run the
wizard. 

The Reset database changed setting on manual backup option determines what happens after you manually backup your
database using the File->Backup Database menu item. If not set and you updated the database during the current session, the
backup is run. If set and you updated the database, ran a manual backup but did not make any more changes after the manual
backup, the database is considered to be unchanged so no backup runs at exit. 

Automatic Backup Settings

Start by checking the Use automatic backup settings option. The other fields will be disabled until this option is checked. 

To set up an automatic backup you must tell Readerware where to store the backup files, the folder you want Readerware to
store them in. Click on the Browse button to select the folder. You also need to tell Readerware how many backup files you
want to keep. This can be between 5 and 25 backup files. 

By default the automatic backup settings are only used when you close the program. If you select the File->Backup Database
menu item, Readerware will launch the Backup Wizard. If you would like Readerware to run an automatic backup when you
select this menu item, check the Use automatic backup settings for manual backup option 

How the automatic backup works

When an automatic backup is run Readerware will create a new backup file. The file name will consist of the database name
and a date and time stamp. For example if you have a database called "Books" Readerware might create a backup file called
"Books Backup 2018-11-21 15-46-36.zip". The time stamp uses a 24 hour clock, so each backup file name will be unique and
you can backup any number of times each day. After creating the new backup file Readerware will delete any extra backup files
over your count setting. 

When you close Readerware without changing the database, Readerware will just close, no backup is run. 

If only the Use automatic backup settings option is checked, Readerware will automatically backup your database at close
whenever the database has been changed. 

If both the Prompt for backup at exit if database changed and the Use automatic backup settings options are checked,
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then Readerware will first ask you if you want to backup your database. If you reply Yes then the automatic backup is run. 

If neither the Prompt for backup at exit if database changed or the Use automatic backup settings options are checked,
then Readerware will just close without backing up your database. You should only use these settings if you are backing up
your database another way. 

If your database is fairly small, you can run the backup every time. However if your database is quite large the backup could
take some time. In this case you can select the prompt option too and maybe run the backup when you are done for the day. 

It is essential to backup your database regularly to protect your valuable data. Readerware automatic backup makes this
process efficient and painless.
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Database Duplicate Preferences
Use this panel to choose which fields are used when Readerware checks for duplicates. 

You might consider books with the same author and title to be duplicates. Select those columns and when you do a duplicates
search, Readerware will use those columns when matching records. 

What about format? Do you consider hardcover and paperback copies of the same title to be duplicates? If you do matching on
Author and Title is fine. If not you can tell Readerware to match on Author, Title and Format.

Database Columns

Columns displayed with a green check mark are used for duplicate matching, those displayed with a red X are not. Double-click
on an entry to toggle its state.
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Contributor Preferences
Use this panel to control how contributors like Author and Artist are displayed, sorted and searched.

Contributor Name Display

Readerware maintains the name of each contributor in two formats, one for display purposes and one for sorting. You can edit
either one in the contributor dialog. By separating the display and sorting of names you have a lot of options to control how
names are displayed and sorted. 

You can control how Readerware uses these names by choosing one of the following options. Assume the display name is
Agatha Christie and the sort name is Christie, Agatha.

Use display name only - The name is displayed as Agatha Christie and is sorted under A.
Use sort name only - The name is displayed as Christie, Agatha and is sorted under C.
Use display and sort names - The name is displayed as Agatha Christie and is sorted under C.

Search Options

Normally when you select a contributor search, Readerware sets the operator to "is" and Readerware looks for an exact match.
You can change this so that Readerware sets the operator to "contains". 

For example, if you search for albums by selecting Carole King from the list, Readerware returns a list of albums where she is
the only artist. 

If you do a contains search, Readerware will return albums by Carole King, Carole King & James Taylor etc. 

If the Force a "contains" search option is checked, Readerware will set the "contains" operator automatically whenever you
select a contributor search. 

Normally when you use type ahead to select a contributor, Readerware looks for an exact match. i.e. if the contributor name
contains accented characters you must type that character to match. 

You can also tell Readerware to strip accents in type ahead. Now if you enter "Sine", Readerware might select "Sinéad
O'Connor" for example.
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Image Preferences
Use this panel to control how Readerware handles images.

Scaling Images

Readerware can automatically scale images as they are added to the database. 

By default images are accepted as is unless they are too large to fit into the database. In this case images will be scaled to fit. 

You can choose to always scale images to a set size. You can scale small and large images independtly. 

Readerware always preserves the image aspect ratio so the final image may not be exactly the size you specify.
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Font Preferences
Use this panel to change the fonts Readerware uses for the different views.

Font options

Start by selecting the User Interface Component you want to change the font for:

Table View
Tree View
Fish Eye View
Thumbnail View (Popup)
Detail View
Toolbars
Menus

Font Settings

You can select font face name, the style and the size of the font:

Face Name - Select the desired font from the list. All your installed fonts are displayed.
Style - Choose from Plain, Bold, Italic and Bold Italic.
Size - The desired point size, you can select from the list or enter the point size.

A sample of the selected font is displayed.

Buttons

To restore the default font choices, click on Restore Default Fonts. 

To save your changes click on OK. To leave preferences without saving your changes click on Cancel.

Top of Page

Copyright © 1999-2022 Readerware Corporation

Page 110 of 145



Hotkey Preferences
Use this panel to assign a Readerware function to any of the 12 function keys.

Hotkey Selection

This preferences panel contains a two column table that lists all 12 keyboard function keys and the Readerware function
assigned to that key. You can assign a Readerware function like auto-catalog or printing reports. Select the function from the
drop down list. 

The Button Panel

Once you have made your changes, click on OK to save them and have them take effect. Click on Cancel to discard your
changes.
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Auto-Catalog Preferences
Use this panel to choose which fields are extracted when cataloging, default values for fields not found etc.

Database Columns

Columns displayed with a green check mark are extracted, those displayed with a red X are not. Double-click on an entry to
toggle its state.

Default Value

Select a column in the above list. The default value field will change allowing you to enter or select an appropriate value for the
column.

You can assign default values to a column regardless of its extraction state. If the column is being extracted, the default value is
only used if no data is found during extraction. If the column is not being extracted, the default value is always used.

Not Found Items

When an item is not found by auto-catalog, Readerware can add a dummy record to the database. The record will have a title of
"Not found". You can search for this title to help identify items that were not cataloged.

Amazon Access

Some Amazon sites provide two modes of access, regular web access and an API for data retrieval. If this option is checked,
Readerware will use the Amazon API when available.
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Proxy Preferences
The Readerware Proxy Preferences tab is used when you access the internet through a proxy server. You specify the name and
port of the proxy server. See your system administrator if you need help with proxy settings.

HTTP Host - Enter the name of the proxy server host used for normal HTTP access.

HTTP Port - Enter the port number of the proxy server host used for normal HTTP access.

Security Host - Enter the name of the proxy server host used for secure HTTPS access.

Security Port - Enter the port number of the proxy server host used for secure HTTPS access. 
 

The Button Panel

Once you have made your changes, click on OK to save them and have them take effect. Click on Cancel to discard your
changes. Note you only have to click on OK when you have finished all your changes, you can move between tabs and only
click OK when you are done. This will close the Readerware preferences dialog.
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Mobile Preferences
Use this panel to choose which fields are transferred to Readerware Mobile.

Database Columns

Columns displayed with a green check mark are transferred, those displayed with a red X are not. Double-click on an entry to
toggle its state.

Maximum Length

Select a column in the above list. The contents of the maximum length field will change allowing you to enter a maximum length
for the column. Memory can be at a premium on mobile devices. This lets you limit the amount of data sent to your Readerware
Mobile device. For example you might want to include the beginning of the item info field so that you have an idea of the
contents, but limit the amount of data sent as this field can contain a lot of data.

Image Size

When transferring images choose a size that matches your device. The default setting uses the recommended size for your
device when using network synchronization. It uses medium sized images when exporting. You can override this and choose a
specific size that will be used by both network synchronization and export. 

You can also set the image size on the device itself. If you intend to set the image size on the device, you must set the image
size here to Use device defaults. If you set a specific image size here, it will override device settings.

Network Synchronization

When network synchronization is enabled you can synchronize your Readerware database with your Readerware mobile device
over your home network. This is a quick and easy way to synchronize your data. 

When enabled Readerware will listen on the specified network port for synchronization requests. Your current IP address is
displayed. You can use this to initiate the synchronization request from Readerware Mobile.
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Book Preferences
The Readerware Book Preferences panel is used to configure book related settings. 

ISBN Handling

By default Readerware validates each ISBN you enter. If you receive an error when entering an ISBN, it means that the ISBN
check digit validation failed. Normally you can resolve this by checking the ISBN and correcting it. Occasionally you might find
that Readerware rejects an ISBN even though you entered it exactly as printed on the book. Very rarely the publisher may
include an invalid ISBN, this is normally on older titles, issued when the ISBN was new. 

Readerware auto-catalog lets you catalog a book from Amazon using an ASIN. If you enter the ASIN instead of the ISBN, you
will receive a confirmation dialog. 

You can tell Readerware to accept the invalid ISBN anyway using the confirmation dialog that is displayed. 

If you want to disable ISBN validation and accept whatever you enter without requiring you to respond to the confirmation dialog,
check the Accept Invalid ISBN  Without Confirmation check box. Clear this option and Readerware will display a confirmation
dialog whenever it encounters an invalid ISBN. 

UPC Manufacturer Mapping

To convert a mass market paperback UPC or barcode to an ISBN, Readerware needs to map the UPC manufacturer code to
the ISBN publisher code. Using this table, you can delete and change the mappings. Normally this is handled automatically
when you scan the barcode, but you can change the mappings and add codes for publishers that have been assigned multiple
codes. More info. 

The Button Panel

Once you have made your changes, click on OK to save them and have them take effect. Click on Cancel to discard your
changes. Note you only have to click on OK when you have finished all your changes, you can move between panels and only
click OK when you are done. This will close the Readerware preferences dialog.
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Loan Preferences
Use this panel to maintain loan related preferences. 

Loan Defaults

Default Loan Period (in days) - When you check out a book, the loan tracker sets the default return date. This is specified as
the number of days, the default is 7 days. 

Loan Dialog Focus

Choose which field initially gets the keyboard focus when the loan dialog is displayed.

Name field - Choose this option when selecting the borrower by name. The name field will get the focus and you can
type the first few characters of the name or select from the drop down list. 

ID field - Choose this option when selecting the borrower by ID. The ID field will get the focus and you can scan a
library card barcode or enter the ID.

Loan Statistics

Readerware can optionally track the number of times an item has been loaned out and the last loan date. 

This information can help you decide which items are popular and which can be removed from your library. 

If you do not need to track loan statistics, you can turn this option off. 

Database Searches

Normally Readerware displays loan information only when you use a Loan search. Loan searches return loans, other searches
return items. For example suppose you have 5 copies of a book with 3 copies on loan. If you search for books on loan,
Readerware will return this book 3 times with the appropriate loan information for each copy. A normal search will just return the
item once so it is not possible to report accurate loan information. 

There are times though when it is useful to have basic loan information when running a normal search. You can request that
Readerware always include loan information by checking the Always return loan information checkbox. Readerware will now
include information from the first loan in all searches. 

If you have entered each copy of an item separately in the database, this will enable you to determine at a glance which titles
are available and which are out. If you have entered multiple copies into the database once and set the copies count, then you
will need to drill down into any item that is out on loan to determine whether or not copies are still available. Select the Edit-
>Check In/Out menu item. 
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The Readerware Command Line
When specifying Readerware command line options you must follow the program name with the options. For example:

C:\Program Files\Readerware 4\readerware.exe <options>

Windows has a lot of problems if there are spaces in any value. You must put the value in double quotes. If both the program
name and the option have spaces, you must put each in a separate set of double quotes. For example:

"C:\Program Files\Readerware 4\readerware.exe" -db"C:\Library\My Books.rw3\My Books.rw3.data"

If you put the whole line in one set of double quotes, Windows will not parse the command line correctly.

Readerware Options

Readerware will accept the following options on the command line: 
 

Database Name

You can use the -db option to include the full path name of a Readerware database on the command line.

-db"C:\Users\Bill\Documents\Readerware\My Books.rw3\My Books.rw3.data"

Preferences File

You can use the -pf option to include the full path name of a Readerware preferences file on the command line. If the file does
not exist Readerware will create it.

-pf"C:\Users\Bill\AppData\Roaming\Readerware.magazines"

You can use both the Database Name and Preferences File options to create completely isolated environments for each
database. 

Debug Mode

You can use the -debug option to start Readerware in debug mode. You should only use this option at the direction of
Readerware technical support. It can impact system performance.:

-debug
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Barcode Reader Support
With Readerware you can use a barcode reader to enter an ISBN, simply scan the barcode instead and Readerware will convert
the barcode into an ISBN.

You will typically find the barcode on the back cover of a book, both hard cover books and paperbacks will include a barcode on
the back cover. However some paperback publishers include a non standard barcode on the back cover. In this case they will
include a compatible barcode inside the front cover. So if you have trouble scanning the barcode on the back cover of a
paperback, if Readerware is unable to convert this barcode into an ISBN, look for a barcode inside the front cover and scan that
instead.

Readerware barcode support can be very useful both when building your initial database and normal maintenance. If you are
using Readerware to track your "to read" pile for example, you will want to retrieve the entry for a book to mark it as read or add
comments, ratings etc. A barcode reader is the fastest way to retrieve a book from the database.

Anywhere you can enter an ISBN in Readerware you can simply scan in the barcode instead. Readerware will convert the
barcode into a correctly formatted ISBN. When searching for a book, Readerware will immediately search for the title after you
scan the barcode, there is no need to press the enter key.

When deciding whether or not a barcode reader will be useful to you, it will help to check out the contents of your library. How
many books in your collection contain barcodes? All new books you purchase will contain a barcode, how many new books do
you buy? How often will you be searching the database for a specific book? 
 

Types of Barcode Readers

There are many types of barcode readers. Readerware will handle any bar code reader that enters data via a keyboard
interface. These are often referred to as "wedge" readers as they wedge themselves in between the keyboard and your
computer. Some barcode readers require driver software, others do not. Readerware will support either type, but if a barcode
reader requires driver support, you need to ensure that a driver is available for your operating system, (Windows, Linux etc.).

There are basically two types of barcode readers that are applicable to an application like Readerware:

Wands - Wands must be swiped across the barcode as if you were drawing a line through it. Wands are the most rugged
and least expensive. One minor drawback is that as the wand comes in physical contact with the bar code, it can cause
wear and tear on the book jacket over time. For most users however this will not be a problem.
Charged Coupled Device, (CCD) - Just point it at the label and pull the trigger. Good performance/price ratio, very rugged
as they have no moving parts and are easy to use. Some models have limits to how wide the bar codes can be, but this is
not normally a problem with books.

See The Readerware Web Site for specific recommendations. 
 

Types of  Barcodes

There are two basic types of barcodes that are used on books. Hard cover books have a European Article Number (EAN) on the
back jacket.

Paperbacks have different types of barcodes. Some will include an EAN like a hardcover book. However mass market
paperbacks, those designed for sale in places like supermarkets, will not have an EAN as they typically cannot be read by
supermarket scanners. Instead they have a UPC bar code.

Fortunately Readerware will support either type of barcode and you need not know which type of barcode you are scanning. But
there are some differences. 
 

Manufacturer to Publisher Mapping

The EAN embeds the ISBN so Readerware can retrieve the ISBN from the bar code. Mass market paper backs only include part
of the ISBN, but also include a manufacturer code. Readerware needs to map the UPC manufacturer code to the ISBN
publisher code, and reconstruct the full ISBN. Readerware has mappings for most publishers built in. But you may occasionally
see an error dialog reporting an undefined manufacturer code when scanning a paperback.

Once you enter the correct mapping, Readerware will remember it and will be able to handle books from that paperback
publisher. Mapping the manufacturer code to the publisher code is best explained by example.
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Here is a UPC code from a paperback:

  

Although the ISBN is printed under the barcode, it is not part of the barcode itself. So when the barcode is scanned, the ISBN is
not included. Here is how Readerware maps the manufacturer to the publisher and generates the ISBN. The UPC manufacturer
is identified by the first 6 digits, in this example the manufacturer code is 071009. The ISBN identifies the publisher by the first
two number groups, in this example the publisher code is 0440.

So if this publisher were unmapped, Readerware would display a manufacturer code of 071009 and ask you to enter the
corresponding publisher code, in this case 0440. That's all there is to it, Readerware is now able to generate the ISBN for all
mass market paperbacks by this publisher. 

Occasionally a publisher will run out of book numbers and will be allocated another publisher code by the ISBN agency. But the
UPC manufacturer code is unchanged. So it is possible to have the same UPC manufacturer code mapped to two different ISBN
publisher codes. Readerware can handle this. 

If when you scan a paperback Readerware displays an incorrect ISBN you either have an invalid mapping or you need to add a
second publisher code. Go to Preferences, Books tab. The mapping table will be displayed and you can edit the mappings:

To delete a mapping, erase either column and hit the Enter key, Readerware will delete this mapping when you click OK
To change a mapping edit the column data as appropriate and hit the Enter key
To assign multiple publisher codes, enter them separated by a comma.

When a UPC manufacturer code is mapped to more than one ISBN publisher code, Readerware will display a selection dialog
when you scan the barcode.
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Readerware Portable Install Wizard
When you install Readerware onto your computer it does a local install. This means that the programs are installed at the
appropriate location on your local hard drive, and Readerware stores things like preferences under your user ID. For most users
this is the best choice. 

Readerware does support additional install configurations for use in specialized circumstances:

Portable installation - You can install Readerware and your database on a portable drive like a USB thumb drive.
You can then take this drive with you and plug it in to any machine. You have your complete Readerware system with
you on any machine. 

CD Install - You can copy Readerware and your database to a CD. You can then give a copy of the CD to non
Readerware users. They can insert the CD into any machine and run Readerware from the CD and search and
browse your database. The database is in read only mode, no changes are allowed. 

Network install - You can configure Readerware and install it to a network share where users can run the program
from the network server. This is designed for use with Readerware Client/Server Edition. You set your database up in
client/server mode, then create a customized Readerware network install. When your user launches the program it
will open the network database and use your custom options. There is no need for a local install when using
Readerware Client/Server Edition.

To create any on these custom installs, you must start with a Readerware Local install and then select the File->Make portable
menu item. Readerware will then copy the necessary program, database and preferences files creating your customized install. 

Drive Selection

You need to tell Readerware where to create your custom install. You can select the actual destination or a temporary holding
folder on your local hard drive. For example you can select a thumb drive to create a portable install, a network share to create a
network install. For CD installs you must select a holding folder and later burn the contents to CD, Readerware cannot create the
actual CD. 

Click on Browse and select the destination folder. 

Select the installation type:

Portable (Thumb drive)
CD (read only database)
Network launcher

Options

On the Options page you decide what you want to copy to the install folder:

Copy Program - This will copy the Readerware programs, you should normally select this option.

Copy Database - This will copy the Readerware database files. Note that Readerware can only copy a local
database from your hard drive. If Readerware is accessing a server or external database, this option will be disabled.
You will normally want to copy the database for a Portable and CD install, for a network install, the database is not
normally needed. 

Copy Preferences - This will copy the current Readerware settings so that the Readerware installation will start up
with your current options. You should normally copy preferences. If you omit preferences, Readerware will start up
with a default configuration.
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Verification Page

Next up is the verification page. This is your last chance to change your settings prior to creating the portable installation. A
quick summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 

Running Page

When you reach this page, your Readerware installation is being created. You will see a progress bar that will update as
Readerware copies files to your portable installation. 

The time will vary based on the number of files you are copying and the destination media. For example writing to thumb drive
can be slow. Please be patient and wait for the copies to complete. 

When the operation completes, click on the Next button to proceed to the final page of this wizard. 

Complete Page

Your Readerware install is ready and has been created at the location displayed on this page. 

Copying your installation to a CD

To create a CD install, you have to create the install on your hard drive first, then burn the files to a CD. 

Today most operating systems will burn files to a blank CD, no special software is required. 

Windows

To copy the files to a CD 

Insert a blank, writable CD into the CD recorder. 
If Windows asks you what to do with the blank disc, select the write data files to CD option". Otherwise double click on "My
Computer", then double click on your CD drive icon. 
Drag and drop the Readerware install files on to the CD folder 
Verify that the file(s) you intend to copy to the CD appear under "Files Ready to be Written to the CD". 
Under CD Writing Tasks, click Write these files to CD. Windows displays the CD Writing Wizard. Follow the instructions in
the wizard.

Mac OS X

To copy the Readerware install files to a CD 

Insert a blank CD or DVD disc into the optical drive of your computer. 
If you see a dialog, you can choose an action from the pop-up menu. Then click OK. 
Type a name for the disc under the CD icon. 
Drag the Readerware files to the open window. 
The Finder places aliases to the files in the disc's window. 
Choose File->Burn Disc. 
The files that the aliases point to are burned to the disc.
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Readerware Portable Import Wizard
This wizard will help you import a Readerware portable installation back into your main Readerware installation. For example,
while cataloging your library you might decide to create a Readerware portable installation on a thumb drive. You can then use
this on any PC to catalog nearby books. When you are done you no longer need your portable installation and this wizard will let
you import your new database back into your main installation. 

When you install Readerware onto your computer it does a local install. This means that the programs are installed at the
appropriate location on your local hard drive, and Readerware stores things like preferences under your user ID. For most users
this is the best choice. 

Readerware does support additional install configurations for use in specialized circumstances:

Portable installation - You can install Readerware and your database on a portable drive like a USB thumb drive.
You can then take this drive with you and plug it in to any machine. You have your complete Readerware system with
you on any machine. You can later import the database back into Readerware. 

CD Install - You can copy Readerware and your database to a CD. You can then give a copy of the CD to non
Readerware users. They can insert the CD into any machine and run Readerware from the CD and search and
browse your database. The database is in read only mode, no changes are allowed. 

Network install - You can configure Readerware and install it to a network share where users can run the program
from the network server. This is designed for use with Readerware Client/Server Edition. You set your database up in
client/server mode, then create a customized Readerware network install. When your user launches the program it
will open the network database and use your custom options. There is no need for a local install when using
Readerware Client/Server Edition.

Drive Selection

You need to tell Readerware where your portable install was created. Click on the Browse button and select the drive or volume
containing the portable installation. Just select the drive or volume, you do not need to select a particular file. 

Database Selection

Next select the database you want to copy the portable database to. If this database exists it will be overwritten by the portable
database so please be careful when selecting the database. 

By default Readerware will select the original database used to create the portable installation. This database will now be
replaced with the database from your thumb drive. Click on the Browse button and select the name and location for the
database. 

Verification Page

Next up is the verification page. This is your last chance to change your settings prior to importing the portable installation. A
quick summary of your choices is listed. Click on Next if you are ready to go. Click on Back if you want to change your choices. 

Please heed the database will be overwritten warning if displayed. It means that the selected database will be overwritten with
the contents of your portable database. A Readerware backup is always a good idea before overwriting an existing database. 

Running Page

When you reach this page, your Readerware portable database is being imported. You will see a progress bar that will update
as Readerware copies database files from your portable installation. 

The time will vary based on the size of the database you are copying. 

When the operation completes, click on the Next button to proceed to the final page of this wizard. 
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Complete Page

Your Readerware database has been imported. 

Click on Finish to close the wizard and open your imported database.
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International Standard Book Numbers (ISBN)

A Brief History

The International Standard Book Number has its origins in the Standard Book Numbering system developed in England for
bookseller W. H. Smith. The Standard Book Numbering system was introduced in the UK in 1967.

The International Standards Organization, (ISO), investigated the feasibility of adapting the British system for international use in
1968. The International Standard Book Number (ISBN) was approved as an ISO standard in 1970. 
 

ISBN Format

An ISBN has 10 digits, separated by hyphens. In Readerware you can enter ISBN's with or without hyphens, Readerware will
automatically add the hyphens in the correct places. The ISBN is divided into 4 parts:

1. Group identifier (1 digit, typically 0 or 1 for English-speaking countries)
2. Publisher identifier
3. Title identifier
4. Check digit

The check digit is used to validate the preceding 9 digits. The check digit will sometimes be an X. All other characters must be
numeric. 
 

ISBN Problems

The publisher identifiers are assigned by various Government agencies. The title identifiers are assigned by the publishers
themselves. Therein lies a problem. The ISBN should be unique but a publisher could reuse ISBN's from out of print titles, or
simply make a mistake and assign duplicate numbers to different titles. So occasionally you will run across different titles with
the same ISBN.

The check digit is calculated from the preceding 9 digits. Unfortunately not all check digits have been calculated correctly. You
will sometimes run across a book with an ISBN that has an invalid check digit. This problem occurs mostly on older titles.

Readerware handles this by displaying an error dialog whenever it detects an invalid ISBN. Normally you will get this dialog
when you enter an invalid ISBN, so the proper response is to click on Reject and correct the ISBN. However because you will
occasionally run across an invalid ISBN on a book, Readerware allows you to override the error and accept the ISBN anyway.
You should only override the ISBN error in those rare cases when a book has an invalid ISBN. 
 

Where to find the ISBN

All modern books, (hardcover and paperbacks), include the ISBN on the copyright page. Hardcover books today will include the
ISBN as part of the European Article Number, (EAN), commonly referred to as the UPC or bar code, which is located on the
back of the book jacket. Paperback books may also include an EAN but mass market paperbacks typically do not. So the bar
code on a mass market paperback will not include the ISBN, but a mass market paperback may include the EAN on the inside
front cover.

On older books, the ISBN can be virtually anywhere. If the copyright page does not include the ISBN, check the book jacket,
typically the spine or the back cover. Books published before 1970 will of course not have an ISBN. 
 

ISBN and bar codes

Remember that anywhere you can enter an ISBN in Readerware, you can enter it via a bar code reader. A bar code reader can
make entering and maintaining data in Readerware a lot easier. They are the fastest way to search for a book. See The
Readerware Web Site for recommendations on specific bar code readers. 
 

Library of Congress Card Catalog Number (LCCN)

The Library of Congress Card Catalog Number predates the ISBN and can also be useful when cataloging books with
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Readerware. You will often find the LCCN on books from the fifties and sixties. Sometimes you will find both the ISBN and the
LCCN, in that case use the ISBN as it is supported by all the search sites. If a book only has an LCCN, you can search for it at
The Library of Congress [2] site.

You will find the LCCN inside the book on the copyright page. It is normally referred to as The Library of Congress Card Catalog
Number or LCCN. Sometimes it is there but not identified. The LCCN is normally formatted with a 2 digit year, a hyphen and
then the book number. For example 63-10153.
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Readerware Mobile for Android
Now you can take your Readerware databases with you on an Android device. You're fully
mobile, take your Readerware databases with you when you visit your favorite brick and mortar
stores. You can easily check your databases to identify the titles you already own and the titles
you are looking for. 

Browse your music or video library from the couch, decide what to play next. 

You have full control over your Readerware Mobile database, you choose which fields to
include. You can take multiple databases with you. 

Synchronizing your databases

You setup your Readerware Mobile database format in the desktop version. Select Preferences,
then Mobile. You choose which fields to include in the mobile database. A default set of
common fields is provided to get you started, but you have full control over which fields to
include. You can also set maximum lengths for each field. So for example you could choose to
include the product info field, but only take the first 200 hundred characters to conserve space. 

Synchronizing from Android

The first time you run Readerware on your Android device, the database chooser is displayed. You can also select the Menu-
>Database option at any time to display it. 

Choose from the following options:

Connect - Transfer your database over your home WiFi network. Readerware must be running on your computer and you
must have enabled the network sync option in Readerware Mobile preferences. Connect your Android device to your WiFi
network and enter the IP address of your computer to connect. Your computer IP address will be displayed in Readerware
Mobile preferences. The current database will be transferred. If you are running Readerware Client/Server Edition you can
sync your database to your Readerware server instead of Readerware itself. Follow the above instructions but enter the IP
address of your Readerware Server and a port number of 9002.
Import - You can also export your Readerware database. Connect your Android device and copy the exported file, just
drop it in the Readerware folder. When you select the Import function Readerware Mobile will find the file, create the
database and open it. Note: You may have to disconnect your device from your computer after transferring the file.
Android can restrict file access while connected and Readerware may not be able to find the file.
List - Use the List function to display all available Readerware databases on your device. You can open any database and
delete old databases.

Using Readerware Mobile

When you start Readerware Mobile your full database is displayed in a list format. You can scroll up and down and also take
advantage of fast scrolling. If you have a large database the Android scroll thumb will appear when you start to scroll, drag the
thumb. To scroll down to items beginning with the letter "S", drag the thumb and release it when the letter is displayed. 

You can also search your database, select the Menu->Search item. Select the type of search and enter what you are looking for.
Readerware uses wildcard searches so just enter the first few letters of an author or part of the title and Readerware will display
all matches. Click the Android Back button to return to the full list. 

To display more information on a particular item, just touch it and the Readerware detail view is displayed. You can scroll
through your items from the detail view. Click the Android Back button to return to the full list. 

Readerware Mobile Options

You can customize how Readerware Mobile works. You can choose the default search and sort for your database, customize
the display, orientation etc. 
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Select the Menu->Settings item to customize Readerware Mobile. 

Using Readerware Mobile as a barcode reader

When searching for items in your database, you can use the device camera as a barcode
reader. On the search screen touch the Scan Barcode & Search button and scan the barcode.
Readerware will select the correct search type and search the database for the item. 

It is important to understand that when searching your database by ISBN/UPC, you are
searching for a particular edition of a book, album or video. You might have that title but a
different edition with a different ISBN/UPC. Normally it is best to search your database by title,
author, artist etc. 

You can also capture barcode scans and use them with auto-catalog, select the barcode button
to start capturing barcodes. Take your device to your shelves and scan the barcodes.
Readerware automatically saves the scans and you can use them with Readerware auto-
catalog on your desktop to add new items to your database. 

Start Readerware auto-catalog and on the item input page, click on the Upload button and select Readerware Mobile from the
list. In Readerware Mobile touch the Upload button on the capture screen and the barcodes will be transferred over your home
network and automatically appear in Readerware auto-catalog. 

The barcodes you scan will be saved to a file on your device. Book barcodes are saved to a file called Books.rwb, music
barcodes to Music.rwb and video barcodes to Videos.rwb. You can also copy these files to your computer. 

Connect your Android device to your computer via the USB cable and drag and drop these files to your hard drive. You can then
select them in auto-catalog. 

Note: The first time you try and scan a barcode you might be prompted to install the Android barcode app from the Android
Market. Once the app is installed you will be able to scan. 
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Readerware Mobile for iOS
Now you can take your Readerware databases with you on an iOS device like an iPhone or iPad. You're
fully mobile, take your Readerware databases with you when you visit your favorite brick and mortar
stores. You can easily check your databases to identify the titles you already own and the titles you are
looking for. 

Browse your music or video library from the couch, decide what to play next. 

You have full control over your Readerware Mobile database, you choose which fields to include. You
can take multiple databases with you. 

Synchronizing your databases

You setup your Readerware Mobile database format in the desktop version. Select Preferences, then
Mobile. You choose which fields to include in the mobile database. A default set of common fields is
provided to get you started, but you have full control over which fields to include. You can also set
maximum lengths for each field. So for example you could choose to include the product info field, but only take the first 200
hundred characters to conserve space. 

Synchronizing from iOS

The first time you run Readerware on your iOS device, you will need to transfer your database. Touch the database icon in the
bottom left hand corner of the screen. 

Choose from the following options:

Connect - Transfer your database over your home WiFi network. Readerware must be running on your computer and you
must have enabled the network sync option in Readerware Mobile preferences. Connect your device to your WiFi network
and enter the IP address of your computer to connect. Your computer IP address will be displayed in Readerware Mobile
preferences. The current database will be transferred. If you are running Readerware Client/Server Edition you can sync
your database to your Readerware server instead of Readerware itself. Follow the above instructions but enter the IP
address of your Readerware Server and a port number of 9002.
Import - You can also export your Readerware database and use iTunes to transfer it. Connect your device and launch
iTunes. Click on your device icon and then the Apps tab. Scroll down to the file sharing section. Click on the appropriate
Readerware app and then the Add button, select your exported database file. iTunes will then transfer it to your device,
When you select the Import function Readerware Mobile will find the file, create the database and open it. The file you
copied will be deleted so you don't have to worry about cleaning it up.
List - Use the List function to display all available Readerware databases on your device. You can open any database and
delete old databases.

Using Readerware Mobile

When you start Readerware Mobile your full database is displayed in a list format. You can scroll up and
down and also take advantage of fast scrolling. If you have a large database the scroll thumb will appear
when you start to scroll, drag the thumb. To scroll down to items beginning with the letter "S", drag the
thumb and release it when the letter is displayed. 

You can also search your database, select the Search button in the top right hand corner of the screen.
Select the type of search and enter what you are looking for. Readerware uses wildcard searches so
just enter the first few letters of an author or part of the title and Readerware will display all matches.
Click the List button to return to the full list. 

To display more information on a particular item, just touch it and the Readerware detail view is
displayed. Click the List button to return to the full list. 

Readerware Mobile Options
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You can customize how Readerware Mobile works. You can choose the default search and sort for your database etc. 

Select the preferences button to customize Readerware Mobile. 

Using Readerware Mobile as a barcode reader

When searching for items in your database, you can use the device camera as a barcode reader. On the search screen touch
the Scan Barcode & Search button and scan the barcode. Readerware will select the correct search type and search the
database for the item. 

It is important to understand that when searching your database by ISBN/UPC, you are searching for a particular edition of a
book, album or video. You might have that title but a different edition with a different ISBN/UPC. Normally it is best to search
your database by title, author, artist etc. 

You can also capture barcode scans and use them with auto-catalog, select the barcode button to start capturing barcodes.
Take your device to your shelves and scan the barcodes. Readerware automatically saves the scans and you can use them
with Readerware auto-catalog on your desktop to add new items to your database. 

Start Readerware auto-catalog and on the item input page, click on the Upload button and select Readerware Mobile from the
list. In Readerware Mobile touch the Upload button on the capture screen and the barcodes will be transferred over your home
network and automatically appear in Readerware auto-catalog. 

The barcodes you scan will be saved to a file on your device. Book barcodes are saved to a file called Books.rwb, music
barcodes to Music.rwb and video barcodes to Videos.rwb. You can also copy these files to your computer using iTunes. 

Connect your device and launch iTunes. Click on your device icon and then the Apps tab. Scroll down to the file sharing section.
Click on the appropriate Readerware app and you will see the barcode capture file, drag it to your hard drive. You can then
select the file in auto-catalog. 
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Readerware Mobile on an iPod
Note: This is for a classic iPod only, it will not work on an iPod Touch or iPhone etc. 

You can export your Readerware databases to iPod Notes format and take your databases with you. Once
on your iPod you're fully mobile, take your Readerware databases with you when you visit your favorite brick
and mortar stores. You can easily check your databases to identify the titles you already own and titles you
are looking for.

Exporting to your iPod

You first thing to do is set up the data that you want to export to your iPod:

Create an iPod table view containing just the columns you want to export in the order you want to
export them in. Select the Preferences menu item, Views tab
Sort your database in the best sequence. For books this is typically Author then Title. For CDs, Artist
then Title. For videos Title. The order the records appear on your screen is the order they will be in on
your iPod.

Now you are ready to actually export your data to your iPod so connect your iPod to your computer as normal. It will appear as
another hard drive. 

In Readerware select File->Export to launch the Export Wizard:

Select the iPod Notes format from the drop down list, click Next
Click on the Browse button to display the file selection dialog, navigate to the Notes folder on your iPod. Click Save to
close the dialog and then Next.
Select the All option to export your entire database.
Select the Current View Columns option, click Next
Verify your choices and complete the wizard to export your database to your iPod.

This is the recommended way to transfer your database to your iPod. Setting up an iPod table view means that you can easily
transfer the same columns each time. There are other options, see the Export Wizard documentation for more information on
transferring your books, music and videos to your iPod..

Using Readerware on your iPod

When you export your Readerware database to iPod Notes format, Readerware creates a series of iPod
Note files, so you must use the Notes facility to access your databases. From the top level iPod menu select
Extras, then Notes. You should now see your Readerware databases.

A quick tip, you can add Notes to your top level iPod menu. Click on Settings then Main Menu. Turn Notes
On and it will now appear on the top level iPod menu for even faster access to your Readerware databases.

Select the database you want to view. You will see a high level list of the database contents, the authors,
artists or titles. Scroll to find the entry you want and then select it.

You will now see the detail listing for all items in that part of the database. You can scroll around to find the
item you want. 

To return to the previous page, click on the iPod menu button. If you want to view the next section of the
database you will find a Next link at the bottom of the current list..
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Readerware Mobile for Palm OS
Readerware Palm Editions are lightweight editions of the desktop product that run on a Palm or compatible
device. It is not a standalone product but an add on to Readerware. You can transfer your databases to your
Palm. Once there you're fully mobile, take your Readerware databases with you when you visit your favorite
brick and mortar stores. You can easily search your databases to identify the titles you already own. Your
Readerware Want List is also transferred to Readerware Palm Edition so you can easily display the items you
are looking for. 
  
 

Installing Readerware Palm Edition

Readerware Palm Edition is distributed as a self extracting executable or zip file, it includes Readerware, ReaderwareAW and
ReaderwareVW for the Palm. You must first extract the contents of this file into a temporary directory. Just double click on it to
extract the files which must be transferred to your Palm. The first two must be transferred regardless of which product(s) you
install. Transfer the others as appropriate.

Important: You must install these files on your Palm OS device, Readerware will not work if installed on an expansion card.

All Products:

waba.pdb 
waba.prc

Readerware:

Readerware.prc 
RWare.pdb

ReaderwareAW:

ReaderwareAW.prc 
AWare.pdb

ReaderwareVW:

ReaderwareVW.prc 
VWare.pdb

Start your Palm Desktop application, click on the Install button. Click on Add and select each of the files in turn. You do not
have to transfer any other files included in the Readerware Palm Edition distribution. Click Done. The Palm software will display
a dialog telling you that the files will be transferred on the next HotSync. Start the HotSync from your Palm as normal.

You should now see new icons on your Palm home panel. Depending on the products you installed, you will see the familiar
Readerware, ReaderwareAW or ReaderwareVW icons and another called Waba VM. To start a product, just select the
appropriate Readerware icon.

If you start Readerware now, you will see an about box and an empty window. This is because before you can see your data,
you must transfer your database from your desktop to your Palm.

That's the next step, your now ready to create your Readerware Palm Edition databases. 

If you have trouble running the Readerware programs on your Palm, see the Installation/Synchronization problems section. 

Exporting to Readerware Palm Products

Readerware Palm Edition is optimized for small devices providing a quick and easy way to search your entire database and your
want list on a portable device. You do not create the Readerware databases using Readerware Palm Edition, rather you create
them on your desktop and then transfer the database to your Palm.

The basic process is the same for all products. Do a search to establish which items you want to export. If you want to transfer
your entire database, click on the Browse button in the toolbar. Now you will see the search results displayed in Readerware as
normal.
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To create your Palm database, select the File->Export menu item. Select the Palm format from the drop down list. Select a
directory for the database. The database name defaults to the correct name for each product, you should not change the name,
just the directory.

The Palm database, the file you export from Readerware and transfer to your Palm, must be named correctly:

Readerware: readerware.pdb

ReaderwareAW: readerwareaw.pdb

ReaderwareVW: readerwarevw.pdb

TIP: Select your Palm HotSync Add On directory. This will make it easier to actually transfer the file to your Palm. When you
click on Create, Readerware will create the file, the next step is to transfer it.

Start your Palm Desktop application, click on the Install button. Click on Add and select the appropriate .pdb file using the file
selection dialog. Then click Done. The Palm software will display a dialog telling you that the file will be transferred on the next
HotSync. Start the HotSync from your Palm as normal. Now when you start the applications on your Palm, your new database is
loaded automatically.

When you want to transfer updated data to your Palm, just repeat the above steps to export and HotSync your database. You
need to transfer the full database each time, Readerware replaces rather than updates the database.

In order to conserve space and allow large databases to be stored on a handheld device, only the following fields from the
Readerware database are exported to Readerware Palm Edition:

Author (Primary field)
Title
ISBN
Publisher
Rating
Format
First Edition?
Signed?

In order to conserve space and allow large databases to be stored on a handheld device, only the following fields from the
ReaderwareAW database are exported to ReaderwareAW Palm Edition:

Artist (Primary field)
Title
Label
Composer
Conductor
Format
Rating
UPC

 

In order to conserve space and allow large databases to be stored on a handheld device, only the following fields from the
ReaderwareVW database are exported to ReaderwareVW Palm Edition:

Title (Primary field)
Actors
Director
Series
Format
Sound
Widescreen?
UPC

The primary field determines the sequence in which the items are displayed and which field is the search field. You can only
search a Palm database on the primary field.

That's it, your now mobile. 
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If you have trouble running the Readerware programs on your Palm, see the Installation/Synchronization problems section.   

Using Readerware Palm Edition

To launch a Readerware Palm Edition application simply select the appropriate Readerware icon on your Palm home panel.
Readerware will start, load the database and display the first page of results.

Along the top of the screen you will see the application title and a row of buttons:

Select the application title to display the about box. This includes program information as well as the number of items
in your database.

Select the left arrow icon to display the previous page.

Select the right arrow to display the next page.

Select the home icon to return to the first item in the database.

Select the magnifying glass icon to display the search dialog.

Select the shopping cart icon to display your Readerware want list list. 
 

Below the title bar are the items in your database. The primary key is displayed in a bold font followed by the
items, i.e. books by that author. The items are displayed in a plain font. ReaderwareVW displays just the video
title. You can select any title and a detail page is displayed which includes all the information about the selected
item. 
  
 

Searching

When you select the search icon, the search dialog is displayed. Enter the text you are looking for. This must be
text in the primary field: 
 

Readerware Author
ReaderwareAW Artist
ReaderwareVW Title

Enter the data using Palm graffiti just as you would in any other application. The search data is case sensitive and the search
always starts with the first character of the field. You can have Readerware automatically uppercase the first character for you.
Enter as much of the field as necessary to match the required entries. For example to search for books by "Rendell, Ruth", you
might enter "ren", without the quotes, in the search field. Select the Search button and Readerware will display the first matching
item, if any, at the top of the page.

Installation/Synchronization problems

You must install the Readerware program and database files on your Palm OS device, Readerware will not work if installed on
an expansion card.

There is one open issue when exporting your database to Palm format. You need to select a table view before running the
export. If a tree view is active, the database PDB file will not be created correctly. So make sure you select a table view from the
Views drop down list in the Readerware toolbar, then select File->Export.
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If a Readerware program does not run on your Palm, chances are one of the files is missing. Refer to the list of needed files and
transfer them again. As the names are similar it is possible to get pieces of different applications instead of one complete
application. For example instead of transferring Readerware.prc and RWare.pdb, you could have transferred Readerware.prc
and VWare.pdb.

If the Waba VM displays the message " Error: can't access app classes ", it means that the Readerware program was not found.
The file RWare.pdb (Readerware), AWare.pdb (ReaderwareAW) or VWare.pdb (ReaderwareVW) was missing. Transfer the file
again.

Palm T5/Treo 650

Early versions of these devices included serious bugs that could corrupt the new Palm persistent file system. An update for T5
owners is available and this should be installed before using Readerware on your T5. Visit PalmOne at
http://www.palmone.com/us/support/downloads/tungstent5/tungstent5update.html

Due to the way the new file system allocates memory, the maximum size of a Readerware database that the device can handle
is severely limited. For example on a Palm Tungsten T, I have no trouble accessing a 30,000 record Readerware database. But
on the T5/Treo 650 the limit is about 5,000 records. This is because the new file system allocates records in 512 byte blocks.
The size of a typical Readerware database record is less than 100 bytes, but with the new file system it takes up 512 bytes. This
results in limited database capacity.
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Readerware Client/Server Edition
Readerware Client/Server edition is designed to allow multiple users to connect to a central database. It can be used on home
networks to manage personal collections. It can also be used in libraries, churches, schools and enterprise locations to catalog
and manage a library. 

Installing the Readerware Server

The Readerware Server is included in all distributions. Installation is a little different on each platform. We recommend that you
install the full Readerware distribution on the server machine, not just the Readerware server itself. As you configure the server
it will be much easier to test your setup if you can run Readerware on the same machine as the server. Also when you are
running Readerware and the server on the same machine, firewall software is not usually an issue. If you can run Readerware in
client/server mode on the same machine as the server but are unable to connect from another machine, then chances are it is a
firewall issue. You may also need the Readerware client programs to create or migrate your database. 

Before you start the server you must create your Readerware databases on the server machine. 

If this is a new installation you can create a new empty database using the normal Readerware program, select the File->New
Database menu item. 

If you have an existing database on another machine you can use backup & restore to transfer it to the server machine. 

Installing the Readerware Server on Windows

We recommend using the Windows Web Installer when installing Readerware on your server machine. This will ensure that the
best version of Readerware is installed on your machine, i.e. the 64bit version of Readerware on a 64bit machine. 

We recommend that you do a full install on your Windows server machine, install the full product not just the Readerware server.
This will help you when setting up your Readerware server. As you go through the installer look for the Desktop Shortcuts
screen. You might want to add a desktop shortcut for the RWServer Config utility as you will be using it a lot on the server
machine. 

On Windows the Readerware Server is run as a Windows service. This means that the Readerware server can be started with
the machine and it will always be available. You don't have to manually start the server first. 

To configure the Readerware server as a Window service, start the RWServer Config utility. Double-Click on the RWServer
Config desktop shortcut or select it from the Windows Start menu. Select Start->All Programs->Readerware 4->RWServer
Config. 

RWServer Config requires administrator rights so Windows should prompt you to approve the program before it is launched. If
RWServer Config is not run as an administrator, you will not be able to install the Readerware server as a Windows service. 

Select the Service->Install RWServer Service menu item, this will install the Readerware server as a Windows service that will
be started automatically every time you start your computer. You only need to install the Readerware server as a service the first
time you install it. You do not have to do this every time you upgrade Readerware. You can also use the Service menu to check
the status of the Readerware server, stop and start the server etc. 

Once installed, another way to stop and start the server is by using the Windows Control Panel, (Windows 7) or Settings,
(Windows 10), search for Services. The Windows Services settings can also be used to change the Readerware server
properties. Locate RWServer in the list and double click on it to open the properties dialog. There are a couple of settings you
might want to change: 

Startup type - The default setting is Automatic, Windows will start the Readerware Server as Windows starts. You
can change this to Automatic (Delayed Start). Windows will still start the Readerware Server automatically but not
until Windows is fully launched. Choose this option if you need to have other processes start before the Readerware
Server. For example you might have your Readerware database on an encrypted drive. If started right away the drive
may not be available. Using the delayed start option gives you a chance to load the encrypted drive first. 

Log on as - By default the Readerware server runs as a local system account. This normally works fine unless you
have your database stored in a folder owned by a particular user. In this case the system account may be denied
access to the database. You can fix this by providing the appropriate log on credentials and Windows will start the
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Readerware Server under that account.

Important note for Windows 10 users: It is strongly recommended that you use the Automatic (Delayed Start) startup type on
Windows 10. Windows 10 is upgraded automatically by Microsoft and the upgrade process can involve several system restarts.
By using the delayed start option, the Readerware Server is not constantly being started and stopped during the upgrade
process which can cause issues. The Readerware server will still be automatically restarted once the upgrade is complete. 

Once you have installed the Readerware server as a Window service, you can continue with the normal setup. 

Installing the Readerware Server on Linux

You can just install Readerware on your Linux server machine and run the Readerware server by launching the RWServer
application. However we recommend that you take the time to set up the Readerware Server as a Linux systemd service. That
way the Readerware server will be started automatically when the machine starts. 

Setting up the Readerware server as a systemd service is a one time thing, you do not need to repeat this every time you
upgrade Readerware. Here are the steps you need to follow: 

Create a Readerware user - You should create a new user for the Readerware server. The server will then be run
under this ID. We recommend adding a new standard user called "rware". If you cannot use this name, you may pick
another and update the rwserver.service file to point to the correct user. 

Readerware provides the systemd rwserver.service file as part of the standard distribution. It is located in the
Readerware installation folder. By default Readerware is installed in "/opt/readerware4". You should open this file in a
text editor and check the settings. If you are using a different user, you should change "user=rware" to point to your
Readerware user name. If you installed Readerware in another location, you should change the
"ExecStart=/opt/readerware4/rwserver.sh" line to point to your installation. When ready you should copy this file to the
systemd folder, normally "/lib/systemd/system". 

After copying the service file to the systemd folder issue the following command to enable the rwserver service and
have it started automatically when the system starts: 

systemctl enable rwserver

Now whenever you start your system the Readerware server will be started automatically. If you ever want to change
this behavior use the disable command. 

To start the Readerware server manually use the following command: 

systemctl start rwserver

To stop the Readerware server manually use the stop command.

The full Readerware server log is written to the Documents/Readerware/Logs folder of the user the server is running under. By default
that is rware i.e. /home/rware/Documents/Readerware/Logs/rwserver.log. 

You can also use the standard systemd journal service to view the Readerware server log. For example: 

journalctl _SYSTEMD_UNIT=rwserver

Important: When running the RWServer Config utility to configure the Readerware server, you must first login as the
Readerware user you created above. This ensures that the server configuration files are saved in the correct location. You can
also create your databases under this user. 

Once you have installed the Readerware server with systemd, you can continue with the normal setup. 

Installing the Readerware Server on macOS

You can just install Readerware on your Mac server machine and run the Readerware server by launching the RWServer
application. However we recommend that you take the time to set up the Readerware Server as a macOS launchd daemon.
That way the Readerware server will be started automatically when the machine starts. 
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Setting up the Readerware server as a launchd daemon is a one time thing, you do not need to repeat this every time you
upgrade Readerware. Here are the steps you need to follow: 

Create a Readerware user - You should create a new user for the Readerware server. The server will then be run
under this ID. We recommend adding a new standard user called "rware". You should then login to this account and
create your Readerware databases. If you have existing databases you can use backup & restore to transfer them to
the rware account. If you cannot use this name or would prefer not to relocate your databases, you may pick another
user and update the com.readerware.rwserver.plist file to point to the correct user. 

Readerware provides the launchd plist file as part of the standard distribution. It is located in the Readerware
Client/Server disk image. It is called com.readerware.rwserver.plist. You should open this file in a text editor and check the
settings. If you are using a different user, you should change "<string>rware</string>" to point to your Readerware user
name. The RWServer application is normally installed in your Applications folder. If you installed it in another
location, you should change the "<string>/Applications/RWServer 4.app/Contents/MacOS/JavaAppLauncher</string>" line to point to
your installation. When ready you should copy this file to the launchd daemon folder, normally "/Library/LaunchDaemons".
You can simply drag and drop this file to the launchd daemon folder, you will need to authenticate the operation. 

When you reboot your Mac, the Readerware server will be started automatically. As you test the server configuration
you can manually start the server by double-clicking on the RWServer 4 application. You can use the RWServer
Config utility to restart or stop the Readerware server.

The full Readerware server log is written to the Documents/Readerware/Logs folder of the user the server is running under. By default
that is rware i.e. /Users/rware/Documents/Readerware/Logs/rwserver.log. 

Important: When running the RWServer Config utility to configure the Readerware server, you must first login as the
Readerware user you created above. This ensures that the server configuration files are saved in the correct location. You
should also create your databases under this user. 

Once you have installed the Readerware server with launchd, you can continue with the normal setup. 

Installing the Readerware Server on macOS Catalina or better

You can just install Readerware on your Mac server machine and run the Readerware server by launching the RWServer
application or setting it up as a login item. However we recommend that you take the time to set up the Readerware Server as a
macOS launchd agent. That way the Readerware server will be started automatically when the machine starts. 

Setting up the Readerware server as a launchd agent is a one time thing, you do not need to repeat this every time you upgrade
Readerware. Here are the steps you need to follow: 

The Readerware Server will run under the logged in user, so you should use the normal user that you will log into on
the server machine. You should then login to this account and create your Readerware databases. If you have
existing databases you can use backup & restore to transfer them to your user account. 

Readerware provides the launchd plist file as part of the standard distribution. It is located in the Readerware
Client/Server disk image. It is called com.readerware.rwserver.plist. You should open this file in a text editor and check the
settings. The RWServer application is normally installed in your Applications folder. If you installed it in another
location, you should change all references to the application location to your new location. When ready you should
copy this file to the launchd agents folder, normally "/Library/LaunchAgents". You can simply drag and drop this file to the
launchd agents folder, you will need to authenticate the operation. 

Important: In earlier versions of Readerware we told you to store the "com.readerware.rwserver.plist" file in your
"/Library/LaunchDaemons" folder. This was the wrong location, please delete the file from LaunchDaemons and copy
the new version included in this distribution to your "/Library/LaunchAgents" folder. 

When you reboot your Mac, the Readerware server will be started automatically. As you test the server configuration
you can manually start the server by double-clicking on the RWServer 4 application. You can use the RWServer
Config utility to restart or stop the Readerware server.

The full Readerware server log is written to the Documents/Readerware/Logs folder of the user the server is running under. 

As the Readerware server is started two files are written to the /tmp folder:
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com.readerware.rwserver.out
com.readerware.rwserver.err

If the server does not start you can check these files to see what the problem is. 

Once you have installed the Readerware server with launchd, you can continue with the normal setup. 

Running Readerware in Client/Server Mode

In a Readerware client/server configuration you run the Readerware server on one machine. Typically the database is also on
that machine. The Readerware server opens the database and provides database access to the Readerware client programs,
including the Readerware Loan Client. It can also provide database access to mobile devices. 

The Readerware server can run on any platform, Windows, Linux or macOS. It does not need a dedicated server, it will run in
the background on any machine. 

You can run the Readerware client programs on the same machine as the server as well as other machines on your network.
You configure Readerware to connect to the Readerware server rather than open the database directly. That way multiple users
can connect to the same central database. 

You can have any mix of client machines, Windows, Linux and macOS users can all connect to the same Readerware server,
regardless of what platform the server is running on. 

You can publish your database in read only, checkout or full access mode. Selected users can be given full access. So for
example you could publish your database in checkout mode so that all users can browse the database and check items in and
out. However they will not be allowed to make any other changes to the database. Selected users can be given full access so
that they can add new items and maintain the database. 

Configuring the Readerware Server

Before you can run Readerware in client/server mode, you must configure the Readerware server. For example you must tell the
server where the databases are located. 

The Readerware server itself is what is known as a daemon task. It runs quietly in the background, it does not display any
windows or interact with the user in anyway. This means that you can run the server automatically as the machine starts, and
this is typically the way you run the Readerware server. 

You configure the Readerware server using the RWServer Config utility. This is a typical graphical application and you make
selections to configure the Readerware server. RWServer Config then writes out the configuration file which is used by the
Readerware server. 

The program presents a tab interface, click on the appropriate tab to configure that component of the Readerware server. There
are three basic tab types. The Ports tab is where you define what network ports the Readerware server should use. There are
three database tabs, one for each of the three databases, books, music and video. These tabs are where you define the
databases the Readerware server should use, the access mode etc. The final three tabs are the mobile tabs, again one for each
of the three databases. On these tabs you define whether or not mobile support should be enabled, which database columns
should be transferred to Readerware Mobile etc. 

The Ports Tab

The Readerware server users three TCP/IP ports. 

The control port is used by the Readerware clients to request access to the server. The default control port is 9010. 

The data port is used by the Readerware server to provide database access to the Readerware client programs. The default
data port is 9001. 

The mobile port is used by the Readerware server to provide mobile sync support to Readerware Mobile devices. The default
mobile port is 9002. 

It is strongly recommended that you use the default ports. However only one program can access a given port at a time. So
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there could be a problem if you have another program running on your server machine that is also trying to use one of these 3
ports. That is why you can change them if needed. If you do change a port, you must change it on both ends, i.e. you must
change it in RWServer Config and in the Readerware client programs. By default the Readerware client programs use the same
control port, that is why we recommend you use the default ports unless there is a port conflict. 

The Readerware server will open these three ports for inbound connections. It will then listen on these ports for incoming
messages from Readerware programs. If you are running firewall software on your server machine, you may need to configure it
to allow Readerware to open these ports and accept incoming connections. 

This is one more important field on the Ports tab. Readerware lists the Hostname and IP address of the server machine. This is
the information you will need when connecting to the Readerware server from another machine or a mobile device. For example
it might list "My Computer / 192.168.1.110". When connecting to the server from another computer or mobile device it is best to
use the Host name, i.e. "My Computer". If for some reason you cannot connect using the Host name, select the IP address
instead. i.e. "192.168.1.110 ". The advantage to using the Host name is that it will not change. Depending on your network
configuration, the IP address can change. 

The Server Tabs

Each server database is configured separately. You do not have to make all three databases available. If you are only using
Readerware for books, then you only need to define the books database. 

Click on the appropriate Server tab to configure the database. Start by checking the option to enable this database. 

Click on the Browse button to select the database. The standard file selection dialog is displayed and you can navigate to your
database folder and select the database. 

Next you must select the database access mode. The access mode must be set to one of the following:

Read only - All users can view the database but cannot make any changes to the database, this includes checking
out an item. 

Checkout mode - All users can view the database and check items in and out. No other updates are permitted. 

Full Access - All users have full access to the database.

The update password is used in read only and checkout modes. The Readerware client allows users to request update access.
The user must provide this password to get full access to the database. 

If you have purchased Readerware you must supply your registration name and code to register the server program. If running
in evaluation mode, leave these fields blank. The easiest way to register is to copy the contents of your registration e-mail and
the click on the Paste button. RWServer Config will the locate your registration information in the e-mail and insert it into the
appropriate fields. Your registration e-mail has more information on how to copy/paste your registration. 

There is one final option you need to set when configuring the Readerware server. This is required when using the Readerware
Loan Client. The Readerware Loan Client provides a unified interface to all three databases so you can check items in and out
using the one program. When using the loan client you have to decide which database should contain the borrowers. All
borrowers will be stored in this database. Check the Store borrowers in this database option on the one database that you will
use for borrowers. When saving the server configuration you will get an error if no database is defined as the borrower database.
You will also get an error if multiple databases have this option checked. there should be one and only one borrower database
selected. 

In earlier versions of the Readerware Loan Client only books were supported. If you have been using the loan client prior to
Readerware 4, then you should select the book database as your borrower database. That is where your existing borrowers will
have been stored. 

Even if you are not using the Readerware Loan Client it is a good idea to select a borrower database. This will eliminate the
error message when you save the server configuration. 

The Mobile Tabs

Again mobile support for each database is configured separately. You do not have to enable mobile support for all three
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databases. If you are only using Readerware for music, then you only need to activate mobile support for the music database. 

Select the appropriate mobile tab. Check the option to enable mobile support for this database. 

You can select which database columns should be synced to your mobile device. Columns listed with a green check mark will by
transferred to your mobile devices. Columns displayed with a red X will not. Double-Click on a column to toggle the status. 

You can optionally define a maximum length for each column. For example the Album Info column can contain a lot of data. It
might contain more than you need on your mobile device and by limiting the amount of data transferred you can save space on
your mobile device. Select the column in the list and then enter the maximum length you want to transfer. 

When transferring images to your mobile devices, Readerware will scale them to an appropriate size. You can set that size in
the server configuration but it is recommended that you select the Use device defaults option. That way Readerware will scale
the images to the appropriate size for each device. For example if you have a phone and tablet, Readerware can send bigger
images to the tablet. 

Configuring the Readerware Client

To use Readerware in client/server mode you must select the advanced open dialog option. Select the Preferences menu item,
then Database, then Access. 

Now when you open a Readerware database by selecting File->Open Database, you will see the advanced open dialog. Select
the option to connect to a Readerware Server and enter the server name or IP address and the control port. The control port
must be the same as the control port set in the server configuration utility. 

Readerware will connect to the server and display your database as normal. Readerware remembers the last accessed
database and will open it automatically the next time the program is started. So normally you set up Readerware to connect to
the server once and Readerware connects to your server each time the program is started. 

Configuring the Readerware Loan Client

Unlike Readerware the Readerware Loan Client can only connect to a Readerware server, it cannot open a Readerware
database directly. 

When you select the File->Open database menu item, the Database Chooser is displayed. The only option is to Connect to a
Readerware Server. Select this option and enter the server name. The Readerware Loan Client will connect to the server and
open all the configured databases. The Readerware Loan Client provides a unified view of all databases so that you can
checkout books, music and videos with one program. 

The Readerware Loan Client remembers the last accessed server and will connect to it automatically the next time the program
is started. 

Readerware Server Log File

The Readerware server logs basic activity and errors to a log file. The file is called rwserver.log and it will be created in your
Documents folder, Readerware->Logs. 

If you experience any problems, the answer can normally be found in the log file. This is a plain text file and can be viewed in
any text editor. 

Connection problems

If the client cannot connect to the Readerware server it is normally one of the following issues: 

The Readerware server is not running or does not have the appropriate database open. Check the rwServer.LOG file on
the server machine to verify that the Readerware server has started normally and that the database is open. If you start the
server and open a Readerware and ReaderwareAW database but do not open a ReaderwareVW database, then you will receive
an error if you try to connect from a ReaderwareVW client. 

The operating system cannot resolve the server name. The first thing to check is that the two machines can communicate.
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From the remote machine, open a command prompt and enter the following command:

ping servername

where servername is the name of the machine running the Readerware server. If the ping works, then we know the two
machines can communicate. If not there is some sort of networking problem between the two machines. Try using the machine
IP address in place of the server name. Readerware will accept either. 

Your Firewall is blocking the server ports. If the ping works but Readerware is still unable to connect, then it is probably your
firewall software blocking the ports Readerware is using. 

It is often easier to get started by running the server and client on the same machine. That takes things like firewalls out of the
picture. Once you get it running on the same machine, you know the server is configured correctly and you can then try
connecting from another machine. 

Database Maintenance

You should perform periodic maintenance on your Readerware server databases. 

As you add new items to your server databases, the database will grow in size and should be compacted for better performance
and to reduce disk space usage. As your databases stabilize and you are no longer adding a lot of new items, the need to
compact the database will be reduced. 

Use the RWServer Config utility to compact your databases, select from the Database menu. Depending on the size of your
database, it may take a while to compact a database. The server will be placed in maintenance mode while the database is
compacted. No new connections will be accepted until the operation completes. You can not interrupt the process while the
database is being compacted, it must be allowed to complete. 

It is a good idea to backup your database before compacting it. 

The Compact Database Wizard will guide you through the process. The first screen displays the full path of the database and
the current database size. Verify that you are compacting the correct database and click Next to start compacting. 

When the operation completes the Next button will be enabled. Click Next to display the results screen. RWServer Config will
display the original size of the database and the new compacted size. This should give a good idea of how often your databases
needs to be compacted.
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Remote Database Connection Dialog
This dialog is displayed when you select File->Open Database from the Readerware menu and you have selected the remote
database option. 
 

Instructions

To connect to a Readerware server you need to enter two pieces of information:

The name of the machine the server is running on. If you are running the client and server on the same machine,
you can enter 'Localhost'. Otherwise you should enter the name or IP address of the machine on which the
Readerware server is running. For Example:

Localhost

or

MyServer

or

192.168.0.1

The location of the remote database images. This would normally be on a network drive that you have mapped to
the Readerware server machine. 
 

The Button Panel

Once you have entered the information, click on OK to connect to the Readerware server. Click on Cancel to abort the
operation.
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RWServer Properties File
The easiest way to configure the Readerware server is to use the RWServer Configuration Utility. This will create the
rwserver.properties file for you in the correct location. You can also configure the server by creating your own
rwserver.properties file using a text editor. 

Creating the Server Configuration File

The configuration file specifies the databases and modes etc. This file must be called "rwserver.properties". 

There are four sections to the configuration file. A common section where server properties are specified and three product
sections where you specify the product and database information. 

The common section can contain the following entries:

rw.svr.cp={Control port, default 9010}
rw.svr.dp={Data port, default 9001}

The product sections can contain the following entries:

rw.svr.ena={Database enabled (true or false)}
rw.svr.rnme={Registration name}
rw.svr.rcde={Registration code}
rw.svr.db={full path to the database}
rw.svr.mde={Database mode: 0=full, 1=checkout, 2=read only}

The above examples are configuring Readerware for books. To configure the music version start they keys with aw, i.e.
aw.svr.db. For the video version the keys start with vw. 

You do not need to start all databases, if you are only running Readerware for books, then you only need to define the rw.svr
entries. 

Note that special characters must be escaped with the backslash character. So to enter a backslash you must enter \\. 

Example:

rw.svr.cp=9010
rw.svr.dp=9001

rw.svr.ena=true
rw.svr.rnme=Readerware User
rw.svr.rcde=RW-XXXX-XXXX-XXXX-XXXX
rw.svr.db=D\:\\ReaderwareDB\\Books.rw3\\Books.rw3.data
rw.svr.mde=0

Saving the Server Configuration File

The configuration file must be called "rwserver.properties". The location is determined by the operating system. 

On Windows the configuration file must be stored in the location pointed to by the ALLUSERSPROFILE environment variable.
Create a Readerware folder at that location and store the file in there. For example:

C:\ProgramData\Readerware\rwserver.properties

On Mac OS X the configuration file must be stored in the Application Support folder. Create a Readerware folder at that location
and store the file in there. For example:

/Library/Application Support/Readerware/rwserver.properties
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On Linux the configuration file must be stored in your home folder. There should be a .readerware3 folder in there. For example:

/home/me/.readerware3/rwserver.properties

You can use an alternate location by editing the rwserver.sh script and adding the parameter "-Duser.home=/your/location" after the java
command. For Example:

java -Duser.home=/your/location ...

Readerware will then look for the following file:

/your/location/.readerware3/rwserver.properties
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